Rosemount® Tank Gauging System

System configuration

[Image of a Rosemount Tank Gauging System configuration software interface]

- System Configuration Manual
- 00809-0300-5100, Rev BA
- July 2015

[EMERSON Process Management logo]
Rosemount® Tank Gauging

Configuration with Rosemount TankMaster WinSetup

**NOTICE**

Read this manual before working with the product. For personal and system safety, and for optimum product performance, make sure you thoroughly understand the contents before installing, using, or maintaining this product.

For equipment service or support needs, contact your local Emerson Process Management/Rosemount Tank Gauging representative.

**Version**

This manual is based on the functionality of TankMaster WinSetup version 6.x.

For older TankMaster versions all functionality described in this manual may not be available and the Graphical User Interface (GUI) may look different.
## Contents

### Section 1: Introduction

1.1 Manual overview ................................................. 2
1.2 Technical documentation ........................................ 3
   1.2.1 Reference manuals ...................................... 3
   1.2.2 Product data sheets .................................... 3

### Section 2: System Overview

### Section 3: Using TankMaster

3.1 What is TankMaster? ........................................... 13
3.2 TankMaster software package .................................. 14
3.3 Installing the TankMaster software ............................ 16
   3.3.1 System requirements ................................... 16
   3.3.2 Installed software modules .............................. 16
   3.3.3 Installation procedure .................................. 17
3.4 Installing a Tank Gauging system .............................. 19
3.5 Illegal characters ............................................. 19

### Section 4: The WinSetup Main Window

4.1 Menus ......................................................... 23
4.2 Toolbar ......................................................... 25
4.3 Status bar ...................................................... 26
4.4 Workspace - viewing tanks and devices ....................... 27
   4.4.1 Workspace ............................................... 28
   4.4.2 Icons ....................................................... 29
4.5 User management .............................................. 31
   4.5.1 Logging on to TankMaster ............................... 32
   4.5.2 To administrate user accounts ......................... 33
   4.5.3 To set required access levels .......................... 35
   4.5.4 To change protection level of separate windows ....... 36
   4.5.5 To change password .................................... 37
   4.5.6 To change inactivity timeout ............................ 38

### Section 5: Installing a Rosemount Tank Gauging System

5.1 System configuration overview ................................. 40
   5.1.1 Preparations ............................................. 40
   5.1.2 Installation procedure ................................... 40
   5.1.3 Using the device installation wizard ................. 43
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.2</td>
<td>Communication protocol setup</td>
<td>44</td>
</tr>
<tr>
<td>5.2.1</td>
<td>Master protocol channel configuration</td>
<td>45</td>
</tr>
<tr>
<td>5.2.2</td>
<td>Slave protocol channel configuration</td>
<td>48</td>
</tr>
<tr>
<td>5.2.3</td>
<td>Log file configuration</td>
<td>52</td>
</tr>
<tr>
<td>5.2.4</td>
<td>Changing the current protocol channel configuration</td>
<td>52</td>
</tr>
<tr>
<td>5.2.5</td>
<td>Protocol server configuration</td>
<td>53</td>
</tr>
<tr>
<td>5.3</td>
<td>Preferences</td>
<td>54</td>
</tr>
<tr>
<td>5.3.1</td>
<td>Measurement units.</td>
<td>54</td>
</tr>
<tr>
<td>5.3.2</td>
<td>Ambient air temperature.</td>
<td>55</td>
</tr>
<tr>
<td>5.3.3</td>
<td>Inventory</td>
<td>56</td>
</tr>
<tr>
<td>5.3.4</td>
<td>Miscellaneous</td>
<td>57</td>
</tr>
<tr>
<td>5.3.5</td>
<td>Setting the name tag prefixes.</td>
<td>58</td>
</tr>
<tr>
<td>5.3.6</td>
<td>E-mail configuration</td>
<td>59</td>
</tr>
<tr>
<td>5.3.7</td>
<td>Tank view layout</td>
<td>60</td>
</tr>
<tr>
<td>5.3.8</td>
<td>Tank visibility</td>
<td>62</td>
</tr>
<tr>
<td>5.4</td>
<td>Field device installation - overview</td>
<td>64</td>
</tr>
<tr>
<td>5.4.1</td>
<td>Configuration.</td>
<td>64</td>
</tr>
<tr>
<td>5.5</td>
<td>Installing a Rosemount 2460 System Hub</td>
<td>65</td>
</tr>
<tr>
<td>5.6</td>
<td>Installing a Rosemount 2410 Tank Hub</td>
<td>66</td>
</tr>
<tr>
<td>5.6.1</td>
<td>Installation wizard.</td>
<td>66</td>
</tr>
<tr>
<td>5.6.2</td>
<td>Summary of Tank Hub installation and configuration</td>
<td>78</td>
</tr>
<tr>
<td>5.7</td>
<td>Installing a Rosemount 5900 Radar Level Gauge</td>
<td>80</td>
</tr>
<tr>
<td>5.7.1</td>
<td>Configuration via the Properties window</td>
<td>81</td>
</tr>
<tr>
<td>5.7.2</td>
<td>Installing a 5900 using the installation wizard</td>
<td>88</td>
</tr>
<tr>
<td>5.7.3</td>
<td>Advanced configuration</td>
<td>92</td>
</tr>
<tr>
<td>5.8</td>
<td>Installing the 5900S 2-in-1 version</td>
<td>95</td>
</tr>
<tr>
<td>5.8.1</td>
<td>Overview.</td>
<td>95</td>
</tr>
<tr>
<td>5.8.2</td>
<td>Installation and configuration.</td>
<td>97</td>
</tr>
<tr>
<td>5.9</td>
<td>Installing Auxiliary Tank Devices</td>
<td>109</td>
</tr>
<tr>
<td>5.9.1</td>
<td>Opening the Properties window.</td>
<td>109</td>
</tr>
<tr>
<td>5.9.2</td>
<td>Communication parameter setup</td>
<td>110</td>
</tr>
<tr>
<td>5.9.3</td>
<td>Temperature sensor configuration</td>
<td>111</td>
</tr>
<tr>
<td>5.9.4</td>
<td>Average temperature calculation</td>
<td>113</td>
</tr>
<tr>
<td>5.9.5</td>
<td>Auxiliary sensor configuration</td>
<td>114</td>
</tr>
<tr>
<td>5.9.6</td>
<td>Advanced parameter source configuration</td>
<td>116</td>
</tr>
<tr>
<td>5.9.7</td>
<td>2230 Graphical Field Display</td>
<td>119</td>
</tr>
<tr>
<td>5.9.8</td>
<td>Analog input</td>
<td>121</td>
</tr>
<tr>
<td>5.10</td>
<td>Installing a Rosemount 5400</td>
<td>123</td>
</tr>
</tbody>
</table>
5.10.1 Configuration via 5400 properties .............................................. 124
5.10.2 Advanced configuration .......................................................... 129
5.10.3 Installing a 5400 using the installation wizard ......................... 131
5.11 Installing a Rosemount 5300 ........................................................... 135
5.11.1 Configuration via 5300 Properties ............................................ 136
5.11.2 Advanced Configuration .......................................................... 140
5.11.3 Installing a 5300 using the installation wizard ......................... 142
5.12 Installing a tank ........................................................................... 146
5.12.1 Overview .................................................................................. 146
5.12.2 Starting the tank installation wizard ........................................ 147
5.12.3 Installing a new tank ................................................................. 148
5.12.4 Summary of Tank Installation and Configuration ..................... 156
5.12.5 To change tank configuration .................................................... 157
5.12.6 To uninstall a tank ................................................................. 158
5.13 Adding a tank ............................................................................... 159
5.13.1 Adding a new tank and a new 2410 Tank Hub ......................... 159
5.13.2 Adding a new tank to an existing 2410 Tank Hub .................... 162
5.14 Level gauge calibration ................................................................. 168
5.14.1 Manual Adjustment ................................................................. 168
5.14.2 Using the Calibrate function .................................................... 169
5.15 Tank capacity ............................................................................. 170
5.16 Tank Entry ................................................................................... 171
5.17 Setting up a hybrid system ............................................................ 172

Section 6: Device Handling
6.1 To change device configuration ..................................................... 181
6.2 To uninstall a device ..................................................................... 183

Section 7: Service Functions
7.1 Section overview ........................................................................... 187
7.2 Safety messages ............................................................................ 187
7.3 System status ................................................................................ 188
7.4 Customizing the Tools menu in WinSetup ................................... 189
7.5 User defined temperature conversion ......................................... 191
  7.5.1 User defined linearization table .............................................. 192
  7.5.2 User defined formula .............................................................. 193
  7.5.3 User defined individual formula ............................................ 194
7.6 Viewing input and holding registers .......................................... 195
7.7 To edit holding registers .............................................................. 197
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.8</td>
<td>Viewing diagnostic registers</td>
</tr>
<tr>
<td>7.8.1</td>
<td>Configure</td>
</tr>
<tr>
<td>7.8.2</td>
<td>Restore to default setting</td>
</tr>
<tr>
<td>7.9</td>
<td>Logging measurement data</td>
</tr>
<tr>
<td>7.10</td>
<td>Saving and loading database registers</td>
</tr>
<tr>
<td>7.10.1</td>
<td>To save device registers for a single device</td>
</tr>
<tr>
<td>7.10.2</td>
<td>To save device registers for multiple devices</td>
</tr>
<tr>
<td>7.10.3</td>
<td>To recover a device database</td>
</tr>
<tr>
<td>7.11</td>
<td>Upgrading the device firmware</td>
</tr>
<tr>
<td>7.12</td>
<td>Tank Scan</td>
</tr>
<tr>
<td>7.12.1</td>
<td>Graph area</td>
</tr>
<tr>
<td>7.12.2</td>
<td>Legend/Options</td>
</tr>
<tr>
<td>7.12.3</td>
<td>File storage</td>
</tr>
<tr>
<td>7.12.4</td>
<td>Action buttons</td>
</tr>
<tr>
<td>7.12.5</td>
<td>Editing</td>
</tr>
<tr>
<td>7.13</td>
<td>Viewing tank data</td>
</tr>
<tr>
<td>7.13.1</td>
<td>Viewing data for all tanks</td>
</tr>
<tr>
<td>7.13.2</td>
<td>Viewing data for a single tank</td>
</tr>
<tr>
<td>7.14</td>
<td>Viewing alarm status</td>
</tr>
<tr>
<td>7.15</td>
<td>Protocol handling</td>
</tr>
<tr>
<td>7.15.1</td>
<td>Logging the channel communication</td>
</tr>
<tr>
<td>7.15.2</td>
<td>Saving the communication log to file</td>
</tr>
<tr>
<td>7.15.3</td>
<td>Searching for connected devices</td>
</tr>
<tr>
<td>7.15.4</td>
<td>Channel statistics</td>
</tr>
<tr>
<td>7.16</td>
<td>TankMaster Administrator</td>
</tr>
<tr>
<td>7.16.1</td>
<td>Log on</td>
</tr>
<tr>
<td>7.16.2</td>
<td>Changing the Administrator program password</td>
</tr>
<tr>
<td>7.16.3</td>
<td>Autostart</td>
</tr>
<tr>
<td>7.16.4</td>
<td>Backup</td>
</tr>
<tr>
<td>7.16.5</td>
<td>Restore</td>
</tr>
<tr>
<td>7.16.6</td>
<td>File version information</td>
</tr>
<tr>
<td>7.16.7</td>
<td>Processes</td>
</tr>
</tbody>
</table>

### Section 8: Menu Guide

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.1</td>
<td>File</td>
</tr>
<tr>
<td>8.2</td>
<td>View</td>
</tr>
<tr>
<td>8.3</td>
<td>Service</td>
</tr>
<tr>
<td>8.4</td>
<td>Tools</td>
</tr>
<tr>
<td>8.5</td>
<td>Help</td>
</tr>
</tbody>
</table>
Section 1 Introduction

This manual describes the recommended configuration procedure for setting up a Rosemount Tank Gauging system. The description is based on using the TankMaster Winsetup program as configuration tool. The manual also provides a brief description of the basic functions of TankMaster WinSetup.

For each device (5900S Radar Level Gauge, 2240S Multi-input Temperature Transmitter, 2410 Tank Hub, etc.) there is a reference manual which describes how to install the device (see “Technical documentation” on page 3 and Figure 1-1 on page 4).

Mechanical installation and wiring is described as well as service and troubleshooting. Once the device is installed, it needs to be configured. The Rosemount Tank Gauging System Configuration manual guides you through the process of setting up a Rosemount Tank Gauging system for proper operation with field devices and tanks.

The Rosemount Tank Gauging product portfolio includes a wide range of components for small and large customized tank gauging systems. The system includes various field devices, such as radar level gauges, temperature transmitters, and pressure transmitters for complete inventory control. The TankMaster software suite provides you with the tools that you need to configure and operate the Rosemount Tank Gauging system.
1.1 Manual overview

The *Rosemount Tank Gauging System Configuration* manual includes the following sections:

**Section 1: Introduction**

A description of the various components in the Rosemount Tank Gauging system.

**Section 2: System Overview**

A description of the various components in the Rosemount Tank Gauging system.

**Section 3: Using TankMaster**

An introduction to the TankMaster software package.

**Section 4: The WinSetup Main Window**

An introduction to the basic features of the WinSetup configuration program. It describes the workspace, menus, and various toolbars.

**Section 5: Installing a Rosemount Tank Gauging System**

A description of the recommended configuration procedure for a Rosemount Tank Gauging system.

**Section 6: Device Handling**

A short description of the basic functions for changing device configuration and how to uninstall devices from the WinSetup workspace.

**Section 7: Service Functions**

A description of various functions supported by TankMaster WinSetup for service and maintenance of field devices.

**Section 8: Menu Guide**

A guide to menus and menu options in the TankMaster WinSetup program.
1.2 Technical documentation

The Rosemount Tank Gauging System includes the following documentation:

1.2.1 Reference manuals
- Rosemount Tank Gauging System Configuration Manual (00809-0300-5100 / 300510EN)
- Rosemount 2460 (00809-0100-2460)
- Rosemount 2410 (00809-0100-2410/300530)
- Rosemount 5900S (00809-0100-5900)
- Rosemount 2240S (00809-0100-2240)
- Rosemount 2230 (00809-0100-2230)
- Rosemount 5900C (00809-0100-5901)
- Rosemount 5300 Series (00809-0100-4530)
- Rosemount 5400 Series (00809-0100-4026)
- Rosemount TankMaster WinOpi (303028)
- Rosemount Raptor Wireless Tank Gauging System (300570)

1.2.2 Product data sheets
- Rosemount Tank Gauging System Data Sheet (00813-0100-5100/704010EN)
- Rosemount 2460 System Hub Product Data Sheet (00813-0100-2460)
- Rosemount 2410 Product Data Sheet (00813-0100-2410)
- Rosemount 5900S Product Data Sheet (00813-0100-5900)
- Rosemount 5900C Product Data Sheet (00813-0100-5901)
- Rosemount 2240S Product Data Sheet (00813-0100-2240)
- Rosemount 2230 Product Data Sheet (00813-0100-2230)
- Rosemount 5300 Product Data Sheet (00813-0100-4530)
- Rosemount 5400 Product Data Sheet (00813-0100-4026)
- Rosemount Tank Gauging Installation Drawings
Figure 1-1. System and documentation structure
Section 2 System Overview

The Rosemount Tank Gauging system is a state-of-the-art inventory and custody transfer radar tank level gauging system. It is developed for a wide range of applications at refineries, tank farms and fuel depots, and fulfills the highest requirements on performance and safety.

The field devices on the tank communicate over the intrinsically safe Tankbus. The Tankbus is based on a standardized fieldbus, the FISCO(1) FOUNDATION™ fieldbus, and allows integration of any device supporting that protocol. By utilizing a bus powered 2-wire intrinsically safe fieldbus the power consumption is minimized. The standardized fieldbus also enables integration of other vendors’ equipment on the tank.

The Rosemount Tank Gauging product portfolio includes a wide range of components to build small or large customized tank gauging systems. The system includes various devices, such as radar level gauges, temperature transmitters, and pressure transmitters for complete inventory control. Such systems are easily expanded thanks to the modular design.

The Rosemount Tank Gauging system is a versatile system that is compatible with and can emulate all major tank gauging systems. Moreover, the well-proven emulation capability enables step-by-step modernization of a tank farm, from level gauges to control room solutions.

It is possible to replace old mechanical or servo gauges with modern Rosemount Tank Gauging devices, without replacing the control system or field cabling. It is further possible to replace old HMI/SCADA-systems and field communication devices without replacing the old gauges.

There is a distributed intelligence in the various system units which continuously collect and process measurement data and status information. When a request for information is received an immediate response is sent with updated information.

The flexible Rosemount Tank Gauging system supports several combinations to achieve redundancy, from control room to the different field devices. Redundant network configuration can be achieved at all levels by doubling each unit and using multiple control room work stations.

(1) See documents IEC 61158-2 and IEC/TS 60079-27
Figure 2-1. Rosemount Tank Gauging system architecture

NON-HAZARDOUS AREA

HAZARDOUS AREA

TankMaster PC

2180 Field Bus Modem

2460 System Hub

TRL2 Modbus

Plant Host Computer

2410 Tank Hub

2230 Display

Tankbus

5900S Radar Level Gauge

2240S Temperature Transmitter

3051S Pressure Transmitter

5900S Radar Level Gauge

644 Temperature Transmitter

644

Segment coupler

2410 Tank Hub

5400 Level Transmitter

2240S Temperature Transmitter

644

5300 Level Transmitter

Tankbus

Plant Host Computer

TankMaster PC
Figure 2-2. Rosemount Tank Gauging system architecture for wireless systems

NON-HAZARDOUS AREA

HAZARDOUS AREA

TankMaster PC

Smart Wireless Gateway

2410 Tank Hub

2230 Display

2240S Temperature Transmitter

5900S Radar Level Gauge

THUM adapter

3051S Pressure Transmitter

5900S Radar Level Gauge

644 Temperature Transmitter

Segment coupler

THUM adapter
Figure 2-3. Rosemount Tank Gauging system architecture in a Foundation fieldbus network

- **NON-HAZARDOUS AREA**
  - PC
  - FOUNDATION Fieldbus Power Supply

- **HAZARDOUS AREA**
  - 2230 Display
  - 3051S Pressure Transmitter
  - 5900S Radar Level Gauge
  - 2240S Temperature Transmitter
  - Segment coupler

- **CUSTODY TRANSFER / INVENTORY TANK GAUGING**
  - 5300
  - 5400

- **OPERATIONAL CONTROL**
  - 5400
  - 2240S
TankMaster HMI Software

TankMaster is a powerful Windows-based Human Machine Interface (HMI) for complete tank inventory management. It provides configuration, service, set-up, inventory, and custody transfer functions for Rosemount Tank Gauging systems and other supported instruments.

TankMaster is designed to be used in the Windows 7 and Microsoft Windows Server 2008 environment providing easy access to measurement data from your Local Area Network (LAN).

The TankMaster WinOpi program lets the operator monitor measured tank data. It includes alarm handling, batch reports, automatic report handling, historical data sampling as well as inventory calculations such as Volume, Observed Density and other parameters. A plant host computer can be connected for further processing of data.

The TankMaster WinSetup program is a graphical user interface for installation, configuration and service of devices in the Rosemount Tank Gauging system.

Rosemount 2460 System Hub

The 2460 System Hub is a data concentrator that continuously polls and stores data from field devices such as radar level gauges and temperature transmitters in a buffer memory. Whenever a request for data is received, the 2460 can immediately send data from the updated buffer memory for a group of tanks.

Rosemount 2410 Tank Hub

The Rosemount 2410 Tank Hub acts as a power supply to the connected field devices in the hazardous area using the intrinsically safe Tankbus.

The 2410 collects measurement data and status information from field devices on a tank. It has two external buses for communication with various host systems.

There are two versions of the 2410; one for single tank operation and one for multiple tanks operation. The 2410 multiple tanks version supports up to 10 tanks and 16 devices. With the Rosemount 5300 and 5400 level transmitters the 2410 supports up to 5 tanks.

The 2410 is equipped with two relays which support configuration of up to 10 “virtual” relay functions allowing you to specify several source signals for each relay.

The 2410 supports Intrinsically Safe (IS) and Non-Intrinsically Safe (Non-IS) analog 4-20 mA inputs/outputs. By connecting a Smart Wireless THUM™ Adapter to the IS HART 4-20 mA output, the 2410 is capable of wireless communication with a Smart Wireless Gateway in a WirelessHART network.
Rosemount 5900S Radar Level Gauge

The Rosemount 5900S Radar Level Gauge is an intelligent instrument for measuring the product level inside a tank. Different antennas can be used in order to meet the requirements of different applications. The 5900S can measure the level of almost any product, including bitumen, crude oil, refined products, aggressive chemicals, LPG and LNG.

The Rosemount 5900S sends microwaves towards the surface of the product in the tank. The level is calculated based on the echo from the surface. No part of the 5900S is in actual contact with the product in the tank, and the antenna is the only part of the gauge that is exposed to the tank atmosphere.

The 2-in-1 version of the 5900S Radar Level Gauge has two radar modules in the same transmitter housing allowing two independent level measurements using one antenna and one tank opening.

Rosemount 5300 Guided Wave Radar

The Rosemount 5300 is a premium 2-wire guided wave radar for level measurements on liquids, to be used in a wide range of medium accuracy applications under various tank conditions. Rosemount 5300 includes the 5301 for liquid level measurements and the 5302 for liquid level and interface measurements.

Rosemount 5400 Radar Level Transmitter

The Rosemount 5400 is a reliable 2-wire non-contact radar level transmitter for liquids, to be used in a wide range of medium accuracy applications under various tank conditions.

Rosemount 2240S Multi-Input Temperature Transmitter

The Rosemount 2240S Multi-input Temperature Transmitter can connect up to 16 temperature spot sensors and an integrated water level sensor.

Rosemount 2230 Graphical Field Display

The Rosemount 2230 Graphical Field Display presents tank gauging data such as level, temperature, and pressure. The four softkeys allow you to navigate through the different menus to provide all tank data, directly in the field. The Rosemount 2230 supports up to 10 tanks. Up to three 2230 displays can be used on a single tank.

Rosemount 644 Temperature Transmitter

The Rosemount 644 is used with single spot temperature sensors.

Rosemount 3051S Pressure Transmitter

The 3051S series consists of transmitters and flanges suitable for all kinds of applications, including crude oil tanks, pressurized tanks and tanks with / without floating roofs.

By using a 3051S Pressure Transmitter near the bottom of the tank as a complement to a 5900S Radar Level Gauge, the density of the product can be calculated and presented. One or more pressure transmitters with different scalings can be used on the same tank to measure vapor and liquid pressure.
Rosemount 2180 Field Bus Modem

The Rosemount 2180 Field Bus Modem (FBM) is used for connecting a TankMaster PC to the TRL2 communication bus. The 2180 is connected to the PC using either the RS232 or the USB interface.

Rosemount Smart Wireless Gateway and Rosemount Smart Wireless THUM Adapter

A THUM Adapter allows wireless communication between a 2410 Tank Hub and a 1410/1420 Smart Wireless Gateway. The gateway is the network manager that provides an interface between field devices and the TankMaster inventory software or host / DCS systems.

See the Rosemount Tank Gauging System Data Sheet (Document No. 00813-0100-5100) for more information on the various devices and options.
Section 3 Using TankMaster

3.1 What is TankMaster?

*TankMaster* is a software package designed by Emerson Process Management/Rosemount Tank Gauging for inventory management as well as configuration of level gauging equipment. The *TankMaster* program package provides you with powerful and easy-to-use tools for installation and configuration of Rosemount’s tank gauging system. Devices such as field communication units, Tank Hubs, and radar level gauges can easily be installed.

The operator’s interface provides inventory and custody transfer functions and gives you a clear overview of installed devices and tanks. For each tank you can easily see the associated transmitters and data acquisition units.

*TankMaster* is designed to be used in the Microsoft Windows 7 and Microsoft Windows Server 2008 environment providing easy access to measurement data from your Local Area Network.

The *TankMaster* system allows you to use various protocols such as the TRL2 Modbus and Enraf GPU. Interfaces such as RS232, and RS485 can be used for communication with field devices. TankMaster clients and servers can be integrated in Local Area Networks (LAN) for maximum availability. You can easily change protocol, device, and tank configuration at any time.

Measured data is presented in real-time and you can customize the view of tank data to suit your needs.

**Key features**

- Monitoring of measured data.
- Clear overview of installed tanks and devices.
- Simple installation by using “wizards”.
- Open connectivity.
- Object-oriented user friendly Graphical User Interface.
3.2 TankMaster software package

Rosemount TankMaster includes several software modules:

- WinOpi
- WinView
- WinSetup
- Tank Server
- Master Protocol Server
- Slave Protocol Server
- Administrator

Figure 3-1. TankMaster software modules

WinOpi

WinOpi is the operator’s interface to the Rosemount Tank Gauging system. It communicates with the Tank Server and the different protocol servers to let the user monitor measured tank data. WinOpi supports custody transfer and provides alarm handling, batch reports, automatic report handling, historical data sampling as well as inventory calculations such as volume, observed density and other parameters.

WinView

WinView is a software package with basic inventory capabilities. It is a cost efficient alternative for operational control at smaller tank terminals, marketing terminals, biofuels and chemical plants, etc. It communicates with the Tank Server and the different protocol servers to let the user monitor measured tank data. WinView also provides alarm handling, automatic report handling as well as inventory calculations for volume and mass.
WinSetup

The *WinSetup* program is a graphical user interface for installation, configuration and service of devices such as the 5900S Radar Level Gauge and the 2240S Multi-input Temperature Transmitter.

Tank Server

The *Tank Server* communicates with devices via the *Master protocol server* and handles configuration data for all the installed tanks and devices. Tank and device names, configuration data such as antenna type, number of connected temperature elements and many other parameters are stored by the *Tank Server*. The *Tank Server* collects measured data from connected devices and provides these data to the *WinOpi/WinSetup* user interface.

Master protocol server

The *Master Protocol Server* transfers configuration data and measured data between the *Tank Server* and connected devices in a Rosemount Tank Gauging system. The *Master Protocol Server* is able to communicate with various types of field devices such as radar level gauges, field communication units, temperature transmitters, and pressure sensors to collect measured data such as level, temperature, and pressure.

Slave protocol server

The *Slave Protocol Server* is used to connect the *TankMaster* system to a host computer (DCS system). The *Slave Protocol Server* exchanges tank data between the *Tank Server* and the host computer.

Administrator program

The *Administrator* program allows you to start and stop TankMaster, and to specify which TankMaster software modules that will start automatically when the PC starts up. It also includes a backup and restore function, and functions for handling redundant Tank Servers and Batch Servers.

OPC Server with browser

TankMaster uses OPC Data Access 2.0 (OLE for Process Control), an open industry standard, which eliminates the need for costly customized software integration. With the OPC server and the browser it is easy to import all custody transfer and inventory data to other OPC clients such as different DCS:s, PLC:s, Scada systems, or Microsoft Office programs. This way, operators and plant management are better armed to make timely decisions as they work with distributed inventory and tank gauging data. (Website OPC Foundation: www.opcfoundation.org).

Customized views

In TankMaster you can change general and specific tank view and setup windows. There are a number of options to design TankMaster as you like; you can either modify the existing windows or design completely new ones. For example you can have a photo of the plant giving a quick realistic view and just by clicking a specific tank you will get corresponding tank data.

Batch Server (optional)

The *Batch Server* provides functions for starting, monitoring and closing batch transfers between tanks. It also generates various reports during and after a batch transfer.
3.3 **Installing the TankMaster software**

### 3.3.1 System requirements

The following system specification is recommended to run TankMaster version 6.B6 or higher:

**Table 3-1. System requirements**

<table>
<thead>
<tr>
<th>General</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Product</strong></td>
<td>Rosemount TankMaster; WinOpi, WinSetup, WinView</td>
</tr>
<tr>
<td><strong>Operating system</strong></td>
<td>English version of:</td>
</tr>
<tr>
<td></td>
<td>• Windows 7 Professional, 32- and 64-bit versions, with service pack 1(SP1)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 R2 with service pack 1(SP1)</td>
</tr>
<tr>
<td><strong>TankMaster PC Hardware</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Processor</strong></td>
<td>• 2.5 GHz, multi core processor: Windows 7, Windows Server 2008</td>
</tr>
<tr>
<td><strong>Internal Memory (RAM)</strong></td>
<td>• 4 GB: Windows 7 (32-bit)</td>
</tr>
<tr>
<td></td>
<td>• 8 GB: Windows 7 (64-bit), Windows Server 2008 R2</td>
</tr>
<tr>
<td><strong>Hard Disk</strong></td>
<td>40 GB</td>
</tr>
<tr>
<td></td>
<td>• TankMaster + SQL Server 2005 Express needs approximately 600 MB</td>
</tr>
<tr>
<td></td>
<td>• Windows 7 and Windows Server 2008 need at least 15 GB</td>
</tr>
<tr>
<td><strong>Serial Ports</strong></td>
<td>USB (RS232)</td>
</tr>
<tr>
<td><strong>Monitor</strong></td>
<td>A 22 inch or larger monitor is recommended.</td>
</tr>
<tr>
<td><strong>Hardware key</strong></td>
<td>One key connected to a USB port for each PC with a TankMaster server.</td>
</tr>
<tr>
<td></td>
<td>TankMaster view nodes do not require a hardware key.</td>
</tr>
<tr>
<td></td>
<td>In custody transfer systems a hardware key connected to a parallel port is also required.</td>
</tr>
</tbody>
</table>

**Note!**
A hardware key is **not** required to run WinSetup.

### 3.3.2 Installed software modules

The following software program modules are installed:

- TankMaster WinSetup program
- TankMaster WinOpi program
- Tank Server
- Modbus Master Protocol server
- Various Master Protocol servers
- Various Slave Protocol servers
- Batch server (optional)

---

*For previous TankMaster versions other system requirements apply. Please contact Emerson Process Management/Rosemount Tank Gauging for more information.*
3.3.3 Installation procedure

To install the TankMaster software package do the following:

1. Insert the TankMaster CD-ROM. The installation wizard starts automatically and the TankMaster installation CD start-up screen appears:

![TankMaster Installation CD](image)

**Note!**
If the TankMaster installation wizard does not start automatically when the CD-ROM is inserted, double-click the file Tmcd.exe, or click the Windows Start button, choose Run and select the Tmcd.exe file on the TankMaster installation CD.

2. Click the **Install** button to start the TankMaster software installation procedure. Follow the instructions in the installation wizard.

3. In order to read the TankMaster manuals in pdf format you will have to install the Acrobat Reader software:
   a. click the Acrobat Reader button and follow the on-screen instructions
   b. To open a reference manual, click the **Manuals** button, select a manual and click the **View** button.

4. Finish the installation.
Installation options

There are different installation options available:

Table 3-2. Installations options

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Demo</td>
<td>TankMaster in demo mode with demo database. Devices, tanks and measurement values will be simulated.</td>
</tr>
<tr>
<td>Client</td>
<td>Client installation only, i.e. no Batch Server, Tank Server or Master Protocol Server will be installed. Suitable for network clients connected to one or several common Tank Servers.</td>
</tr>
<tr>
<td>Server and Client</td>
<td>Suitable for standalone systems, and for network servers.</td>
</tr>
<tr>
<td>Redundant server</td>
<td>Server and client installation with possibility to setup redundant Tank Servers. Note that the redundant Batch Server function has to be manually configured after installation.</td>
</tr>
</tbody>
</table>
3.4 Installing a Tank Gauging system

Setting up a Tank Level Gauging system comprises installation and configuration of devices and tanks.

Tank installation

Tank installation includes specifying tank type, level gauge and transmitters to associate with the tank, and to define which source signals to use as input for various tank measurement variables.

Device installation

Device installation includes tasks such as configuration of field bus communication, specifying tank height and other geometry parameters, configuration of device specific parameters for radar level gauges, temperature and pressure transmitters.

Wizards

In order to facilitate the installation process, TankMaster WinSetup guides you through the installation procedure by using so called “wizards”. WinSetup automatically walks through a step-by-step procedure which lets you focus on the important issues rather than trying to remember what to do next. The Online Help provides information for each step in case you need further assistance.

3.5 Illegal characters

Naming objects in TankMaster using certain characters may cause TankMaster to malfunction. The following characters should be avoided:

Table 3-3. Illegal characters

<table>
<thead>
<tr>
<th>\</th>
<th>Reverse solidus</th>
<th>%</th>
<th>Percent sign</th>
</tr>
</thead>
<tbody>
<tr>
<td>/</td>
<td>Solidus</td>
<td>&lt;</td>
<td>Less-than sign</td>
</tr>
<tr>
<td>?</td>
<td>Question mark</td>
<td>&gt;</td>
<td>Greater-than sign</td>
</tr>
<tr>
<td>*</td>
<td>Asterisk</td>
<td>{</td>
<td>Left curly bracket</td>
</tr>
<tr>
<td>[</td>
<td>Left square bracket</td>
<td>}</td>
<td>Right curly bracket</td>
</tr>
<tr>
<td>]</td>
<td>Right square bracket</td>
<td>'</td>
<td>Apostrophe</td>
</tr>
<tr>
<td></td>
<td>Vertical line</td>
<td>&quot;</td>
<td>Quotation mark</td>
</tr>
</tbody>
</table>
Section 4 The WinSetup Main Window

The TankMaster main window includes the Workspace to display tanks and devices, a menu bar at the top of the screen, a status bar at the bottom of the screen and a number of buttons in the toolbar.

Figure 4-2. The WinSetup main window
The *Workspace* window can be moved anywhere on the *Main* window. It can be docked to either side, to the top, or to the bottom. It can also be left floating in the *Main* window.

**Figure 4-3. The WinSetup workspace**

Right click in the *Workspace* window and choose **Allow Docking** to place the *Workspace* window along the *Main* window side.
4.1 Menus

The menu bar at the top of the screen contains menus such as File, View, Service, Tools, and Help.

Figure 4-4. The WinSetup menu

Service menu options are also available by clicking the right mouse button. Different options are available depending on the type of object selected in the Workspace window. For example, clicking the right mouse button on the Devices folder will open the following menu:

Figure 4-5. Service menu

Clicking the right mouse button on a device icon brings up a menu with different configuration and service options:
Figure 4-6. Right-click menu

- Network Connections
- This Workstation
- Tasks
- Devices
  - SYSHUB-201
  - HUB-1
  - ATD-TK-1
- Protocols

- Uninstall
- Save Database to File...
- Upload Database...
- View Input Registers...
- View Holding Registers...
- View Diagnostic Registers...
- Restart...
- Logging...
- Program...
- Calibrate...
- LPG Setup...
- LPG Verify Reference Pn...
- Custody Transfer Config...
- Properties
4.2 Toolbar

The toolbar provides buttons acting as shortcuts to certain menu options. Normally the Toolbar is visible. To hide it, open the View menu and deselect the Toolbar option:

![Figure 4-7. The WinSetup Toolbar](image)

The following items are included in the standard toolbar:

![Figure 4-8. Toolbar items](image)

1. Log off to View Only mode.
2. Log on to TankMaster as Operator, Supervisor or Administrator
3. Rename a tank
4. Search for a tank or a device in the workspace tree structure
5. Open the Properties dialog
6. Open the Tank View window
7. Install a new tank
8. Install a new device
9. Uninstall a tank
10. Uninstall a device
11. Turn the Workspace window On or Off
12. About WinSetup
4.3 Status bar

The status bar is located at the bottom of the TankMaster main window. It provides general information about the current system state.

To hide the TankMaster status bar, open the View menu and deselect the Status bar option.

The status bar shows information about a device, tank or any other item that is selected in the WinSetup main window. Connection status, current user, current protection level (View Only, Operator etc.), and operation status are shown as well.
4.4 Workspace - viewing tanks and devices

The workspace displays an overview of all devices and tanks. You can switch between two different views: Logical and Physical view.

Figure 4-10. The WinSetup workspace Logical and Physical views

In the workspace you can perform various tasks such as:
- Install and configure tanks, devices, and protocols
- Remove tanks and devices
- Change the configuration of tanks and devices
- View database and input registers
- Setup the tank view layout
- Specify tags for tank and device names
- Upload new application software to a radar tank gauge
- View communication log
4.4.1 Workspace

The *Workspace* window shows the installed tanks and devices and available communication protocols. It also provides information about the configuration of installed devices.

**Ex.1** In the Logical View all installed tanks and devices, as well as available communication protocols, are organized in separate folders to provide a clear overview of the system.

A “+”-sign indicates that a device is connected to associated devices.

**Ex.2** The *Tanks* folder contains an overview of the installed tanks. For each tank the associated devices are displayed.

The *Workspace* provides information that reflects the system configuration. In this example the symbols indicate that level gauge LT-1 communicates with *This Workstation* via Tank Hub HUB-101 and 2460 System Hub SYSHUB-201.

**Ex.3** The available communication protocols are displayed in the *Protocols* folder.
## 4.4.2 Icons

In the *Workspace* window the different tanks and devices are represented by the following icons:

**Table 4-4. Device icons**

<table>
<thead>
<tr>
<th>Devices</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon] Rosemount 2460 System Hub</td>
</tr>
<tr>
<td>![Icon] Rosemount 2410 Tank Hub</td>
</tr>
<tr>
<td>![Icon] Rosemount 2410 Tank Hub (Simulation Mode)</td>
</tr>
<tr>
<td>![Icon] Rosemount 5900S Radar Level Gauge (configured / not configured)</td>
</tr>
<tr>
<td>![Icon] Rosemount 5400 Series Radar Transmitter</td>
</tr>
<tr>
<td>![Icon] Rosemount 5300 Series Radar Transmitter</td>
</tr>
<tr>
<td>![Icon] ATD (Auxiliary Tank Device; for example Rosemount 2240S, Rosemount 3051S). Configured / not configured.</td>
</tr>
<tr>
<td>![Icon] Smart Wireless Gateway</td>
</tr>
<tr>
<td>![Icon] Smart Wireless THUM® Adapter</td>
</tr>
<tr>
<td>![Icon] Rex Radar Tank Gauge (RTG)</td>
</tr>
<tr>
<td>![Icon] Rosemount 2160/2165/2175 Field Communication Unit (FCU)</td>
</tr>
<tr>
<td>![Icon] Slave Data Acquisition Unit (SDAU)</td>
</tr>
<tr>
<td>![Icon] COM port status</td>
</tr>
<tr>
<td>![Icon] COM port status for wireless system</td>
</tr>
<tr>
<td>![Icon] Communication Protocol</td>
</tr>
<tr>
<td>![Icon] Communication Protocol Channel</td>
</tr>
<tr>
<td>![Icon] TRL PU</td>
</tr>
<tr>
<td>![Icon] IOT 51XX</td>
</tr>
<tr>
<td>![Icon] MCG32XX</td>
</tr>
<tr>
<td>![Icon] MDPII</td>
</tr>
<tr>
<td>![Icon] CIU</td>
</tr>
<tr>
<td>![Icon] DS4</td>
</tr>
</tbody>
</table>
### Table 4-5. Tank icons

<table>
<thead>
<tr>
<th>Tanks</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon] Fixed Roof, HTG Fixed Roof</td>
</tr>
<tr>
<td>![Icon] Floating Roof, HTG Floating Blanket</td>
</tr>
<tr>
<td>![Icon] Sphere, LPG Sphere</td>
</tr>
<tr>
<td>![Icon] Horizontal, LPG Horizontal</td>
</tr>
<tr>
<td>![Icon] HTG Fixed Roof</td>
</tr>
<tr>
<td>![Icon] HTG Floating Roof, HTG Floating Blanket</td>
</tr>
<tr>
<td>![Icon] Servo Tank Fixed Roof</td>
</tr>
<tr>
<td>![Icon] Servo Tank Floating Roof</td>
</tr>
<tr>
<td>![Icon] Servo Tank Sphere, Servo Tank Sphere LPG</td>
</tr>
<tr>
<td>![Icon] Servo Tank Horizontal, Servo Tank Horizontal LPG</td>
</tr>
</tbody>
</table>
4.5 **User management**

TankMaster provides several protection levels allowing you to prevent unauthorized changes. These protection levels are categorized as **User Access Levels** and **User Sub Access Levels**.

The **User Access Levels** are Chief Administrator, Administrator, Supervisor, Operator, and View Only. Each user access level has five **User Sub Access Levels** providing a large number of unique access levels.

In order to change tank and device configuration, install new tanks and devices, calibrate a level gauge, change holding register values etc. you have to be logged on to the appropriate TankMaster user access level. See “To set required access levels” on page 35 for more information.

You can be logged on in Chief Administrator, Administrator, Supervisor, Operator, or View Only mode. The default usernames and passwords for the **User Access Levels** are:

<table>
<thead>
<tr>
<th>User Access Level</th>
<th>Username PASSWORD</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Only</td>
<td>Default username: <strong>view</strong></td>
</tr>
<tr>
<td></td>
<td>Default password: <strong>view</strong></td>
</tr>
<tr>
<td>Operator</td>
<td>Default username: <strong>operator</strong></td>
</tr>
<tr>
<td></td>
<td>Default password: <strong>oper</strong></td>
</tr>
<tr>
<td>Supervisor</td>
<td>Default username: <strong>supervisor</strong></td>
</tr>
<tr>
<td></td>
<td>Default password: <strong>super</strong></td>
</tr>
<tr>
<td>Administrator</td>
<td>Default username: <strong>administrator</strong></td>
</tr>
<tr>
<td></td>
<td>Default password: <strong>admin</strong></td>
</tr>
<tr>
<td>ChiefAdministrator</td>
<td>Default username: <strong>chiefadmin</strong></td>
</tr>
<tr>
<td></td>
<td>Default password: <strong>chief</strong></td>
</tr>
</tbody>
</table>
4.5.1 Logging on to TankMaster

1. From the **File** menu choose **Log On** or click the Log On button in the WinSetup toolbar.

![Logon to TankMaster Window]

2. Type your Username and Password. The password is case sensitive but the username is not.

**Note!**
If logging on fails five consecutive times the user account is disabled. In this case the user account has to be enabled by an administrator.

3. Click the **OK** button.
The currently logged on user and the corresponding protection level is displayed in the WinSetup status bar.

![Status Bar Display]
4.5.2 To administrate user accounts

TankMaster allows you to setup a number of users at different levels and sub levels. You must be logged on as an Administrator in order to add new user accounts or to change the existing user account settings.

To add a new user:

1. Log on as an Administrator.
2. From the Tools>Administrative Tools menu choose User Manager.
3. In the User Manager window select a cell in an empty row and click the New button.
4. Type a user name and a password. If you like, you may enter a description in the Description field.
5. Choose the desired User Access Level and Sub Level and click the OK button. See “User management” on page 31 for further information on the available User Access Levels and Sub Levels.
6. Check that the new user appears in the User Manager window. Select the "Use first account..." box if you want a default user name to appear in the Log On dialog whenever it is opened. If this box is unmarked the User Name field is empty when the Log On dialog opens.

7. To configure the access sub level descriptions, click the Config Desc button and enter new descriptions in the various fields.

8. Click the OK button.
4.5.3 To set required access levels

In TankMaster WinSetup, you can set the access level required for the following actions:

- Tank/Device Install and Uninstall
- Tank/Device Configuration
- Replace, Restore and Restart Device
- Protocol Configuration
- Exit WinSetup
- Add Program (see “Customizing the Tools menu in WinSetup” on page 189)
- Start Program (in the Tools menu)

For example, if you are logged on as an Operator (* * * * *), you are not allowed to exit WinSetup if the required exit level for this action is set to Supervisor (*) or higher.

To set the required access levels:

1. From the Tools/Administrative Tools menu choose Set Required Access Levels.

   ![Set Required Access Levels dialog box](image)

   **Note!**
   You have to be logged on as an Administrator (* * * * *) to be able to set the required access levels. To create an Administrator (* * * * *) account, see “To administrate user accounts” on page 33.

2. Set the required access levels for each type of action and click the OK button.
Section 4: The WinSetup Main Window

July 2015

System Configuration Manual
00809-0300-5100, Rev BA

4.5.4 To change protection level of separate windows

In TankMaster it is possible to set a Protection Level for a specific window, e.g. the Properties window for a Rosemount 5900S Radar Level Gauge. This function is only available if you are logged on at the Administrator ("* * * *") level. To change the protection level do the following:

1. Put the cursor on the icon at the upper left corner and click the left mouse button.

   ![Diagram of TankMaster window with protection level settings]

2. Choose the Protection Level... option.

   **NOTE!**
   You have to be logged on as an Administrator ("* * * *") to be able to change the Protection Level. To create an Administrator ("* * * *") account, see “To administrate user accounts” on page 33.

3. Select the desired protection level from the drop down menus and click the OK button. Now changes in this window can only be performed if you are logged on at the specified Protection Level or higher.
4.5.5 To change password

TankMaster allows you to change your password at any time:

1. From the **Tools/Administrative Tools** menu choose the **Set Password** option.

![Change User Password dialog box](image)

2. Select the Tank Server on which your user account is valid. You can see the different servers in the **WinSetup** workspace window. (If you are logged on, the current server is already selected in the **Change User Password** window).

3. Enter your username if the workspace is in View Only mode. If you are already logged on, your username appears in the Username field.

4. Enter the old password and the new password in the corresponding fields.

**Note!**
The password is case sensitive.

5. Confirm the new password and click the **OK** button.
4.5.6 To change inactivity timeout

TankMaster WinSetup includes the option to set a timeout after which the current user is automatically logged off. The timeout period is reset each time the user performs an activity that requires an access level check, for example changing the configuration of a device or logging on to WinSetup.

To set the Inactivity Timeout:

1. From the Tools/Administrative Tools menu choose the Set Inactivity Timeout option (you have to be logged on as Administrator).

2. Type the desired value in the corresponding input field.

3. Click the OK button.
This section describes how to install and configure a Rosemount Tank Gauging system by using the Rosemount TankMaster WinSetup configuration program.
5.1 System configuration overview

5.1.1 Preparations

Before installing a Rosemount Tank Gauging system you should ensure that the following information is available:

- A plan of all field devices and tanks.
- Unit IDs of each device (Unit ID is a unique identifier given to each device at factory).
- Modbus addresses of level devices and ATD devices. The devices are shipped with default addresses which will be changed at system configuration. The Modbus addresses are configured in the Tank Database of the 2460 System Hub and the Tank Database of the 2410 Tank Hub as described below.
- Tank geometry parameters and reference distances such as tank reference height (R) and distance between Zero level (datum plate) and tank bottom.
- Antenna types used for the various level gauges.

5.1.2 Installation procedure

Installation and configuration of a Rosemount Tank Gauging system includes the following steps as briefly described below and in Figure 5-1 on page 42:

1. Communication Protocol Setup

Specify communication protocol parameters:

- The Modbus Master Protocol handles communication between a TankMaster workstation and field devices such as the Rosemount 2460 System Hub and the Rosemount 2410 Tank Hub.
- The Slave Protocol handles communication with a host computer.
- Communication with TankMaster can be supervised by logging various error types and function codes.

2. Preferences

Specify measurement units, tag prefixes for tank and device labels, inventory parameters, and parameters to be displayed when viewing tank data.

3. Installation and Configuration of the Rosemount 2460 System Hub

The Rosemount 2460 System Hub has to be installed and configured prior to installing other devices such as a Rosemount 2410 Tank Hub and a Rosemount 5900S Radar Level Gauge.

To install a Rosemount 2460 System Hub:

- Assign a Modbus communication address
- For each communication port, configure protocol and appropriate communication parameters
- Configure the Tank Database with information about the devices connected to the fieldbus
4. **Installation and Configuration of the Rosemount 2410 Tank Hub**

The Rosemount 2410 should be installed after the Rosemount 2460 System Hub prior to the other field devices. In case no 2460 System Hub is used, the 2410 can be connected directly to a TankMaster work station. Installing a 2410 Tank Hub includes the following main steps:

- Specify a device tag
- Assign a Modbus communication address
- Configure the 2410 Tank Database which maps devices to tanks
- Configure the optional local display

5. **Installation and Configuration of Field Devices**

In a Rosemount Tank Gauging system the field devices, such as level gauges and temperature transmitters, are installed in TankMaster Winsetup as part of the Rosemount 2410 installation procedure. The devices are configured at a later stage by using the *Properties* window of each device.

Installation and configuration of devices include the following steps:

- **Communication** Specify protocol and address.
- **Configuration** Specify tank geometry parameters, device specific parameters, temperature element positions, and other parameters depending on the device type.

6. **Installation and Configuration of Tanks**

Installing a tank includes the following steps:

- **Choose tank type** Select one of the available options such as Fixed Roof, Floating Roof, Sphere LPG, Horizontal LPG, or other suitable tank type.
- **Specify a tank tag** Specify a name to be used as an identifier in the *Workspace* window and other TankMaster windows.
- **Select devices** Associate devices to the tank.
- **Configuration** Specify the available source signals for parameters such as Free Water Level, Vapor Pressure and Liquid Pressure.
- **Value Entry** Specify an approved value range for Level, Ullage, and Free Water Level. In case there is no source instrument available, you can specify manual values to be used instead.

7. **Calibration**

Once a Rosemount 5900S Radar Level Gauge is installed and configured, the *Calibration Distance* parameter may have to be adjusted in order to ensure that measured level and actual product level match. The adjustment should be performed once at the final commissioning.
Installing a Rosemount Tank Gauging System

Section 5: Installing a Rosemount Tank Gauging System

July 2015

Figure 5-1. Rosemount Tank Gauging system installation procedure

1. Communication setup.  
   See “Communication protocol setup” on page 44.

2. Preferences.  
   See “Preferences” on page 54.

3. Rosemount 2460 System Hub installation and configuration.  
   See “Installing a Rosemount 2460 System Hub” on page 65.

4. Rosemount 2410 Tank Hub installation and configuration.  
   See “Installing a Rosemount 2410 Tank Hub” on page 66.

5. Device installation and configuration.  
   See for example “Installing a Rosemount 5900 Radar Level Gauge” on page 80 and
   “Installing Auxiliary Tank Devices” on page 109.

6. Tank installation and configuration.  
   See “Installing a tank” on page 146.

7. Calibration.  
   See “Level gauge calibration” on page 168.
5.1.3 Using the device installation wizard

The device installation wizard guides you step-by-step through the installation procedure. The wizard can be started in different ways:

1. Select the **Devices** folder.
2. Click the right mouse button and choose **Install New** from the popup menu, or from the **Service>Devices** menu choose **Install New**.

As an alternative you can use the following method:

1. Select the server where your system is installed.
2. From the **File>Install New** menu choose **Device**.

See chapter 5.6 to 5.11 for detailed information on how to install various devices.
5.2 Communication protocol setup

The TRL2 Modbus Master protocol is available as default protocol when the Rosemount TankMaster software is installed on a TankMaster work station. Optional protocols, such as the Modbus Slave protocol for communication with host systems, can be obtained as well. Please contact Emerson Process Management / Rosemount Tank Gauging for more information.

A Modbus protocol offers up to eight channels. Enraf and HART protocols support 16 channels. For each channel you can specify which PC communication port (USB/COM) to connect to, as well as standard communication parameters such as Baud Rate, Parity, and number of Stop Bits.

For each protocol you can configure the following:

- Communication parameters: COM Port, Baud rate, Parity, number of stop bits, modem type, etc.
- Log file: File name, file size, log schedule.
- Tank mapping (for slave protocols)
5.2.1 Master protocol channel configuration

This section describes how to configure the Modbus Master protocol channel for communication with a FBM 2180 modem. The procedure applies to other protocols and modems as well but other parameter settings may be required.

To configure a protocol channel:

1. Open the Protocols folder in the Workspace window.
2. Select the icon that corresponds to the particular protocol to be configured (this example shows the Modbus Master protocol).
3. Click the right mouse button and select Properties, or choose Protocols/Properties from the Service menu.
4. The Protocol Properties window lists the available protocol channels. For each channel the corresponding icon indicates whether the channel is enabled or disabled.
5. Select the desired channel.
6. Click the Properties button to configure the protocol channel.
7. Select the *Communication* tab. It allows you to configure parameters that control the communication between field devices and a TankMaster work station.

The *File Log* tab lets you specify what type of information to be logged and saved to disk in (see also “Log file configuration” on page 52).

8. Set the communication parameters:

- **Port**: The COM port that the Rosemount 2180 will be connected to
- **Baud rate**: 4800
- **Stop bits**: 1
- **Parity**: None
- **Modem**: Choose FBM 2180 for the Rosemount 2180 Field Bus Modem
- **Handshaking**: FBM 2180: None  
  FBM 2170/71: RTS/CTS/DTR/DSR  
  RS485: RTS/CTS  
  RS232: None
- **Reply timeout**: 1000 ms
- **Retries**: 10
- **Description**: Text describing the configured channel

**Note!**

If the communication is interrupted and handshaking includes DSR, no query will be sent from the TankMaster Protocol Server. This may result in a Query Timeout.
9. The **Comm. disabled in backup mode** check box can be used for systems with redundant tank servers. If the check box is selected, the ModbusMaster will not send any queries if the local tank server is in backup mode.

10. Select the **Enable Channel** check box to activate the protocol channel.

11. Click the **OK** button to store the current configuration and close the configuration window.

12. The Modbus Master Channel icon (channel no. 1 in this example) appears in the WinSetup workspace:
5.2.2 Slave protocol channel configuration

A Slave protocol allows you to collect data from the TankMaster workstation to a host computer.

Note!
A hardware key must be installed in order to run a slave protocol server. Host communication needs to be enabled.

TRL2 Modbus Communication Setup

To configure the TRL2 Modbus Slave protocol channel do the following:

1. Open the Protocols folder in the Workspace window.
2. Select the ModbusSlave protocol icon.
3. Click the right mouse button and select Properties, or choose Protocols>Properties from the Service menu.
4. The Protocol Properties window lists enabled and disabled protocol channels.
5. Select the desired channel.
6. Click the **Properties** button to configure the protocol channel.

![Modbus Slave Protocol Channel 1 Configuration](image)

7. Select the **Communication** tab.

8. Select the **Enable Channel** check box to activate the protocol channel.

9. Ensure that the following communication parameters are set:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Port</strong></td>
<td>Choose the COM port that the host computer will be connected to.</td>
</tr>
<tr>
<td><strong>Baud rate</strong></td>
<td>Choose a setting that matches the host setting.</td>
</tr>
<tr>
<td><strong>Stop bits</strong></td>
<td>Choose a setting that matches the host setting.</td>
</tr>
<tr>
<td><strong>Parity</strong></td>
<td>Choose a setting that matches the host setting.</td>
</tr>
<tr>
<td><strong>Modem</strong></td>
<td>Choose the appropriate interface. Select FBM 2180 if you are using a Rosemount 2180 Field Bus Modem.</td>
</tr>
</tbody>
</table>
| **Handshaking** | FBM 2180: None  
FBM 2170/71: RTS/CTS/DTR/DSR  
RS485, RS232: See specifications for the communication software used on the host system. |
| **Address** | Set the Modbus address to be used by the host computer to identify the TankMaster workstation. |
| **Description** | Text that describes the configured channel. |

**Note!**
If handshaking includes DSR, no query will be sent from the TankMaster Protocol Server if the communication is interrupted. This may result in a Query Timeout.

10. Click the **OK** button to store the current configuration and close the configuration window.
Advanced configuration

To configure delay times and time-outs perform the following steps:

1. In the Slave Protocol Channel Configuration window, select the Communication tab and click the Advanced button:

2. The following default values are used for the TRL2 Modbus Slave protocol:

   - Query to Response Delay: 10 ms
   - Query interval: 100 ms
   - Read Query Timeout: 400 ms
   - Write Response Timeout: 400 ms
   - Max. Response Time: 800 ms
   - Backup Mode: None

3. Choose one of the following three options for Backup Mode:
   - None
   - Write Commands Rejected means that TankMaster does not accept any write commands from the host system to device database registers
   - In Silent mode the ModbusSlave protocol will not send any replies to requests coming from the host computer while the local tankserver is in backup mode
Tank mapping configuration

The slave protocol allows you to send data from a Rosemount Tank Gauging system to a host computer. In the Tank Mapping window you can specify from which tanks to collect data for the host system:

1. In the Slave Protocol Channel Configuration window, select the Tank Mapping tab:

2. From the list of tanks that appear in the Available Tanks pane, select the tanks that the host will connect to.

3. Click the button to move the selected tanks to the list of Mapped Tanks. Ensure that the tanks appear in the order required by the host system. When the host sends a query, TankMaster responds by sending tank data in the order as the tanks are listed in the Mapped Tanks column. You can easily change the position of mapped tanks by using the and buttons.

4. Click the OK button to save the current configuration and close the window.
5.2.3 Log file configuration

See chapter “Saving the communication log to file” on page 230 for information on how to store a communication log on disk.

5.2.4 Changing the current protocol channel configuration

The channel configuration can be changed at any time. Do the following:

1. In the WinSetup Workspace open the Protocols folder and the protocol subfolder with the enabled channels.

2. Select the channel icon.

3. Click the right mouse button and choose Properties, or from the Service menu choose Channels>Properties.

4. Choose the appropriate tab and change the protocol settings as described in the previous sections.
5.2.5 Protocol server configuration

You can specify which protocol servers that will be connected when starting TankMaster WinSetup.

To change the current configuration do the following:

1. In the WinSetup workspace select the Protocols folder.
2. Click the right mouse button and choose Configure.
3. In the Connect column, select the check box of each protocol to be automatically connected when WinSetup starts up.

You may disable a protocol server at any time by using the Disable command:

1. In the Winsetup workspace, open the Protocols folder.
2. Click the right mouse button on the desired protocol server icon and choose Disable.
5.3 Preferences

5.3.1 Measurement units

Specify units for inventory calculations and measured variables such as level and temperature. To change measurement units do the following:

1. Select the desired server (e.g. “This Workstation”) in the WinSetup workspace.
2. Click the right mouse button and choose Setup, or from the Service menu choose Servers>Setup.
3. In the Server Preferences window select the Units tab.
4. Choose the desired measurement units for level/ullage, temperature, pressure, volume, density, and weight.
5. Click the OK button to save the current setting and close the window.

Note!
Make sure that the desired measuring units are specified before installing new tanks and devices.

Note that these settings only affect installation of new tanks. Tanks which are already installed in the WinSetup Workspace will not be affected. In order to change measurement units for an existing tank you have to do the following:

1. Uninstall the tank.
2. Change measurement units in the Server Preferences/Units window (or in the TankMaster WinOpi program choose menu option Setup>System and change units in the System Setup window).
3. Install the tank again.
5.3.2 Ambient air temperature

To change the Ambient Air Temperature preferences do the following:

1. Select the desired server (e.g. “This Workstation”) in the WinSetup workspace.

2. Click the right mouse button and choose Setup, or from the Service menu choose Servers>Setup.

3. In the Server Preferences window select the Ambient Air Temperature tab:

4. Choose Auto when there is a temperature sensor available that can be used for Ambient Air Temperature measurements. Otherwise, select the Manual option and type a value for the Ambient Air temperature.

   - **Device.** Click the button and select the device to which a temperature sensor is connected.

   - **Ambient Air Temp Source.** Select temperature source associated with the selected device. In a Rosemount Tank Gauging system the associated temperature transmitter has to be configured in the tank database of the 2410 Tank Hub (see “Installing a Rosemount 2410 Tank Hub” on page 66 for more information).

   - **Sensor.** Choose a specific sensor to be used for Ambient Air Temperature.

   - **Value Range.** The Value Range defines the minimum and maximum values when Ambient Air Temperature is manually entered.

5. Click the OK button to save the current setting and close the window.
5.3.3 Inventory

Local Gravity and Ambient Air Density calculations are used for automatic density measurements. To change the Inventory settings do the following:

1. Select the desired server (e.g. "This Workstation") in the WinSetup workspace.
2. Click the right mouse button and choose Setup, or from the Service menu choose Servers>Setup.
3. In the Sever Preferences window select the Inventory tab:

4. Local Gravity.
   The Local Gravity is used for density and weight calculations when an optional pressure transmitter is installed.
   - Select Manual if you want to use a specific value for the Local Gravity.
   - Choose Calculated if you want the local gravity to be calculated by TankMaster. In this case you need to enter the Latitude and Elevation of the site.

5. Ambient Air Density.
   The Ambient Air Density is used for calculating Observed Density and Weight in Air (WIA).
   - Select Manual if you want to use a specific Ambient Air Density value.
   - Choose Calculated if you want the Ambient Air Density to be calculated by TankMaster. The calculated value is based on the Base Density and the Ambient Air Temperature.

See the TankMaster WinOpi Reference Manual (Document no. 303028EN) for more information on inventory parameters and calculations.

6. Click the OK button to save the current settings and close the window.
5.3.4 Miscellaneous

To change parameters such as type of Tank Capacity Table, or Reference Temperature, do the following:

1. Select the desired server (e.g. “This Workstation”) in the WinSetup workspace.
2. Click the right mouse button and choose Setup, or from the Service menu choose Servers>Setup.
3. In the Server Preferences window select the Miscellaneous tab.

![Server Preferences Window](image)

4. Choose the type of Tank Capacity Table (TCT) to be used as default setting when installing new tanks. The default TCT type will automatically be chosen when strapping tables are created for new tanks. However, the TCT type can be changed when the strapping table is specified in the Tank Capacity Setup window regardless of the settings in the Server Preferences window.

   You can choose between TCT type Raw, International, and Northern.

   See the TankMaster WinOpi Reference Manual (Document no. 303028EN) for further information.

5. Specify the maximum number of Digital Alarms that will be used.

6. Specify the Reference Temperature to be used for inventory calculations. Normally, the standard value 15 °C is used.

7. Click the OK button to save the current settings and close the window.
5.3.5 Setting the name tag prefixes

TankMaster WinSetup allows you to specify default name tag prefixes that will appear automatically when installing new tanks and devices. Note that Tank Tag must begin with a letter. These prefixes can be ignored if you want to use other prefixes instead.

To specify name tag prefixes do the following:

1. From the **Service** menu choose **Preferences**.

2. In the **Preferences** window select the **Tag Prefixes** tab.

3. Type the prefixes to be used for tank names and device names, and click the **OK** button.

You can change the prefixes later at any time. Note that this will not affect names of existing tanks and devices.
5.3.6 E-mail configuration

TankMaster WinSetup allows you to setup an e-mail client for alarm notifications and reports.

To setup an e-mail client do the following:

1. From the Service menu choose Preferences.

2. In the Preferences window select the E-mail Configuration tab.

3. Enter the following information:

   **SMTP Server**
   Specify an SMTP server for outgoing messages. Contact your LAN administrator or Internet Service Provider (ISP) for details.

   **Sender Address**
   The e-mail account which will send e-mails from the current workstation must be located on the specified SMTP server.

   **SMTP Port**
   Optional. Contact your LAN administrator or ISP for details.

   **Authentication Configuration**
   Select this option and enter a Login name and Password if authentication is required on the mail server. Contact your LAN administrator or ISP for details.

   **Channel Security Configuration**
   Select this option if the e-mail client requires the use of channel security. Contact your LAN administrator or ISP for details.

   **Subject**
   Enter a title for an e-mail alarm notification. This subject is only used for Alarm notification and is optional. This subject will not be used for other e-mails sent from the built-in e-mail client.
5.3.7 Tank view layout

The Setup Tank View tab is used to specify variables to be presented in the Tank View window, see "Viewing tank data" on page 223.

TankMaster WinSetup allows you to create a new tank view layout and store it on disk, or load an existing table layout from disk.

To create a Tank View layout do the following:

1. From the Service menu choose Preferences.
2. In the Preferences window select the Setup Tank View tab.
3. Click the Load Table button if you wish to edit an existing Table Layout.
4. In the Available Parameters pane on the left-hand side of the Preferences/Setup Tank View window, select the parameter to be presented in the Tank View window (see "Viewing tank data" on page 223).
5. Click the Move button to move it to the Selected Parameters pane on the right-hand side of the Preferences/Setup Tank View window.
6. Repeat steps 4 to 5 for each parameter you wish to include.
7. The Move All button allows you to move all variables at once to the Selected Parameters list box.
8. Ensure that all parameters to appear in the Tank View window are included in the Selected Parameters list box as illustrated below:
8. Click the **Save As** button if you wish to store the current tank view table for future use.

9. Click the **OK** button to save the current Tank View settings and close the window.

**Note!**
When clicking the **Apply** or the **OK** button, the parameter setup is stored in the table layout that is currently used by the **Tank View** window.

To view the specified tank parameters click the right mouse button and choose the **Open Tank View** option:
5.3.8 Tank visibility

The Tanks Visibility tab lets you configure tanks on a remote tank server to make them visible on
the current WinOpi client.

To specify tanks to be visible on the current WinOpi client:

1. From the Service menu choose Preferences and select the Tanks Visibility tab:

2. Select the Enable Tank Visibility function check box.

3. From the Select tank server drop-down list select the remote tank server on which the
tanks are installed.

4. In the Select tanks to be visible on this workstation pane, check the tanks you wish
to make visible on the current workstation. In the default setting all tanks are visible.

5. Choose the Visible on this workstation option to make the selected tanks visible on
the current workstation.

6. Click the OK button to store the current configuration and close the Preferences window.
5.4 **Field device installation - overview**

The *Rosemount TankMaster* configuration software supports configuration of many devices, for example:

- Rosemount 2460 System Hub
- Rosemount 2410 Tank Hub
- Rosemount 5900 Radar Level Gauge
- Rosemount 2240S Multi-input Temperature Transmitter
- Rosemount 2230 Graphical Field Display
- Rosemount 5400 Radar Level Transmitter
- Rosemount 5300 Guided Wave Radar
- Rosemount 2160 Field Communication Unit
- Rosemount 2165/75 Field Communication Unit
- Rosemount 3051/3051S Pressure Transmitter
- Rosemount 644 Temperature Transmitter

5.4.1 **Configuration**

A *TankMaster* installation includes configuration of the Rosemount Tank Gauging system for communication with the *TankMaster* workstation and field devices as well as configuration of device specific parameters.

Configuration of a radar level gauge:

- mapping to a specific tank in the tank database of the 2410 Tank Hub
- setting up communication parameters
- selecting antenna type
- setting up the tank geometry
- configuration of tank environment parameters

Configuration of a Auxiliary Tank Devices (ATDs):

- specifying communication address
- mapping of measurement variables to source devices
- configuration of the 2240S Multi-input Temperature Transmitter
- configuration of temperature elements
- configuration of water level sensor
- configuration of the 2230 Graphical Field Display
5.5 Installing a Rosemount 2460 System Hub

This is a brief description of how to install and configure a Rosemount 2460 System Hub in a Rosemount Tank Gauging system. See the Rosemount 2460 System Hub Reference Manual (Document No. 00809-0100-2460) for more information on how to setup the Rosemount 2460 System Hub.

The following basic steps are included:

1. Ensure that the Rosemount TankMaster WinSetup program is up and running.

2. Enable and configure a Protocol Channel in order to establish communication with the appropriate port on the TankMaster PC.

3. Start the installation wizard in TankMaster WinSetup:
   a. Click the right mouse button on the Devices folder.
   b. Choose the Install new option.


5. Specify a name tag in the 2460 System Hub Tag input field. This tag will be used as an identifier of the Rosemount 2460 in various windows and dialogs.

6. Click the Next button to proceed with the installation wizard.

7. Verify communication with the the host computer/TankMaster PC.

8. Verify that the Host and Field ports are properly configured. Host ports are used for communication with TankMaster work stations or other host systems. Field ports are used for communication with the Rosemount 2410 Tank Hub, the Rosemount 5900S Radar Level Gauge, and other field devices.

9. Configure the Tank Database. Ensure that the Modbus Addresses of the connected devices are properly set. These addresses must correspond to the 2410 Tank Hub database settings.
5.6 Installing a Rosemount 2410 Tank Hub

The installation wizard covers basic configuration of a Rosemount 2410 Tank Hub. If further configuration of Primary Bus, Secondary Bus, Relay Output, and Hybrid Density Calculation is required, this must be done separately via the 2410 Tank Hub Properties window, as seen in the Rosemount 2410 Reference Manual (Document No. 300530EN).

5.6.1 Installation wizard

It is very important that the Tank Database of the 2460 System Hub is properly configured prior to configuring the Rosemount 2410 Tank Hub. This ensures that the 2460 is able to collect data from the different field devices.

See “Installing a Rosemount 2460 System Hub” on page 65 for more information on how to configure the 2460.

Perform the following steps to start the installation wizard in TankMaster WinSetup:

1. In the Workspace window select the Device folder.

2. Click the right mouse button and select Install New, or from the Service menu choose the Devices/Install New option. Now the Select Device window appears.
Device type

3. From the **Device Type** drop-down list, choose the 2410 Tank Hub option.

4. Type a name in the **2410 HUB Tag** input field. The 2410 HUB tag will be used as an identifier for the Rosemount 2410 Tank Hub in various windows and dialogs.

5. Click the **Next** button.
Communication setup

6. Specify whether TankMaster communicates directly with the 2410 Tank Hub, or via a 2460 System Hub.

7. If the 2410 Tank Hub is connected to a 2460 System Hub, select the appropriate 2460 from the 2460 Tag drop-down list.

8. If the 2410 is connected directly to a TankMaster PC and not via a 2460 System Hub, specify the communication protocol channel which is associated with the communication port on the TankMaster workstation. To check which channels are enabled:
   a. in the WinSetup workspace open the Protocols folder
   b. click the right mouse button on the ModbusMaster protocol icon
   c. choose the Properties option

   To check which communication port that is associated with a certain channel:
   a. right-click the protocol channel icon
   b. open the Communication tab and check which communication port that is selected.

   See chapter “Master protocol channel configuration” on page 45 for more information on how to configure communication protocols.
9. To verify communication with the 2410 Tank Hub, type the current Modbus address and click the Verify Communication button. The Unit Id will appear if the correct Modbus address was entered (the 2410 is shipped with the default Modbus address=247).

In case you would like to change the current Modbus address, or the address is unknown, click the Change Address on Device button.

**Note!**
In case several 2410 Tank Hubs are connected using the same default address (247), you will have to change the addresses before the Verify command can be used. See How to change the Modbus address of the 2410 for more information.

### How to change the Modbus address of the 2410

a. In the 2410 Tank Hub Communication window click the Change Address on Device... button to open the Change Address window.

b. Enter the **Unit ID** and the new **Modbus Address**

When changing the device address, the Unit Id is used as a unique identifier of the device. The Unit Id can be found on a label mounted on the device.

**Tip!** If there is no other device connected that uses the same address as the current device, you can find the Unit Id by typing the current address into the Address field in the 2410 Tank Hub Communication window and clicking the Verify Communication button.

c. Click the **OK** button to confirm the address settings and close the Change Address window.

d. In the 2410 Tank Hub Communication window click the Verify Communication button to check that communication is established between the TankMaster work station and the 2410 Tank Hub. The **Unit ID** will appear when TankMaster finds the 2410.

10. In the 2410 Tank Hub Communication window click the **Next** button to continue the installation procedure of the 2410.
Tank Database setup

Each tank is represented by a position in the Rosemount 2410 tank database. Each device connected to the 2410 is mapped to a tank position. For each tank position, a name is assigned as an identifier of the tank. The 2410 tank database maps field devices to the various tanks, and identifies the devices whenever there is a request for measurement data from the 2460 System Hub.

11. The Device Type column lists all devices that communicate on the Tankbus. Ensure that all devices connected to the Tankbus appear in the Device Type list to verify proper communication.

12. In the Tank Position column, map each device to a tank by selecting the appropriate number from the drop-down list in the 2410 tank database as illustrated below. The example below illustrates two different cases; a single tank connected to a 2410 Tank Hub, and another case with three tanks connected to a 2410. Note that tank positions which are mapped to devices are enabled for editing of tank name and Modbus address in the right-hand pane of the Tank Hub Tank Database window.

13. Type the desired names in the Tank Name field. These tank names should also be used at a later stage when installing the tanks associated with the current 2410 Tank Hub, see “Installing a tank” on page 146.

(1) Mapping more than one tank requires the Multiple tank version of the Rosemount 2410 Tank Hub. See the Rosemount Tank Gauging System Data Sheet (Document No. 00813-0100-5100) for more information.
14. For each tank, specify a Modbus address in the Level Modbus Address column to be associated with the level gauge. This must be the same Modbus address as configured in the Tank Database of the 2460 System Hub. The Level Modbus address is used to identify level gauges when distributing requests for measurement data from the 2460 System Hub.

15. The various non-level devices on a tank are represented by a single ATD device in the Rosemount Tank Gauging system.

In tank position 1, the Rosemount Tank Gauging system uses the Modbus address of the 2410 Tank Hub itself as the ATD Modbus address. In the example above, the 2410 Tank Hub has Modbus address 101. This address is automatically used as the ATD Modbus address as well.

For tank positions 2 to 10 you have to specify Modbus addresses in the ATD Modbus Address column to be associated with the different ATD devices. The ATD Modbus addresses must be the same as configured in the 2460 Tank Database.

An empty ATD Modbus address field indicates that no ATD device is mapped to that particular tank position.

See “Installing a Rosemount 2460 System Hub” on page 65 and the 2460 System Hub Reference Manual (Document No. 00809-0100-2460) for further information on how the Tank Databases of the 2460 and 2410 are related.

16. Click the Next button to continue the installation procedure.
Device Tag setup

Level Tags and ATD Tags are configured automatically based on the tank names in the 2410 Tank Hub Tank Database window and the configuration of tag prefixes in the Preferences/Tag Prefix window, see “Setting the name tag prefixes” on page 58. However, it is possible to edit the Level Tags and ATD Tags.

17. Verify that the TankMaster Level Tag is correct or type a new one.

18. Verify that the TankMaster ATD Tag is correct or type a new one. If the ATD tag field is empty and disabled then no ATD device is associated with that tank position.

19. Click the Next button to continue the installation procedure.
Local Display setup

Choose the parameters to be displayed on the integral display panel on the Rosemount 2410 Tank Hub. The display will alternate between the selected items at a rate given by the Display Toggle Time.

20. In the Units for Display pane, choose the desired measurement units from the drop-down lists. These measurement units will be used by the 2410 local display when presenting the various tank variables.

21. In the Display Tanks pane, select check boxes for the tanks that you want to present in the 2410 integral display.

22. In the Display Tank Parameters pane, choose the tank parameters to be displayed by checking the appropriate boxes. See Table 5-1 below for more information on available parameters:
23. Enter the **Display Toggle Time**. Information on the local display alternates between the selected items at a rate given by the Display Toggle Time value.

24. The 2410 can be configured to show different parameters for each tank on the Tank Bus. In the **2410 Tank Hub Local Display** window click the **Individual Tank Configuration** button:

### Table 5-1. Various Tank Parameters can be presented on the 2410 local display

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level</td>
<td>The current product level in the displayed tank.</td>
</tr>
<tr>
<td>Distance</td>
<td>Distance (ullage) is measured from the Tank Reference point to the product surface.</td>
</tr>
<tr>
<td>Level rate</td>
<td>The speed at which the product surface moves when emptying or filling the tank.</td>
</tr>
<tr>
<td>Signal strength</td>
<td>The signal strength of the radar level gauge measurement signal.</td>
</tr>
<tr>
<td>Free water level</td>
<td>Water surface level at the bottom of the tank. Available when a water level sensor is installed in the tank.</td>
</tr>
<tr>
<td>Vapor pressure</td>
<td>Tank vapor pressure.</td>
</tr>
<tr>
<td>Liquid pressure</td>
<td>Product liquid pressure.</td>
</tr>
<tr>
<td>Air pressure</td>
<td>Ambient air pressure.</td>
</tr>
<tr>
<td>Air temperature</td>
<td>Ambient air temperature.</td>
</tr>
<tr>
<td>Vapor temperature</td>
<td>Tank vapor temperature.</td>
</tr>
<tr>
<td>Product temperature</td>
<td>Average temperature of the product.</td>
</tr>
<tr>
<td>Tank temperature</td>
<td>Average temperature of product and vapor in the tank.</td>
</tr>
<tr>
<td>Temperature 1, 2 ...</td>
<td>Temperature value measured by element 1, 2, etc.</td>
</tr>
<tr>
<td>Observed density</td>
<td>The actual product density at the current product temperature.</td>
</tr>
<tr>
<td>Reference density</td>
<td>Density at reference temperature (used for inventory calculations).</td>
</tr>
<tr>
<td>Volume</td>
<td>Total observed volume.</td>
</tr>
<tr>
<td>User defined 1 to 5</td>
<td>Variables for advanced configuration.</td>
</tr>
</tbody>
</table>
25. The Display Tanks pane has a list of all tank positions in the Tank Database of the connected 2410 Tank Hub. Tank positions within brackets, for example (Tank Pos 6), are not configured in the 2410 Tank Database.

26. Select the desired tank position and choose which parameters to show on the 2410 display. Repeat this procedure for each tank position.

27. Click the OK button to store the configuration and return to the 2410 Tank Hub window.

28. Click the Next button to continue the installation procedure.
Configuration summary

The 2410 Tank Hub Summary window shows information about all devices included in the 2410 Tank Database for the current installation.

29. Verify that all Modbus addresses, level tags and ATD tags presented in the 2410 Tank Hub Summary window are correct.

In case you would like to make any changes, click the Back button until the appropriate window appears.

30. By selecting the Install Level and AUX devices... check box in the lower left-hand corner of the 2410 Tank Hub Summary window, the field devices connected to the 2410 via the Tankbus will be installed automatically in the TankMaster workspace as illustrated in Figure 5-3 on page 77. The check box is selected by default and this is the recommended setting.

When the devices are installed they need to be configured via the Properties window. See for example “Installing a Rosemount 5900 Radar Level Gauge” on page 80 and “Installing Auxiliary Tank Devices” on page 109.

The installation procedure will be facilitated by using the Install Level and AUX devices... check box. However, the field devices (level gauge and ATD) can be installed at a later stage by using the device installation wizard for the respective device, see “Using the device installation wizard” on page 43.

31. Click the Finish button to confirm the installation. The installed devices will appear in the Workspace window as illustrated in Figure 5-3 on page 77.
Advanced Configuration

The installation wizard does not include all configuration options available for the 2410 Tank Hub. Further configuration can be done via the 2410 Tank Hub Configuration window:

- host communication parameters for the Primary Bus
- host communication and emulation parameters for the Secondary Bus
- virtual relays
- hybrid density calculation

See the Rosemount 2410 Reference Manual (Document No. 300530EN) for more information on how to configure the Rosemount 2410 Tank Hub.
5.6.2 Summary of Tank Hub installation and configuration

Select device type 2410 Tank Hub

Communication setup. Choose how the 2410 connects to the TankMaster workstation. Assign address and choose communication channel.

2410 Tank Database setup. Map devices to tank position. Specify tank name. Assign Modbus address for level devices and ATD devices.

Enter level tags and ATD tags.
Local Display Setup.
Choose the desired measurement units for the different tank parameters.
Select tanks and parameters.
Set the display parameter toggle time.

Verify the configuration.
Choose whether the slave devices should be installed automatically in the TankMaster workspace or not.
5.7 Installing a Rosemount 5900 Radar Level Gauge

This is a description of how to setup a Rosemount 5900 Radar Level Gauge by using the TankMaster WinSetup configuration software. It applies to both 5900 models; the 5900S and the 5900C. Pictures in the examples below will show the 5900S in most cases, but the functionality is the same for the 5900C if not otherwise stated.

The Rosemount 5900 Radar Level Gauge is typically installed in TankMaster WinSetup as part of the Rosemount 2410 Tank Hub installation procedure. In a following step, the 5900 is configured via the 5900 RLG Properties window, see “Configuration via the Properties window” on page 81. The 5900 RLG Properties window includes tabs for basic and advanced configuration.

When adding a Rosemount 5900 Radar Level Gauge to a Rosemount 2410 Tank Hub in an existing Rosemount Tank Gauging system, the 5900 needs to be mapped to the appropriate tank in the 2410 tank database. Configuration is performed via the 5900 RLG Properties window. See “Adding a tank” on page 159 for further information.

A Rosemount 5900S is most conveniently installed by utilizing the integrated option included as part of the Rosemount 2410 Tank Hub installation procedure.

The 5900 can also be installed and configured by using the WinSetup installation Wizard (see “Installing a 5900 using the installation wizard” on page 88). This method should only be used in exceptional cases when, for example, the 5900 is connected to the Tankbus at a later stage and not available when installing the 2410 Tank Hub.

The following configuration steps are included in the 5900 Radar Level Gauge basic configuration:

- communication parameters
- antenna type
- tank geometry

Configuration of a 5900 may also include:

- Tank Scan
- Empty Tank Handling

Due to the properties of the product, the tank shape, or other circumstances, further configuration may be needed in addition to the basic configuration. Disturbing objects and turbulent conditions in the tank may require that advanced measures are taken. The advanced configuration options include:

- Tank Environment
- Tank Shape
- Surface Echo Tracking
- Filter Settings

See “Advanced configuration” on page 92 for further information on the advanced configuration options.
5.7.1 Configuration via the Properties window

This section describes the basic configuration procedure of a Rosemount 5900 Radar Level Gauge through the 5900 RLG Properties window.

For a basic configuration of the Rosemount 5900 Radar Level Gauge perform the following steps:

1. In the WinSetup Workspace window, open the Devices folder and select the Rosemount 5900S Radar Level Gauge.

2. Click the right mouse button and select Properties, or from the Service menu choose the Devices/Properties option.

The 5900 RLG Properties window appears.

The Communication, Antenna, and Geometry tabs cover basic configuration of the Rosemount 5900.
3. Select the Communication tab. Note that a red gauge icon means that the device needs to be configured.

4. Verify the communication settings. The Connected to HUB field indicates which tank position that the 5900 is associated with in the 2410 Tank Database. Normally, the single tank version of the Rosemount 2410 Tank Hub is used for Rosemount 5900S level gauges. In this case the Position in 2410 HUB field will be equal to 1 since there is only one tank position that is used in the 2410 Tank Database.

   In case the multiple tank version of the Rosemount 2410 is used to connect several tanks, the level gauge can be mapped to another tank through the 2410 Tank Hub Properties/Tank Database window:
   a. in the WinSetup workspace click the right mouse button on the 2410 icon
   b. choose the Properties option
   c. choose the desired tank position

   See “Tank Database setup” on page 70 for more information on 2410 Tank Database setup.

5. Verify that the Modbus address is correct. To change the Modbus address click the Change button to open the 5900 RLG Communication window. Then click the Change Address on Device button to open the Change Address window:
a. Enter the **Unit ID**.
   When changing the device address, the Unit Id is used as a unique identifier of the device. The Unit Id can be found on the 5900 main label.

b. Set the desired address in the **Set Modbus Address** input field.

c. Click the **OK** button to confirm the settings and to close the **Change Address** window.

6. In the **5900 RLG Properties/Communication** window click the **Apply** button to store the Modbus address in the 5900 holding register.

7. In the **5900 RLG Properties** window select the **Antenna** tab:

8. Choose one of the predefined **Antenna Types** to match the antenna attached to the 5900 Radar Level Gauge. For predefined antennas, a number of transmitter parameters (such as TCL and Hold Off Distance) are configured automatically in order to optimize measurement performance.

   For non-standard antennas you may choose one of the User Defined antennas. However, it is recommended that you contact Emerson Process Management/Rosemount Tank Gauging for advice before using this advanced option.
The following antenna types are available:

**5900 with Horn Antenna**
- Horn

**5900 with Parabolic Antenna**
- Parabolic

**5900 with Still-pipe Array Antenna**
- Still-Pipe Array Fixed
- Still-Pipe Array Hatch

**5900 with LPG Antenna**

Depending on the pressure rating of the flange, choose one of the following options:
- LPG/LNG 150 PSI + Valve
- LPG/LNG 150 PSI
- LPG/LNG 300 PSI + Valve
- LPG/LNG 300 PSI
- LPG/LNG 600 PSI + Valve
- LPG/LNG 600

**5900C with Cone Antenna**

Available options:
- Cone 4” PTFE
- Cone 4” Quartz
- Cone 6” PTFE
- Cone 6” Quartz
- Cone 8” PTFE
- Cone 8” Quartz

**5900C with Cone Pipe Antenna**

Available options:
- Cone Pipe PTFE
- Cone Pipe Quartz
Pipe Diameter

For Still-pipe Array, LPG, and Cone Pipe\(^{(1)}\) antennas you need to specify Pipe Diameter. The Pipe Diameter parameter compensates for the lower microwave propagation speed inside a still-pipe. See also "Using the Calibrate function" on page 169 for information on how to calibrate the 5900 for still-pipe installations.

For Cone Pipe\(^{(1)}\) antennas it is very important that the accurate pipe diameter is input to WinSetup in order to avoid scale factor deviations which may result in inaccurate level readings. For Cone Pipe antennas supplied by factory the following nominal values are recommended as input in TankMaster WinSetup:

<table>
<thead>
<tr>
<th>Antenna</th>
<th>Nominal Pipe Diameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cone Pipe 1&quot;</td>
<td>30 mm</td>
</tr>
<tr>
<td>Cone Pipe 2&quot;</td>
<td>56 mm</td>
</tr>
</tbody>
</table>

Antenna Size

For Still-pipe Array antennas, various antenna size options are available: 5, 6, 8, 10, and 12 inch.

User Defined antenna (advanced)

The User Defined option (User Def. Free Propagation, User Def. Linear Pipe, and User Def. Modeconv. Pipe) should only be used for special applications when using non-standard antennas:

a. Choose the appropriate antenna type:
   - User Defined Free Propagation
   - User Defined Still-Pipe
   - User Defined Still-Pipe Array

b. Enter the **Tank Connection Length** in the TCL input field.

c. For still pipe applications, type the inner diameter of the still pipe in the **Pipe Diameter** input field.

d. In case there are disturbances close to the nozzle you may need to adjust the **Hold Off Distance**. By increasing the Hold Off distance, the measurement range is reduced in the upper part of the tank.

9. In the 5900 RLG Properties/Antenna window click the **Apply** button to save the configuration.

See *Rosemount 5900S Reference Manual* (Document No. 00809-0100-5900) and the *Rosemount 5900C Reference Manual* (Document No. 00809-0100-5901) for more information on **Hold Off Distance** and other level gauge parameters.

\(^{(1)}\) Rosemount 5900C only
10. In the 5900 RLG Properties window select the Geometry tab:

![Geometry Tab Image]

11. Enter the tank geometry parameters:

   a. **Tank Reference Height (R)**
      
      The Tank Reference Height (R) is the distance from the hand dip nozzle (Tank Reference Point) to the Zero Level (Datum Plate) close to the bottom of the tank.

   b. **Reference Distance (G)**
      
      The Reference Distance (G) is the distance between the Tank Reference Point and the Gauge Reference Point, which is located at the side of the flange which meets the tank nozzle.
      
      G is positive if the Tank Reference Point is located above the Gauge Reference Point, otherwise G is negative.

When using a 5900 with Still-pipe Array Antenna and hinged hatch, the Tank Reference Point is located at the hand-dip plate inside the hatch. The hand-dip plate is also used as the Gauge Reference Point for this antenna type, which means that G=0.
c. **Minimum Level Distance (C)**
   The Minimum Level Distance (C) is defined as the distance between the Zero Level (Dipping Datum Point) and the minimum level (tank bottom) for the product surface. By specifying a C-distance the measuring range can be extended to the bottom of the tank.

   **C>0:** the 5900 presents negative level values when the product surface is below the Zero Level.
   You can use the *Show negative level values as zero* check box if you wish to present product levels below the Zero Level (Datum plate) as equal to zero.

   **C=0:** measurements below the Zero Level will not be approved, i.e. the RLG will report “invalid level” if the product level is below the Datum Plate.

   See the *Rosemount 5900S Reference Manual* (Document No. 00809-0100-5900) and the *Rosemount 5900C Reference Manual* (Document No. 00809-0100-5901) for more information on tank geometry parameters.

12. **Enter the Calibration Distance**
   Use this variable to calibrate the 5900 so that measured product levels match hand dipped levels. A minor adjustment may be necessary when the gauge is installed if, for example, there is a deviation between the actual tank height and the height given by tank drawings.

   For **still-pipe** applications the *Calibrate* function in the TankMaster WinSetup program is a useful tool to configure the Calibration Distance and the Correction Factor, see “Level gauge calibration” on page 168 for more information.

13. Click the **OK** button to save the configuration and close the configuration window.

In addition to the configuration steps described above, a basic configuration of the 5900 may include using the Tank Scan function to verify that there are no disturbing objects in the tank that may interfere with the level measurements. Also, the Empty Tank Handling function may be used to optimize measurement performance near the tank bottom.

See “Basic Configuration” in the *Rosemount 5900S Reference Manual* (Document No. 00809-0100-5900) for more information.

Further configuration options are available in the **Tank Shape, Environment, and Advanced Configuration** tabs, see “Advanced configuration” on page 92.
5.7.2 Installing a 5900 using the installation wizard

The installation wizard in TankMaster WinSetup is a tool that may be used to install and configure a Rosemount 5900 Radar Level Gauge and other devices.

Normally a 5900 is installed as part of the installation procedure for a Rosemount 2410 Tank Hub. However, the installation wizard lets you install a Rosemount 5900 level gauge in TankMaster separately from the 2410 installation:

1. Configure the Tank Database of the **Rosemount 2460 System Hub** by including the new 5900 Radar Level Gauge. Ensure that the correct Modbus address is entered (see “Installing a Rosemount 2460 System Hub” on page 65 for more information).

2. Configure the Tank Database of the **Rosemount 2410 Tank Hub** in the **2410 HUB Properties/Tank Database** window, (see “Installing a Rosemount 2410 Tank Hub” on page 66 for more information).

3. Install and configure the Rosemount 5900 as described in “Using the installation wizard” on page 89.

In most cases the following procedure is recommended when installing a new Rosemount 5900 Radar Level Gauge:

1. Add the new 5900 Radar Level Gauge to the Tank Database of the **2460 System Hub**. Ensure that the correct Modbus address is configured (see “Installing a Rosemount 2460 System Hub” on page 65 for more information).

2. Configure the Tank Database of the **2410 Tank Hub** in the **2410 Tank Hub Properties/Tank Database** window, (see “Installing a Rosemount 2410 Tank Hub” on page 66 for more information).

3. In the **2410 Tank Hub Properties/ Device Tags** window ensure that the **Install Level and AUX devices** check box is selected. This will ensure that the 5900 is automatically installed in the TankMaster workspace.

4. Configure the 5900 (see “Configuration via the Properties window” on page 81).

See also “Adding a tank” on page 159 for further information on adding tanks and devices to a Rosemount Tank Gauging system.
Using the installation wizard

To configure a Rosemount 5900 by using the WinSetup installation wizard perform the following steps:

1. In the Workspace window select the Devices folder.

![Workspace window with Devices folder highlighted]

2. Click the right mouse button and select **Install New**, or from the Service menu choose **Devices/Install New**.

   The Select Device window appears:

![Select Device window with 5900S/5900C Radar Level Gauge selected]

3. Choose **Device Type** 5900S/5900C Radar Level Gauge from the drop-down list.

4. Enter the level tag to be used for identifying the 5900.

5. Click the **Next** button to open the **5900 RLG Communication** window:
6. In the 2410 HUB Tag drop-down list, choose the 2410 that the 5900 Radar Level Gauge is connected to. Normally, there is one 2410 for each tank equipped with a 5900 Radar Level Gauge.

7. Enter the **Modbus address** that is used for the 5900 Radar Level Gauge. This address must be stored in the Tank Databases of the 2460 System Hub and the 2410 Tank Hub as well.

8. Click the **Verify Communication** button to verify that the TankMaster PC communicates with the 5900. The Unit ID will appear when contact is established.

9. Check the **Position in 2410 HUB** field to verify that the 5900 is mapped to the correct tank position in the 2410 tank database. Normally, the single tank version of the Rosemount 2410 Tank Hub is used for 5900 level gauges. In this case the **Position in 2410 HUB** field will be equal to 1 since there is only one tank position that is used in the 2410 Tank Database.
   In case the multiple tank version of the 2410 Tank Hub is used for several tanks, the level gauge can be mapped to the desired tank via the **2410 Tank Hub Properties/Tank Database** window (in the WinSetup workspace, click the right mouse button on the 2410 icon and choose the Properties option).
   See "Tank Database setup" on page 70 for more information on 2410 Tank Database setup.

10. Click the **Next** button to proceed with configuration of the 5900.

11. For descriptions of the **5900 RLG Antenna** and the **5900 RLG Geometry** windows, refer to the appropriate parts in chapter “Configuration via the Properties window” on page 81.
12. In the 5900 RLG Summary window, click the Finish button to verify the configuration and finish the installation wizard. In case some part of the configuration needs to be changed, click the Back button until the desired window appears.


Further configuration options are available in the 5900 RLG Properties window, see “Advanced configuration” on page 92.
5.7.3 Advanced configuration

In addition to the basic configuration, there are advanced configuration options available for the Rosemount 5900 Radar Level Gauge. These may be used to optimize measurement performance for certain applications.

**Tank Shape**

The **Tank Type** and **Tank Bottom Type** parameters optimize the Rosemount 5900S for various tank geometries and for measurements close to the tank bottom.

To configure the 5900 Radar Level Gauge for a certain tank shape, do the following:

1. In the **5900 RLG Properties** window select the **Tank Shape** tab:

   ![Tank Shape Configuration Window](image)

2. Select a **Tank Type** option that matches the actual tank. Choose **Unknown** if there is no option that is applicable.

3. Select **Tank Bottom Type** that matches the actual tank. Choose **Unknown** if there is no option that is applicable.

4. Click the **OK** button to save the configuration and close the window.
Tank Environment

Certain tank conditions may require additional configuration of the 5900S Radar Level Gauge in order to optimize measurement performance. By considering environmental conditions in the tank, the 5900S can compensate for conditions such as rapid level change, weak echo signals, or varying surface echo amplitudes.

To configure the 5900 Radar Level Gauge for special tank conditions:

1. In the 5900 RLG Properties window select the Environment tab:

2. Select the check boxes that correspond to the conditions in the tank. Use as few options as possible. It is recommended that no more than two options are used simultaneously.

3. Choose the Product Dielectric Range from the drop-down list. Choose the Unknown option if the correct value range is unknown or if the contents of the tank is changing on a regular basis.

4. Click the OK button to save the configuration and close the window.

See the Rosemount 5900S Reference Manual (Document No. 00809-0100-5900), or the Rosemount 5900C Reference Manual (Document No. 00809-0100-5901), for more information on tank environment settings.
The Advanced configuration tab

The Advanced Configuration tab provides further configuration options. The following options are available:

- **Tank Scan**<sup>(1)</sup>
- **Empty Tank Handling**<sup>(1)</sup>
- **Surface Echo Tracking**
- **Filter Settings**
- **Safety Alarm** (only used for SIL safety systems)

![Figure 5-4. The 5900S RLG Properties/Advanced Configuration window](image)

For information on the Advanced Configuration tab features, see the Rosemount 5900S Reference Manual (Document no. 00809-0100-5900) or the Rosemount 5900C Reference Manual (Document No. 00809-0100-5901).

<sup>(1)</sup> May also be used in Basic configuration.
5.8 Installing the 5900S 2-in-1 version

5.8.1 Overview

Installing a 2-in-1 Rosemount 5900S Radar Level Gauge is in most parts similar to installing a standard 5900S. A significant difference though, is that in the TankMaster operator's interface the 5900S 2-in-1 version will be configured as two separate gauges, and each gauge will be associated with its own tank.

To configure a 2-in-1 version of the 5900S level gauge:

1. Configure the 2460 Tank Database by adding two 5900S gauges.
2. Install the 2410 Tank Hub in TankMaster WinSetup.
3. Configure the tank database in the new 2410 Tank Hub:
   a. map the two 5900S gauges to two different tank positions, i.e. configure the Primary and Secondary 5900S gauges as if they are installed on two different tanks
   b. assign a Level Modbus address for each 5900S
4. Assign tags for the 5900S Radar Level Devices and the Auxiliary Tank Device\(^{(1)}\) (ATD). The ATD includes various non-level devices such as temperature transmitters, displays, and pressure transmitters.
5. Install the devices in TankMaster workspace. This is performed automatically by the TankMaster installation wizard.
6. Install two new tanks to be associated with the primary and secondary 5900S radar level gauges.
7. Assign a 5900S and an ATD for the primary tank.
8. Assign a 5900S for the secondary tank. Note that the primary and secondary tanks in TankMaster workspace represent one tank in real life.
9. Configure the tanks.
10. Open the TankMaster workspace to verify a correct installation of tanks and devices.

---

\(^{(1)}\) Auxiliary Tank Device (ATD) is used in the Tank Database of the 2410 Tank Hub to designate various devices such as temperature and pressure transmitters, displays and other non-level devices. See “Installing a Rosemount 2410 Tank Hub” on page 66 for more information on the Auxiliary Tank Device (ATD) concept.
Configuration example of 5900S 2-in-1 version

The 5900S 2-in-1 version is installed and configured in TankMaster as a tank gauging system with two tanks. Various configuration options are possible:

a. Primary tank with 5900S and ATD \(^{(1)}\) (2240S, 2230 ...).
   Secondary tank with 5900S.

b. Primary tank with 5900S and ATD (2240S, 2230 ...).
   Secondary tank with 5900S. ATD on Primary tank mapped to secondary tank (see example in Figure 5-5).

c. Primary tank with 5900S and ATD (2240S, 2230 ...).
   Secondary tank with 5900S and ATD (redundant).

Figure 5-5. Example of a Rosemount Tank Gauging system with a 2-in-1 5900S

(1) See “Installing a Rosemount 2410 Tank Hub” on page 66 for more information on the Auxiliary Tank Device (ATD) concept.
5.8.2 Installation and configuration

To install and configure the 2-in-1 version of the Rosemount 5900S, follow these steps:

1. Start the TankMaster Winsetup program.
2. Configure the Tank Database of the 2460 System Hub.
   Since the 2-in-1 5900S includes two separate gauges, you will have to add two Level Device addresses to the Tank Database.

Assign TRL2 Modbus addresses for the 2-in-1 5900S level devices.

Example of primary and secondary addresses for the 2-in-1 version of the 5900S level gauge:

Primary tank TK-1: address=1
Secondary tank TK-1S: address=51

It is recommended that Modbus address 50 + “X” is used for the secondary level device, where “X” is the address of the primary level device.

For the Primary tank the temperature device will automatically be assigned the same Modbus address as the 2410 Tank Hub.

For the Secondary tank you will not need to enter a “Temp Device Address”.

Do not configure any temperature elements (Number of Temp Elements=0) for the Secondary temperature device.

In case two temperature transmitters are installed on the tank, one to be associated with the Primary and the other to the Secondary tank, you will need to configure Temp Device Address as well as Number of Temp Elements for both tanks. This configuration is like a standard configuration with one 2410 Tank Hub connected to two separate tanks.
3. Proceed with installing a 2410 Tank Hub.

4. In the WinSetup workspace, select the Devices folder, click the right mouse button and choose File > Install New.

5. In the Select Device window, choose Device Type 2410 Tank Hub and assign a 2410 Tag.

6. Click the Next button to proceed to the Tank Database configuration window.

7. Configure the 2410 tank database.

In the 2410 tank database, the 2-in-1 5900S RLG will appear as two separate 5900S level gauges. The two gauges are mapped to different tank positions and will be associated with different tanks in the WinSetup workspace.
Tank Name
Assign the same name on the two tanks. Add "S" to the secondary tank name, for example:

primary tank: TK-1
secondary tank: TK-1S

Address
Assign Level Modbus Addresses to the gauges.

Example:
TK-1: 1
TK-1S: 51

It is recommended that Modbus address 50 + "X" is used for the secondary device, where "X" is the address of the primary radar level gauge.

Ensure that the same addresses are configured in the Tank Database of the 2460 System Hub and the 2410 Tank Hub.

8. Click Next to proceed to the Device Tags window.

9. Verify the Level Tags for the primary and secondary 5900S gauges, and the ATD Tag for the other devices (temperature transmitter, field display, pressure transmitter). The tags can be changed later if needed.
10. **Summary.**
In the final step of the 2410 installation wizard, check that all device tags and Modbus addresses are correct. Note that if a 2460 System Hub is used, the Modbus addresses in the 2410 Tank Database must match the addresses configured in the 2460 Tank Database.

Ensure that the "Install Level and ATD devices..." check box is marked if you like to enable automatic installation of devices in the TankMaster workspace. This is the recommended setting.

**Note!** If new devices are added to an existing 2410 Tank Hub, this check box may not be active. Then you will have to add the new devices manually.

11. **Verify that the devices appear in the WinSetup workspace.** The 2410 Tank Hub, the two 5900S RLGs, and the ATD are automatically installed in the TankMaster WinSetup workspace if the check box is marked in the 2410 Tank Hub Summary window.

**Note!** The new device icons are red indicating that these devices need to be configured.

Once the 2410 and associated level and ATD devices are installed in TankMaster you will have to configure each device.
12. Right-click the device icon and select **Properties**. See “Installing a Rosemount 5900 Radar Level Gauge” on page 80 and “Installing Auxiliary Tank Devices” on page 109 for further information.

Ensure that the 2410, the two 5900S RLGs, and the ATD are installed in the TankMaster workspace. Red icons indicate that these devices are not configured.
13. Finally, when devices are installed and configured you will have to install and configure the two tanks to be associated with the 2-in-1 5900S.

In the following description one tank will be associated with the primary 5900S level gauge (LT-TK-1 in this example), and the other tank will be associated with the secondary 5900S level gauge (LT-TK-1S).

Select the Tanks folder and choose the Install New option. Install and configure the primary tank first and then the secondary tank.

For each tank choose Tank Type and assign a Tank Tag. It is recommended that you use the same tank name as specified in the tank database of the 2410 Tank Hub.
14. Assign devices to the **primary** tank TK-1:
   a. Primary 5900S level gauge (LT-TK-1)
   b. ATD device (ATD-TK-1) in case the tank is equipped with non-level devices such as a 2240S Temperature Transmitter, a 2230 Graphical Field Display, Water Level Sensor, or a 3051S Pressure Transmitter.
15. For the secondary tank TK-1S assign the secondary 5900S level gauge (LT-TK-1S) as shown below:
16. Optional: you may map the ATD device on the primary tank to the secondary tank TK-1S as shown below. This allows you to view temperature data, such as Average Temperature, for the secondary tank as well.
17. Choose the desired tank measurement variables. For the primary tank, variables associated with the ATD device automatically appear in the Configuration window. **Note**: The available source variables may vary depending on the actual devices connected to the 2410 Tank Hub.

For the secondary tank, “none” is automatically selected for temperature and pressure variables as well as for Free Water Level. In case the ATD device on the primary tank is mapped to the secondary tank as well (see step 16 on page 105), these variables will also appear in the Configuration window for the secondary tank.
18. Specify parameter value range to be used in various windows for presentation of measurement data.

19. Choose whether to use measurement values (Automatic) from the available instruments or manual values.

**Note!**
Calculation of the Average Temperature (AVG Temp) requires a valid Level value. In case the Level value is not available, the Average Temperature (AVG Temp) will also be missing.
20. Verify installation. In the TankMaster workspace verify that the tanks and devices are properly installed. Check that the two 5900S gauges and the ATD are associated with the right tanks. Two options are shown below:

- ATD (temperature transmitter, etc.) is associated with the primary tank only
- ATD on primary tank is mapped to both the primary and secondary tanks
5.9 Installing Auxiliary Tank Devices

Auxiliary Tank Devices (ATDs) such as the Rosemount 2240S Multi-input Temperature Transmitter and the Rosemount 2230 Graphical Field Display, are typically installed as part of the installation procedure of the Rosemount 2410 Tank Hub. The ATD devices appear in the TankMaster workspace and are configured via the 22XX ATD window.

The 22XX ATD window includes tabs for configuration of temperature sensors, graphical field displays, and water level sensors. It also includes configuration options for mapping outputs of measurement instruments such as water level sensors, pressure sensors etc. to measurement variables such as Free Water Level and Liquid Pressure.

Before starting the ATD installation, read the reference manuals for the various ATD devices, such as the Rosemount 2240S and the Rosemount 2230, to learn more about how to configure these devices.

5.9.1 Opening the Properties window

To open the 22XX ATD window and to configure the ATD devices do the following:

1. In the WinSetup Workspace window, open the Devices folder and select the ATD device icon.

2. Click the right mouse button and select Properties, or from the Service menu choose the Devices/Properties option to open the 22XX ATD window.

3. The 22XX ATD window has a number of configuration tabs for the Rosemount 2240S Multi-input Temperature Transmitter and the Rosemount 2230 Graphical Field Display.

4. Configure the ATD devices by choosing the appropriate tabs. See descriptions of the configuration tabs in the following sections.

5. Verify the ATD configuration by clicking the Apply or OK button.
5.9.2 Communication parameter setup

The Communication tab lets you verify the ATD communication settings. A red icon means that the current ATD needs to be configured.

1. In the 22xx ATD window select the Communication tab:

2. In the Connected to HUB field verify that the ATD device is connected to the correct 2410 Tank Hub and mapped to the correct tank position in the 2410 tank database. For example, “position 1” means that the ATD device is mapped to tank database position 1 in the 2410, “position 2” to tank database position 2 etc. You can check the tank database of the current 2410 Tank Hub by opening the 2410 HUB Properties/Tank Database window. See “Installing a Rosemount 2410 Tank Hub” on page 66 for more information on the 2410 Tank Database.

3. The Change button lets you change the Modbus address of the current ATD device in case the ATD device is connected to a multiple tank version of the 2410 Tank Hub. Note that the Modbus address can only be changed for ATD devices in tank database position 2 and higher. An ATD device mapped to position 1 in the 2410 tank database uses the same Modbus address as the 2410 Tank Hub itself. See “Installing a Rosemount 2410 Tank Hub” on page 66 for more information.

4. Click the Apply button to store the configuration, or click the OK button to store the configuration and close the window.
5.9.3 Temperature sensor configuration

The 2240S MTT Temperature Sensor tab lets you configure a sensor connected to the Rosemount 2240S Multi-input Temperature Transmitter.

The 2240S MTT Temperature Sensor tab input fields are disabled in case no 2240S Multi-input Temperature Transmitter is connected to the Tankbus. In that case, no 2240S temperature transmitter will be mapped to the 2410 tank database.

To configure the temperature sensors for a Rosemount 2240S, do the following:

1. In the 22xx ATD window select the 2240S MTT Temperature Sensor tab:

   ![2240S MTT Temperature Sensor Configuration](image)

2. The Rosemount 2240S is equipped with a DIP switch for automatic configuration of temperature element and wiring. By selecting the Use Auto Sensor Configuration check box, the 2240S transmitter is automatically configured according to the DIP switch settings. See the Rosemount 2240S Multi-Input Temperature Transmitter Reference Manual (Document No. 00809-0100-2240) for more information.

   In case a temperature element type is used that does not match the Auto Sensor Configuration, the 2240S transmitter can be manually configured as described below.
Manual configuration

1. Ensure that the **Use Auto Sensor Configuration** check box is unchecked.

2. Choose conversion method in the **Method** input field. For more information on conversion methods such as *User defined table*, *User defined formula* and *User defined individual formula*, see the appropriate sections in “User defined temperature conversion” on page 191.

**Note!**
For spot temperature elements, use the **Pt100** sensor option in order to obtain a correct average temperature calculation.

3. Choose the type of sensor connection that is used for the spot sensors in the **Connection** drop-down list.

4. Specify the measurement range of the current temperature element in the **Min Value** and **Max Value** input fields.

5. Click the **Apply** button to store the configuration, or click the **OK** button to store the configuration and close the window.

See the *Rosemount 2240S Multi-Input Temperature Transmitter Reference Manual* (Document No. 00809-0100-2240) for more information on how to configure temperature sensors for the Rosemount 2240S.
5.9.4 Average temperature calculation

This section gives a brief description of how to configure average temperature calculations for a temperature sensor connected to the Rosemount 2240S Multi-input Temperature Transmitter. See the Rosemount 2240S Multi-Input Temperature Transmitter Reference Manual (Document No. 00809-0100-2240) for more information.

To configure a Rosemount 2240S for average temperature calculations, do the following:

1. In the 22xx ATD window, choose the Average Temperature Calculation tab:

2. **No of Elements**: select the number of used temperature elements. Verify that the input fields for element positions are enabled.

3. **Sensor Type**: choose the type of sensor that is used; Spot or Average.

4. **Insert Distance**: specify the minimum distance between a temperature sensor and the product surface for temperature sensors included in average temperature calculation.

5. **Position**: type the position of each temperature element measured as the distance from the Zero Level to the spot temperature element. If average temperature elements are used, for each sensor element enter the position where the average element ends.
6. You may exclude a certain temperature element from the average temperature calculation by selecting the **Exclude** check box in the column next to the Position field. This option may be useful in case you would like to exclude a malfunctioning temperature element.

7. Click the **Apply** button to store the configuration, or click the **OK** button to store the configuration and close the window.

See the *Rosemount 2240S Multi-Input Temperature Transmitter Reference Manual* (Document No. 00809-0100-2240) for more information on how to configure the Rosemount 2240S for average temperature calculations.

5.9.5 Auxiliary sensor configuration

The **2240S MTT Auxiliary Sensor** tab lets you configure a water level sensor connected to a Rosemount 2240S Multi-input Temperature Transmitter.

All input fields in the **2240S MTT Auxiliary Sensor** tab will be disabled if no 2240S Multi-input Temperature Transmitter is associated with the current tank position in the tank database of the 2410 Tank Hub.

**Water Level Sensor**

This section gives a brief description of how to configure the Rosemount 765 Water Level Sensor connected to the Rosemount 2240S Multi-input Temperature Transmitter. See the *Rosemount 2240S Multi-Input Temperature Transmitter Reference Manual* (Document No. 00809-0100-2240) for further information.

To configure the water level sensor do the following:

1. In the **22xx ATD window**, select the **2240S MTT Auxiliary Sensor** tab:
2. Calculate the **Level Offset (X)** according to the formula $X = (R - L1) - (L - L2)$.

3. Enter the resulting level offset value in the **Level Offset (X)** input field.

4. Enter the **Upper Dead Zone (UDZ)** and the **Lower Dead Zone (LDZ)** if needed.

5. Click the **Apply** button to store the configuration, or click the **OK** button to store the configuration and close the window.

See the *Rosemount 2240S Multi-Input Temperature Transmitter Reference Manual* (Document No. 00809-0100-2240) for more information on how to configure a water level sensor connected to a Rosemount 2240S Multi-input Temperature Transmitter.
5.9.6 Advanced parameter source configuration

The Advanced Parameter Source Configuration tab lets you map the output of various measurement instruments (source devices) to tank measurement variables such as Liquid Pressure and Vapor Pressure. That makes the measurement variables available for configuration in the Tank Configuration window as described in “Installing a new tank” on page 148.

Source devices are automatically mapped to tank measurement variables such as Level, Vapor Temperature, and Free Water Level and do not need to be mapped in the Advanced Parameter Source Configuration tab.

The Rosemount 2410 Tank Hub supports 60 source parameter mappings. Six mappings are reserved for each one of the ten 2410 tank positions.

**Note!**
A warning message will appear in case a certain parameter/source mapping is already used for another tank.

For a source device to be available in the Advanced Parameter Source Configuration tab, it must be mapped to the current tank in the 2410 tank database (see “Installing a Rosemount 2410 Tank Hub” on page 66 for more information).

To map parameters to source devices, perform the following steps:

1. In the 22xx ATD window, select the Advanced Parameter Source Configuration tab:
2. In the Parameter Mapping column choose a tank measurement variable.

3. In the Source Device Type/ID/No column, choose a measurement device such as a pressure transmitter or any other type of instrument.

   The default setting lists only the devices mapped to the current tank position in the 2410 tank database. By using this option you will avoid mapping to a device on the wrong tank by mistake. By selecting the appropriate radio button you can choose to show all available devices, or only the devices mapped to tank position 1 in the 2410 tank database.

4. In the Source Parameter column, select the transmitter variable to be mapped to the tank measurement variable in the first column.

5. In case User Defined is selected, you may type a description in the Description of User Def parameter box.

6. Click the Apply button to store the configuration, or click the OK button to store the configuration and close the window.
Using a Rosemount 644 Temperature Transmitter

When using a Rosemount 2240S Multi-input Temperature Transmitter, the Rosemount Tank Gauging system automatically handles source parameter mapping to provide correct input for calculation of tank measurement variables such as Vapor Temperature and Average Temperature.

For Rosemount 644 Temperature Transmitters, tank variables have to be mapped manually to the appropriate 644 source devices. The output from each 644 transmitter on the tank is mapped to a temperature tank variable as shown in the following example with three 644 transmitters on the tank:

1. Choose Temperature 1 in the Parameter Mapping list for the first 644 Temperature Transmitter. This temperature parameter is mapped to the temperature element at position 1 in the tank.

   For the second and third 644 transmitters, choose Temperature 2 and Temperature 3 in the Parameter Mapping list. These parameters are mapped to the temperature elements at position 2 and 3, respectively.

2. In the Source Device Type field, for each temperature parameter (Temperature 1, 2, 3) choose the actual 644 transmitter to be used as source device.

3. In the Source Parameter list, choose Temperature 1. This is the source parameter designation of the temperature output from a Rosemount 644 Temperature Transmitter.

   Note that the Vapor Temperature and Average Temperature variables are not mapped to the source devices.

4. Click the Apply button to store the configuration, or click the OK button to store the configuration and close the window.
5.9.7 2230 Graphical Field Display

This section gives a brief description of how to configure a Rosemount 2230 Graphical Field Display.

All fields in the 2230 Graphical Field Display tab are disabled if no graphical field display is connected to the Tankbus, or if the display is not mapped to the current tank database position of the Rosemount 2410 Tank Hub. The Configure Tank Display 2 and Configure Tank Display 3 buttons are disabled when only one Rosemount 2230 is mapped to the current tank database position.

To configure the 2230 Graphical Field Display:

1. In the 22xx ATD window, select the 2230 Graphical Field Display tab:

2. From the drop-down lists in the Units for Display pane, choose the desired measurement units to be displayed by the Rosemount 2230 for the various tank measurement variables.

   Note! The 2230 will convert the unit specified in the Server Preferences window (see “Measurement units” on page 54).

3. In the Display Tanks pane, choose the tanks to be presented by the Rosemount 2230 display by selecting the appropriate check boxes.
4. In the Display Tank Parameters pane, choose the parameters to be displayed for each tank by selecting the appropriate check boxes.

5. Enter the toggle time for the displayed tank parameters in the Display Toggle Time input field. The selected parameters will be displayed for one tank at a time starting with Tank 1.

6. If a second graphical field display is used, click the Configure Tank Display No 2 button and repeat step 1 through 4 above.

7. If a third graphical field display is used, click the Configure Tank Display No 3 button and repeat step 1 through 4 above.

8. The 2230 can be configured to show different parameters for each tank on the Tank Bus. In the 2230 Graphical Field Display tab click the Individual Tank Configuration button:

   ![Individual Tank Configuration](image)

9. Select the desired tank and choose parameters to show on the 2230 display. Repeat this procedure for each tank.

10. Click the OK button to store the configuration and return to the 22xx ATD window.

11. Click the Apply button to store the configuration, or click the OK button to store the configuration and close the window.

See the Rosemount 2230 Graphical Field Display Reference Manual (Document No. 00809-0100-2230) for more information on how to configure a Rosemount 2230 Graphical Field Display.
### 5.9.8 Analog input

The Rosemount 2410 Tank Hub can be equipped with an analog input which lets you connect instruments for 4–20 mA/HART communication.

12. Ensure that the **Enable** check box is selected.

13. In the **Value Unit** field choose a suitable unit to match the input source.

14. In the **Value Range** pane, enter the parameter values that correspond to the analog input values 4 and 20 mA, respectively. You may specify any value as long as the 20 mA value is above the 4 mA value. If the measured value goes outside the range values, the analog input enters alarm mode.

15. Use the **Advanced** button in case you would like to configure Filter Factor and Current Limits.
By setting a Filter Factor you can suppress spurious fluctuations in the analog input signal. A value between 0 and 1 can be used. The default value is 0.1. A higher value means less filtering. Filtering means that the presented Analog Input value is calculated as the average value of the \(<n>\) latest measurements. A filter factor equal to 0.1 is the average of the 10 latest measurements, a filter factor equal to 0.5 is the average of the 2 latest measurements and so on.

The Current Limits define the lower and upper limits of the input currents. Outside this range an error will be indicated. The current limits should correspond to the error limits of connected instruments. If for example an instrument sets the output current in alarm mode to 3.8 mA, you should set the lower error limit to 3.8 or higher.

16. In the Analog Input Values pane, verify that Status is OK and that the expected measurement results appear in the Value and Current fields.

### Analog input and tank parameter setup

For a complete configuration of the Analog Input you need to perform the following steps:

a. Configure the Tank Database of the 2410 Tank Hub. Associate the Analog Input with the tank on which the Analog Input device is installed.

b. In the Properties window of the 2410 Tank Hub, select the Device Tags tab and install the analog input device in TankMaster. Verify that the Analog Input is installed as and ATD device.

c. In the ATD Properties/Analog Input window, configure value range and units.

d. In the ATD Properties/Advanced Parameter Source Configuration window, ensure that the analog input device is mapped to the desired tank parameter, source device, and source parameter.

e. Install a tank in TankMaster WinSetup and make sure that the ATD device that includes the analog input device is mapped as source device for the tank.

See the Rosemount 2410 Tank Hub Reference Manual (Document No. 00809-0100-2410; Appendix C, section C.10) for a complete description of how to setup the analog input for a Rosemount 2410 Tank Hub. The manual also includes a description on how to configure HART slaves for the 2410 Tank Hub.
5.10 Installing a Rosemount 5400

The Rosemount 5400 Radar Level Transmitter is most conveniently installed in TankMaster WinSetup by utilizing the integrated option included as part of the Rosemount 2410 Tank Hub installation procedure. In a following step, the 5400 is configured via the 5400 RLT window, see “Configuration via 5400 properties” on page 124. The 5400 RLT window includes tabs for basic and advanced configuration of a Rosemount 5400 transmitter.

When adding a Rosemount 5400 to a Rosemount 2410 Tank Hub in an existing Rosemount Tank Gauging system, the 5400 needs to be mapped to the appropriate tank in the 2410 tank database. Configuration is performed via the 5400 RLT window. See “Adding a tank” on page 159 for further information.

The 5400 can also be installed and configured by using the WinSetup installation Wizard (see “Installing a 5400 using the installation wizard” on page 131). This method should only be used in exceptional cases when, for example, the 5400 is connected to the Tankbus at a later stage and not available when installing the 2410 Tank Hub.

The following configuration steps are included in the Rosemount 5400 radar level transmitter basic configuration:

- communication parameters
- antenna type
- tank geometry

Due to properties of the product, tank shape, or other circumstances, further configuration may be needed in addition to the basic configuration. Disturbing objects and turbulent conditions in the tank may also require advanced measures to be taken. The TankMaster WinSetup configuration tool includes advanced options for the 5400 such as:

- tank environmental conditions
- tank shape

See “Advanced configuration” on page 129 for further information on advanced configuration options.

For further information on how to install and configure a Rosemount 5400 Radar Level Transmitter see the Rosemount 5400 Reference Manual (Document No. 00809-0100-4026).
5.10.1 Configuration via 5400 properties

This section describes the basic configuration procedure for a Rosemount 5400 series radar transmitter by using the 5400 RLT window.

To configure the Rosemount 5400 Radar Level Transmitter perform the following steps:

1. In the WinSetup Workspace window, open the Devices folder and select the desired Rosemount 5400 transmitter.

2. Click the right mouse button and select Properties, or from the Service menu choose the Devices/Properties option. The 5400 RLT window appears:

3. Select the Communication tab.
4. Verify the tank position. The Connected to HUB field shows the name of the 2410 Tank Hub and the tank position that the 5400 is mapped to in the 2410 tank database. The tank position indicates which tank the 5400 is associated with.
   In case the 5400 transmitter is connected to a multiple tank version of the Rosemount 2410, the 5400 may be mapped to another tank position via the 2410 Tank Hub Properties/Tank Database window if needed (in the WinSetup workspace, click the right mouse button on the 2410 icon and choose the Properties option).
   See “Tank Database setup” on page 70 for more information on how to configure the 2410 Tank Database.

5. Verify that the Modbus address is correct. To change the Modbus address click the Change button:

   ![Change Address dialog box](image)

   a. Enter the Unit ID in the Unit ID input field. When changing the device address, the Unit Id is used as a unique identifier of the device. The Unit Id can be found on a label mounted on the device.
   b. Set the desired address in the Set Modbus Address input field.
   c. Click the OK button to confirm the settings and to close the Change Address window.

6. Click the Apply button to store the configuration, or click the OK button to store the configuration and close the window.

7. Select the Antenna tab.
8. Choose **Antenna Type**. You may choose between predefined antenna types or User Defined for non-standard antennas. For a predefined antenna a number of transmitter parameters such as Tank Connection Length (TCL) and **Hold Off Distance** are automatically specified in order to optimize measurement performance. When choosing a User Defined antenna the database settings must be entered manually.

Choose one of the following antenna types:

- **Free Propagation**
  - Cone 4 inch

- **Still-pipes**
  - Cone 2 inch
  - Cone 3 inch
  - Cone 4 inch

9. Choose **Antenna Extension** length in case the antenna is equipped with an extension.

10. Adjust the **Hold Off Distance (UFM)** if there are disturbances close to the nozzle. By increasing the Hold Off distance, the measurement range is reduced in the upper part of the tank.

11. For still pipe applications select the **Enable still pipe/Bridle Measurements** check box and enter the **Pipe Inner Diameter**.

See the *Rosemount 5400 Reference Manual (Document No. 00809-0100-4026)* for more information on **Hold Off Distance** and other transmitter parameters.

12. Click the **Apply** button to store the configuration.

13. Select the **Geometry** tab.
14. Enter the tank distance parameters.
   
a. **Tank Reference Height (R).**
   The Tank Reference height (R) is defined as the distance from the Tank Reference Point to the Zero Level.
   
b. **Reference Distance (G).**
   The Reference Distance (G) is the distance between the Tank Reference Point and the Gauge Reference Point, which is located at the top surface of the nozzle flange on which the gauge is mounted.
   
c. **Minimum Level Distance (C).** The Minimum Level Distance (C) is defined as the distance between the Zero Level (Dipping Datum Point) and the minimum level for the product surface (tank bottom). By specifying a C-distance, the measuring range can be extended to the bottom of the tank.
   
   **C>0:** the transmitter presents negative level values when the product surface is below the Zero Level.
   You can use the **Show negative level values as zero** check box to present product levels below the Zero Level (Datum plate) as equal to zero.
   
   **C=0:** measurements below the Zero Level will not be approved, i.e. the transmitter will report “invalid level” if the product level is below the Datum Plate.
15. Enter the **Calibration Distance**. Use this variable to adjust the tank height so that measured product levels match hand dipped levels. Normally a minor adjustment is necessary when the transmitter is installed. For example, a minor deviation between the actual tank height and the value stored in the transmitter database may occur if tank dimensions according to drawings are not quite up to date with actual dimensions.

16. Select the **Show negative level as zero** check box to show negative product levels as zero.

17. Click the **Apply** button to store the configuration, or click the **OK** button to store the configuration and close the window.

See the *Rosemount 5400 Reference Manual (Document No. 00809-0100-4026)* for more information on the different tank geometry parameters.
5.10.2 Advanced configuration

In addition to the basic configuration there are some advanced configuration options available for the Rosemount 5400 transmitter.

**Tank shape**

The **Tank Type** and **Tank Bottom Type** parameters optimize the Rosemount 5400 for various tank geometries and for measurements close to the tank bottom. These parameters are configured in the 5400 RLT/Tank Shape window:
Tank environment

Certain product conditions in the tank may require special configuration options to be used in order to optimize measurement performance of the 5400 Radar Level Transmitter. By configuring the environmental conditions in the tank, the 5400 can compensate for conditions such as rapid level change, weak echo signals, varying surface echo amplitudes, or other similar sources of inaccurate measurement.

The 5400 RLT/Environment window is used to optimize the 5400 radar transmitter for special tank conditions:

![5400 RLT/Environment window](image)

Product Condition options are set by selecting check boxes for the appropriate tank conditions. It is recommended to select as few options as possible and not more than two.

The **Product Dielectric Range** can be set from the drop-down list. Choose the *Unknown* option if the correct value range is unknown or if the contents of the tank is changing on a regular basis.

See the *Rosemount 5400 Reference Manual (Document No. 00809-0100-4026)* for more information on tank environment settings.
5.10.3 Installing a 5400 using the installation wizard

The installation wizard in TankMaster WinSetup is a tool that may be used to install and configure a Rosemount 5400 Radar Level Transmitter and other devices.

Normally a 5400 is installed as part of the installation procedure for a Rosemount 2410 Tank Hub. However, the installation wizard lets you install a Rosemount 5400 Radar Level Transmitter in TankMaster separately from the 2410 installation.

1. Configure the Tank Database of the **Rosemount 2460 System Hub** by including the new 5400 Radar Level Transmitter. Ensure that the correct Modbus address is configured (see “Installing a Rosemount 2460 System Hub” on page 65 for more information).

2. Configure the Tank Database **Rosemount 2410 Tank Hub** in the **2410 HUB Properties/Tank Database** window, (see “Installing a Rosemount 2410 Tank Hub” on page 66 for more information).

3. Install and configure the Rosemount 5400 as described in “Using the installation wizard” on page 89.

In most cases the following procedure is recommended when installing a new Rosemount 5400 Radar Level Transmitter:

1. Add the new 5400 Radar Level Transmitter to the Tank Database of the **2460 System Hub**. Ensure that the correct Modbus address is configured (see “Installing a Rosemount 2460 System Hub” on page 65 for more information).

2. Configure the Tank Database of the **2410 Tank Hub** in the **2410 Tank Hub Properties/Tank Database** window, (see “Installing a Rosemount 2410 Tank Hub” on page 66 for more information).

3. In the **2410 Tank Hub Properties/Device Tags** window ensure that the **Install Level and AUX devices** check box is selected. This will make sure that the 5400 is automatically installed in the TankMaster workspace.

4. Configure the 5400 (see “Configuration via the Properties window” on page 81).

See also “Adding a tank” on page 159 for further information on adding tanks and devices to a Rosemount Tank Gauging system.
Using the installation wizard

To configure a Rosemount 5400 by using the WinSetup installation wizard perform the following steps:

1. In the Workspace window select the Devices folder.

2. Click the right mouse button and select **Install New**, or from the Service menu choose **Devices/Install New**. The Select Device window appears:

3. Choose **Device Type** 5400 Radar Level Transmitter from the drop-down list.

4. Enter the level tag used for the radar level gauge.

5. Click the **Next** button to open the 5400 RLT Communication window.
6. In the **2410 HUB Tag** drop-down list choose the Rosemount 2410 Tank Hub that the 5400 Radar Level Transmitter is connected to.

7. Enter the **Modbus address** that is used for the 5400 level transmitter. Note that this address must be stored in the Tank Databases of the 2460 System Hub as well as the 2410 Tank Hub.

8. Click the **Verify Communication** button to verify that the TankMaster PC communicates with the 5400 transmitter. The Unit ID will appear when contact is established.

9. Verify the tank position. The **Position in 2410 HUB** field shows the tank position that the 5400 is mapped to in the 2410 tank database. The tank position indicates which tank the 5400 is associated with. In case the 5400 transmitter is connected to a multiple tank version of the Rosemount 2410, the 5400 can be mapped to another tank position via the **2410 Tank Hub Properties/Tank Database** window if necessary (in the WinSetup workspace, click the right mouse button on the 2410 icon and choose the Properties option).

See “Tank Database setup” on page 70 for more information on how to configure the 2410 Tank Database.

10. Click the **Next** button to proceed with the 5400 configuration.

11. For configuration of the **5400 RLT Antenna** and the **5400 RLT Geometry** windows refer to the appropriate parts of the description in “Configuration via 5400 properties” on page 124.

12. For configuration of the **5400 RLT Tank Shape** and the **5400 RLT Environment** windows, refer to the appropriate parts of the description in “Advanced configuration” on page 129.
13. In the **5400 RLT Summary** window, click the **Finish** button to finish the installation wizard. If the configuration needs to be changed click the **Back** button until the desired window appears.

Further configuration options are available in the **5400 RLT** window, see “Advanced configuration” on page 129.
5.11 Installing a Rosemount 5300

The Rosemount 5300 Guided Wave Radar is most conveniently installed in TankMaster WinSetup by utilizing the integrated option included as part of the Rosemount 2410 Tank Hub installation procedure. In a following step, the 5300 is configured via the 5300 GWR window, see “Configuration via 5300 Properties” on page 136. The 5300 GWR window includes tabs for basic and advanced configuration of a Rosemount 5300.

When adding a Rosemount 5300 to a Rosemount 2410 in an existing Rosemount Tank Gauging system, the 5300 needs to be mapped to the appropriate tank in the 2410 tank database. Configuration is performed via the 5300 GWR window. See “Adding a tank” on page 159 for further information.

A Rosemount 5300 is most conveniently installed by utilizing the integrated option included as part of the Rosemount 2410 Tank Hub installation procedure.

The 5300 can also be installed and configured by using the WinSetup installation Wizard (see “Installing a 5300 using the installation wizard” on page 142). This method should only be used in exceptional cases when, for example, the 5300 is connected to the Tankbus at a later stage and not available when installing the 2410 Tank Hub.

The following configuration steps are included in the basic configuration of a Rosemount 5300 Guided Wave Radar:

- communication parameters
- probe type
- tank geometry

Due to the properties of the product, the shape of the tank, or other circumstances, further configuration may be needed in addition to the basic configuration. Disturbing objects and turbulent conditions in the tank may also require advanced measures to be taken. The TankMaster WinSetup configuration tool includes advanced options for the 5300 such as:

- tank environmental conditions

See “Installing a tank” on page 146 for further information on advanced configuration options.

For further information on installation and configuration of a Rosemount 5300 Guided Wave Radar see the Rosemount 5300 Reference Manual (Document No. 00809-0100-4530).
5.11.1 Configuration via 5300 Properties

This section describes the basic configuration procedure for a Rosemount 5300 Guided Wave Radar by using the 5300 GWR window.

To configure the Rosemount 5300 Guided Wave Radar perform the following steps:

1. In the WinSetup Workspace window, open the Devices folder and select the desired Rosemount 5300.

2. Click the right mouse button and select Properties, or from the Service menu choose the Devices/Properties option. The 5300 GWR window appears.
3. Select the *Communication* tab.

![Image of Communication tab]

4. Verify the position in the tank database. The *Connected to HUB* field shows the name of the 2410 Tank Hub and the tank position that the 5300 is mapped to in the 2410 tank database. The tank position indicates which tank the 5300 is associated with. In case the 5300 radar is connected to a multiple tank version of the Rosemount 2410, the 5300 may be mapped to another tank position via the 2410 Tank Hub Properties/Tank Database window if necessary (in the WinSetup workspace, click the right mouse button on the 2410 icon and choose the Properties option). See “Tank Database setup” on page 70 for more information on how to configure the 2410 Tank Database.

5. Verify that the Modbus address is correct. To change the Modbus address click the *Change* button.

![Image of Change Address window]

a. Enter the Unit ID in the *Unit ID* input field. When changing the device address, the Unit Id is used as a unique identifier of the device. The Unit Id can be found on a label mounted on the device.

b. Set the desired address in the *Set Modbus Address* input field.

c. Click the *OK* button to confirm the settings and to close the *Change Address* window.

6. Click the *Apply* button to store the configuration.
7. Select the **Probe** tab.

8. Choose a **Probe Type** that corresponds to the probe that is used on the 5300. It is possible to choose a predefined (standard) probe, or User Defined for non-standard probes. When using a predefined probe type, measurement performance is optimized by automatically specifying various device parameters. For a User Defined probe the database settings must be configured manually.

   The following predefined (standard) **Probe Types** are available:
   - Flexible Twin
   - Flexible Single
   - Coaxial

9. Specify the **Probe Length**. The Probe Length is measured from the Upper Reference Point to the end of the probe. If a weight is used at the end of the probe it shall not be included. See the *Rosemount 5300 Reference Manual* for more information.

10. Adjust the **Hold Off Distance (UNZ)** if there are disturbances in the upper part of the tank. Such problems may occur if there are disturbing objects, such as a narrow nozzle with rough walls, close to the probe. By increasing the Hold Off distance, the measuring range is reduced.

11. Click the **Apply** button to store the configuration.

   See the *Rosemount 5300 Reference Manual* (Document No. 00809-0100-4530) for more information on **Hold Off Distance** and other configuration parameters.
12. Select the *Geometry* tab.

13. Enter the **Tank Reference Height (R)**. The Tank Reference height is defined as the distance from the Upper Reference Point to the Zero Reference Point.

14. Enter the **Reference Distance (G)**. Reference Distance is the distance between the Upper Reference Point and the flange.

15. Enter the **Calibration Distance**. Use this variable to adjust the Tank Reference Height (R) so that measured product levels match the hand dipped level values. Normally a minor adjustment is necessary when the device is installed. For example, a minor deviation between the actual tank height and the value stored in the device database may occur if tank dimensions according to drawings are not quite up to date with actual dimensions.

16. Choose the appropriate *Mounting Type*: *Pipe Chamber*, *Direct Bracket*, or *Nozzle*. Choose *Unknown* if none of these is appropriate. Depending on the chosen mounting type you may also need to specify other parameters such as Inner Diameter and Nozzle Height.

17. Select the **Show level below probe end as zero** check box if you want the 5300 to present negative product levels as zero.

18. Click the **Apply** button to store the configuration, or click the **OK** button to store the configuration and close the window.

See the *Rosemount 5300 Reference Manual (Document No.00809-0100-4530)* for more information on various tank geometry parameters.
5.11.2 Advanced Configuration

In addition to the basic configuration there are advanced configuration options available for the Rosemount 5300 Guided Wave Radar. Environment conditions such as rapid level changes and dielectric constants of products as well as vapor dielectric constant can be configured.

The 5300 GWR/Environment window can be used to optimize the 5300 Guided Wave Radar for special tank conditions as illustrated below. To configure Environment parameters for the Rosemount 5300:

1. In the Workspace window, select the Rosemount 5300 icon.
2. Click the right mouse button and choose the Properties option. The 5300 GWR window appears.
3. Select the Environment tab.

![Environment Configuration Window](image)

**Measurement mode**

The 5300 is pre-configured according to the specified model and normally the measurement mode does not need to be changed.

**Rapid level change**

Select the **Rapid Level Change** check box if the surface is moving quickly up or down at rates over 0.1 m/s (4 inch/s).
Dielectric constant/dielectric range

The Product Dielectric Range is used for setting the appropriate signal amplitude thresholds in order to filter out noise from the measurement signal.

In interface level measurements, dielectric constants can be configured for both the upper and the lower products. For the Product Dielectric Range choose option Unknown if the correct value range is not known or if the contents of the tank is changing on a regular basis.

For Measurement Mode Liquid Product Level enter the Product Dielectric Range. In some applications there is heavy vapor above the product surface having a significant influence on the level measurement. This may for example be the case of saturated water vapor under high pressure. In such cases the Vapor Dielectric Constant can be changed to compensate for this effect. Normally this value does not have to be changed since the effect on measurement performance is very small for most vapors. The default value is equal to 1 which corresponds to the dielectric constant of vacuum.

For Measurement Mode Product Level and Interface Level enter the Upper Product Dielectric Constant. If the dielectric constant of the lower product is significantly smaller than the dielectric constant of water you may need to adjust the Lower Product Dielectric Range as well.

See the Rosemount 5300 Reference Manual (Document No. 00809-0100-4530) for more information on tank environment settings.
5.11.3 Installing a 5300 using the installation wizard

The installation wizard in TankMaster WinSetup is a tool that may be used to install and configure a Rosemount 5300 Guided Wave Radar and other devices.

Normally a 5300 is installed as part of the installation procedure for a Rosemount 2410 Tank Hub. However, the installation wizard lets you install a Rosemount 5300 Transmitter in TankMaster separately from the 2410 installation.

1. Configure the Tank Database of the Rosemount 2460 System Hub by including the new 5300 transmitter. Ensure that the correct Modbus address is configured (see “Installing a Rosemount 2460 System Hub” on page 65 for more information).

2. Configure the Tank Database of the Rosemount 2410 Tank Hub in the 2410 HUB Properties/Tank Database window, (see “Installing a Rosemount 2410 Tank Hub” on page 66 for more information).

3. Install and configure the Rosemount 5300 as described in “Using the installation wizard” on page 89.

In most cases the following procedure is recommended when installing a new Rosemount 5300 Guided Wave Radar:

1. Add the new 5300 transmitter to the Tank Database of the 2460 System Hub. Ensure that the correct Modbus address is configured (see “Installing a Rosemount 2460 System Hub” on page 65 for more information).

2. Open the 2410 Tank Hub Properties/ Tank Database window and configure the Tank Database of the 2410 Tank Hub, (see “Installing a Rosemount 2410 Tank Hub” on page 66 for more information).

3. In the 2410 Tank Hub Properties/ Device Tags window ensure that the Install Level and AUX devices check box is selected. This will make sure that the 5300 is automatically installed in the TankMaster workspace.

4. Configure the 5300 (see “Configuration via the Properties window” on page 81).

See also “Adding a tank” on page 159 for further information on adding tanks and devices to a Rosemount Tank Gauging system.
Using the installation wizard

To configure a Rosemount 5300 by using the WinSetup installation wizard perform the following steps:

1. In the Workspace window select the Devices folder.

2. Click the right mouse button and select Install New, or from the Service menu choose Devices/Install New.
   The Select Device window appears:

3. Choose Device Type 5300 Guide Wave Radar from the drop-down list.

4. Enter the level tag used for the 5300.

5. Click the Next button to open the 5300 GWR Communication window.
6. In the 2410 Tag drop-down list choose the Rosemount 2410 Tank Hub that the 5300 
radar transmitter is connected to.

7. Check that the Modbus address is the same one that is used for the 5300 in the Tank 
Databases of the 2460 System Hub and the 2410 Tank Hub.

8. Click the Verify Communication button to verify that the TankMaster PC 
communicates with the 5300. The Unit ID appears when contact is established.

9. Verify that the Position in 2410 HUB is the tank position that the 5300 is mapped to in 
the 2410 tank database. The tank position indicates which tank the 5300 is associated 
with.

In case the 5300 radar is connected to a multiple tank version of the Rosemount 2410, 
the 5300 tank position can be changed via the 2410 Tank Hub Properties/Tank Database 
window if necessary (in the WinSetup workspace, click the right mouse button on the 
2410 icon and choose the Properties option). See “Tank Database setup” on page 70 for 
more information on how to configure the 2410 Tank Database.

10. Click the Next button to proceed with the 5300 configuration.

11. For configuration of the 5300 GWR Probe window refer to the appropriate parts in 
“Configuration via 5300 Properties” on page 136.

12. For configuration of the 5300 GWR Environment window refer to the appropriate parts in 
“Installing a tank” on page 146.
13. In the **5300 GWR Summary** window click the **Finish** button to finish the installation wizard. If the configuration needs to be changed click the **Back** button until the desired window appears.

Further configuration options are available in the **5300 GWR window**, see "Installing a tank" on page 146.
5.12 Installing a tank

5.12.1 Overview

Basically the purpose of the tank installation procedure is to associate various devices to the right tanks. It also includes mapping variables such as Free Water Level and Vapor Pressure to specific instrument outputs.

Installing a new tank is a simple and straightforward procedure when using the tank installation wizard.

**Note!**
Make sure that measurement units are specified before installing a new tank. See also "Measurement units" on page 54.

The specified measurement units only affect installation of new tanks. Changing measurement units has no effect on tanks which are already installed in WinSetup. This means that if you want to change measurement units for an installed tank, it has to be uninstalled first, and then installed again after changing the measurement units in the Server Preferences/Units window. See also "Measurement units" on page 54.

A tank installation includes the following steps:

1. Specify tank type: Fixed Roof, Floating Roof, Sphere, Horizontal etc.
2. Select which devices to associate with the tank.
3. Configure the tank. For inventory calculations you will need to specify source signals for Free Water Level (FWL), Vapor Temperature, Vapor Pressure and Liquid Pressure, see “Advanced parameter source configuration” on page 116.
4. Specify input for the different tank variables: automatic (measured by a field device) or manual values.
5.12.2 Starting the tank installation wizard

To start the tank installation wizard do the following:

In the Logical View select the Tanks folder.
Click the right mouse button and choose Install New from the popup menu, or from the File menu choose Install New>Tank.

As an alternative you can use the following method:
In the Logical View or the Physical View select the server where the system is installed.
From the File menu choose Install New>Tank.

See "Installing a new tank" on page 148 for further instructions.
5.12.3 Installing a new tank

To install and configure a tank by using the WinSetup installation wizard do the following:

1. Start the **TankMaster WinSetup** program.

2. Start the tank installation wizard (see “Starting the tank installation wizard” on page 147 for more information).

3. Choose the appropriate tank type. For a Rosemount Tank Gauging system the following options are available:
   - Fixed Roof
   - Floating Roof
   - Sphere
   - Horizontal
   - LPG Sphere, LPG Horizontal
   - Servo Tank:
     - Fixed Roof, Floating Roof, Sphere LPG, Horizontal LPG, Servo Tank Sphere, Horizontal
   - HTG Fixed Roof, HTG Floating Roof, HTG Floating Roof Blanket

4. Enter a name in the **Tank Tag** input field. A prefix appears automatically if you have defined one in the **Tag Prefixes** window (see “Setting the name tag prefixes” on page 58). It is recommended that the same name is used as in the tank database of the 2410 Tank Hub, see “Installing a Rosemount 2410 Tank Hub” on page 66.

   Note that Tank Tag must begin with a letter.

5. Click the **Next** button to proceed with the tank installation.
6. Assign field devices to the current tank:
   a. From the Available Devices pane, choose a device that is installed on the current tank and click the arrow button to move it to the Selected Devices pane.
   b. Repeat this procedure for each device that is associated with the tank.

   ![Select Devices Interface]

   1. Select a device
   2. Click this button
   3. The device appears in the Selected Devices pane
   4. Repeat the procedure for each device to be associated with the tank

**Note!**
It is recommended that devices are installed prior to installing tanks. In a Rosemount Tank Gauging system, field devices should be installed as described in “Installation procedure” on page 40.
Show slave positions (advanced)

The “Show Slave Positions” check box should only be used for advanced tank configuration of devices which are not supported by the Rosemount Tank Gauging system.

A device which is connected to the Tankbus and configured in the Tank Database of the 2460 System Hub, will appear in the Available Devices pane at the left-hand side of the Select Devices window.

In case a device which can not be identified by the Rosemount Tank Gauging system is connected to the Tankbus, you will have to select the “Show Slave Positions” check box in order to map this device to a tank.

To associate an “unknown” device to a tank do the following:

a. In the Select Devices window, select the Show Slave Positions check box to display the Tank Database positions of the 2460.

b. In the Select Devices window choose the Slave Database position that corresponds to the tank where the device is installed.

In the example above the devices are mapped to position 5 which is identified as SYSHUB-201.05 in the 2460 Tank Database.

c. Move the selected item to the Selected Devices pane by clicking the button.

7. Click the Next button to proceed with the tank installation.
8. Configure the tank.

The *Tank Configuration* window lets you enable tank measurement variables such as *Vapor Temperature*, *Vapor Pressure*, *Liquid Pressure*, and *Free Water Level* (FWL) for calculating *Observed Density* and other inventory parameters. See the *TankMaster WinOpi Reference Manual* for more information on inventory parameters.

![Tank Configuration window](image)

The *Calculate in TankMaster* check box may be used for devices without internal calculation of *Level Rate*. By selecting this check box the Level Rate is calculated by the TankMaster program.

*Liquid Pressure* and *Vapor Pressure* are not automatically mapped to measurement instruments. These tank measurement variables have to be mapped to an instrument in the *22XX ATD/Advanced Parameter Source Configuration* window in order to make them available in the *Tank Configuration* window. See Figure 5-6 on page 152 for an example of how to map the Liquid Pressure variable to the output of a Rosemount 3051S pressure transmitter.

See also “Advanced parameter source configuration” on page 116 for further information on mapping tank measurement variables to source devices.

To open the *22XX ATD/Advanced Parameter Source Configuration* window:

a. In the TankMaster WinSetup workspace, click the right mouse button on the ATD device icon and choose the Properties option.

b. Select the *Advanced Parameter Source Configuration* tab.

c. Map the appropriate tank measurement variable to the output of a transmitter that is available on the Tankbus. See an example in Figure 5-6 on page 152.
Figure 5-6. A measurement instrument which is mapped in the 22XX ATD/Advanced Parameter Source Configuration window can be selected in the Tank Configuration window.

22XX ATD / ADVANCED PARAMETER SOURCE CONFIGURATION

TANK CONFIGURATION
Advanced Configuration

The Advanced Tank Setup window allows you to change mapping of tank measurement variables to gauge output. This option can be used, for example, to map the relay outputs of a Rosemount 2410 Tank Hub to relay status presentation in the TankMaster WinOpi program.

Note!
Advanced configuration should only be used when there is no appropriate option available in the standard Tank Configuration window.

To change tank parameter mapping do the following:

a. Click the Advanced button in the Tank Configuration window.

b. For each tank input variable you can change output as well as gauge. Simply put the mouse pointer in the Gauge or Output field of the desired Tank Input variable (Level, Level rate, etc.) and choose the appropriate option from the drop-down list.

c. Click the OK button to close the Advanced Tank Setup window.

9. In the Tank Configuration window, click the Next button to proceed to the next step of the tank installation procedure.
10. The Value Entry window lets you:
   - Choose whether to use measurement values (Automatic) from available instruments, or manual values.
   - For Level and Free Water Level, specify parameter Value Range to be used in various windows for presentation of measurement data.

   ![Value Entry Window]

   The Free Water Level, Liquid Pressure, and Vapor Pressure parameters are set to Value Source=Manual by default. Therefore, the tank needs to be configured for automatic measurements when these type of instruments are used.

   The Value Entry window allows you to disable automatic measurements for selected parameters in case you need to remove an instrument for service purposes.

   To use manual values do the following:

   1. Choose a measurement variable in the Parameters list on the left-hand side of the Value Entry window.
   3. Type the desired value in the Value entry field.

   Now the automatic measurement is disabled for the selected tank measurement variable. Manual values are marked yellow in order to distinguish from automatically measured values.
The **Value Range** parameters (Minimum and Maximum) lets you scale bar graphs in the *Tank View* window and other windows (in Winsetup as well as WinOpi) where bar graphs are used to display product levels.

For example, the **Value Range** maximum value for Level is normally set equal to the Tank Reference Height (R), or the maximum level in the strapping table, to obtain correct scaling of the level bargraphs as illustrated below:

![Value Range Example](image1.png)

**Value range:** Min=0 Max=20 m

**Value range:** Min=0 Max=12 m

---

4. **Summary.**

The **Summary** window presents information about the current tank installation. When you click the **Finish** button, the tank installation is completed and the tank appears in the *WinSetup Workspace*. You can choose not to finish the installation by clicking the **Cancel** button. Note that if a device was installed as part of the tank installation process, the device remains installed and appears in the *Workspace* although the tank installation was not completed.

![Summary Window](image2.png)

**Name of the current tank**

**Associated devices**
5.12.4 Summary of Tank Installation and Configuration

**Tank Type**
Choose the tank type option that corresponds to the actual tank.

**Select Devices**
Associate devices with the tank.

**Tank Configuration**
Specify the source input for Vapor Temperature, Vapor Pressure, Liquid Pressure, and Free Water Level (FWL).

**Value Entry**
Configure for automatic measurements. If needed, set manual values by disconnecting the automatic measurement. Set the value range for scaling of measurement variables in bar graphs.
5.12.5 To change tank configuration

When a tank is installed and configured the current settings can be modified at any time by opening the corresponding Properties dialog. To open the Properties dialog for a tank do the following:

1. In the Workspace window select the desired tank.

2. Click the right mouse button and choose the Properties option from the popup menu.

3. Change the current tank settings by selecting the appropriate tab in the Properties window.

4. Click the Apply button to store the configuration before advancing to the next tab.

Basically the tabs correspond to the different steps in the installation wizard. See “Installing a tank” on page 146 for a description on how to configure a tank.
5.12.6 To uninstall a tank

To remove a tank from the WinSetup workspace do the following:

1. In the Workspace window select the tank you want to remove.

2. Click the right mouse button and choose the **Uninstall** option from the popup menu.
5.13 Adding a tank

New tanks can easily be added to a Rosemount Tank Gauging system. The procedure will be slightly different depending on the specific system configuration. It can be summarized as described below in sections “Adding a new tank and a new 2410 Tank Hub” on page 159, and “Adding a new tank to an existing 2410 Tank Hub” on page 162.

5.13.1 Adding a new tank and a new 2410 Tank Hub

Summary

To install a new Rosemount 2410 Tank Hub and a new tank in a Rosemount Tank Gauging system that includes a Rosemount 2460 System Hub and various field devices:

1. Configure the communication settings of the 2460 System Hub.
2. Update the Tank Database of the 2460 System Hub by adding field devices to be associated with the new tank.
3. Install the new Rosemount 2410 Tank Hub and configure the Tank Database by mapping field devices to the new tank.
4. Configure the field devices added to the 2410 tank database (Rosemount 5900S, Rosemount 2240S, Rosemount 3051S etc.).
5. Configure the new tank.

Figure 5-7. A new tank and 2410 Tank Hub are added to the workspace
Installation procedure

To add a new tank and new field devices to a Rosemount Tank Gauging system do the following:

1. Start the TankMaster WinSetup program.

2. In the WinSetup workspace, right-click the icon of the 2460 System Hub to open the 2460 System Hub window.

3. Select the Configuration tab:

![Configuration Tab Image]

4. In case the 2410 is connected to a field bus port on the 2460 System Hub which has not been used prior to adding the new 2410 Tank Hub, ensure that the 2460 System Hub Configuration window is properly configured for the 2410 Primary Bus. For example, you may have to change the Baud Rate depending on the type of communication bus that is used; RS-485 or TRL2. See “Installing a Rosemount 2460 System Hub” on page 65 for further instructions and information.

5. Click the Apply button to save the configuration.

6. Select the Tank Database tab.
7. Configure the Tank Database with Modbus addresses for the new 2410 Tank Hub, level gauge, and temperature device (ATD\(^{(1)}\)), see “Installing a Rosemount 2460 System Hub” on page 65 for more information.

8. Install and configure a Rosemount 2410 Tank Hub and the field devices connected to the Tankbus as described in “Installing a Rosemount 2410 Tank Hub” on page 66.

9. Install a tank and associate the new 2410 to the tank as described in “Installing a tank” on page 146.

Now the new tank and field devices are installed and configured and will appear in the TankMaster workspace.

Figure 5-8. New tank and 2410 Tank Hub

---

(1) Auxiliary Tank Device (ATD) is used in the Tank Database of the 2410 Tank Hub to designate various devices such as temperature and pressure transmitters, displays and other non-level devices.
5.13.2 Adding a new tank to an existing 2410 Tank Hub

Summary

To add a new tank to an existing Rosemount 2410 Tank Hub in a Rosemount Tank Gauging system that includes a Rosemount 2460 System Hub and various field devices:

1. Update the Tank Database of the 2460 System Hub by adding the field devices installed on the new tank.
2. Update the tank database of the existing Rosemount 2410 Tank Hub by mapping the new field devices to the new tank.
3. Configure the new field devices added to the 2410 tank database.
4. Configure the new tank.

Figure 5-9. A new tank is added to an existing 2410 tank hub
**Installation procedure**

In case new devices are connected to an existing 2410 Tank Hub, you will have to update the tank databases of the 2460 System Hub and the 2410 Tank Hub, as well as install and configure the new devices in TankMaster WinSetup.

1. Start the TankMaster WinSetup program.
2. Open the 2460 System Hub window.
3. Select the Tank Database tab.
4. Configure the Tank Database with Modbus addresses of the new level gauge and ATD devices, see “Installing a Rosemount 2460 System Hub” on page 65 for more information.
5. In the WinSetup Workspace, select the 2410 Tank Hub icon:
6. Click the right mouse button on the **Properties** option, or from the **Service** menu choose **Devices>Properties**.
7. Select the **Tank Database** tab:

![Image of Tank Database window]

- **New Devices**

8. Verify that the new devices connected to the Tankbus appear in the **Device Type** column. Devices that appear in the list are properly communicating on the Tankbus. Devices supported by the Rosemount Tank Gauging system will automatically be identified by the 2410.

9. Verify that the devices to be associated with the new tank are marked “Not Configured” in the **Tank Position** column.

10. Map the new devices to a tank in the Tank Position column by selecting the appropriate number in the drop-down list.
11. Verify that a new tank position appears in the right-hand pane of the Tank Database window. In the example above, the new devices are mapped to tank position 4, and a tank position was added to the list of tanks in order to allow configuration of tank name and Modbus addresses for the new devices.
12. Type a name in the **Tank Name** field. This tank name should also be used at a later stage when installing the tank to be associated with the current 2410 Tank Hub, see “Installing a tank” on page 146.

13. The **Level Modbus Address** field is enabled for the new level gauge. Specify a Modbus address of your own choice. Note that it must be the same Modbus address as configured in the Tank Database of the 2460 System Hub for this level gauge.

14. In case an Auxiliary Tank Device (ATD) such as a Rosemount 2240S Multi-input Temperature Transmitter is installed, the **ATD Modbus Address** field is enabled as well.

   Specify a Modbus address of your own choice. Note that it must be the same Modbus address as configured in the Tank Database of the 2460.  
   For tank position 1, the ATD Modbus address is automatically configured as the Modbus address of the Rosemount 2410 Tank Hub itself.  
   All the non-level devices on a tank are represented by a single ATD device in the Rosemount Tank Gauging system.

   See “Installing a Rosemount 2460 System Hub” on page 65 and “Installing a Rosemount 2410 Tank Hub” on page 66 for further information on how to configure the tank databases of the 2460 System Hub and the 2410 Tank Hub.

15. Click the **Apply** button to store the tank database configuration.

16. Select the **Device Tags** tab.
17. Verify that the **TankMaster Level Tag** is correct or enter a new one.

18. Verify that the **TankMaster ATD Tag** is correct or enter a new one.
   In case there are no ATD device associated with the tank, the ATD tag field will be disabled.

19. Click the **Install New Devices in TankMaster** button to automatically install the devices in the **TankMaster Workspace**. This is the recommended way of installing field devices in TankMaster, but you may install the devices at a later stage by using the device installation wizard, see "Using the device installation wizard" on page 43.

20. Click the **OK** button to store the configuration and close the 2410 Tank Hub configuration window.

21. The devices will now be available in the TankMaster workspace, and each device has to be configured via the **Properties window**, see for example "Installing a Rosemount 5900 Radar Level Gauge" on page 80 and "Installing Auxiliary Tank Devices" on page 109.

22. Proceed with installing the tank as described in "Installing a tank" on page 146.

Now the new tank and field devices are installed and configured and will appear in the TankMaster workspace.
5.14 Level gauge calibration

Normally a minor level gauge adjustment is needed in order to accurately match measured and actual product levels. For example, a deviation may result from minor errors in tank geometry parameters such as the tank height (R) or the position of the Gauge Reference Point (see the Rosemount 5900S Radar Level Gauge reference manual, Document No. 00809-0100-5900, for more information on tank geometry).

The Rosemount 5900 level gauge can be calibrated by using the **Calibration Distance** parameter. It can be manually adjusted in the 5900S Properties/Geometry window.

For 5900 gauges in Still-pipe applications you may use the **Calibrate** function to let WinSetup automatically calculate an optimized Correction Factor and Calibration Distance based on measurement data and hand dipping at different product levels.

---

**Note!**
For a comprehensive description of how to calibrate a Rosemount 5900S Radar Level Gauge see the Rosemount 5900S Reference Manual (Document No. 00809-0100-5900).

---

5.14.1 Manual Adjustment

A Rosemount 5900 level gauge can be calibrated manually by adjusting the Calibration Distance parameter\(^{(1)}\). By comparing hand dipped level values with product levels measured by the gauge, a Calibration Distance value can be calculated according to the formula:

\[
\text{New Calibration Distance} = \text{Old Calibration Distance} + \Delta L,
\]

where \(\Delta L\) = observed level (hand dip) - gauge level reading.

**To change the Calibration Distance stored in the gauge database:**

1. Select the level gauge icon in the WinSetup workspace.
2. Click the right mouse-button and choose the **Properties** option.
3. Select the **Geometry** tab.
4. Type the **Calibration Distance** value in the corresponding input field and click the **OK** button.


---

\(^{(1)}\) For non-standard antennas the Tank Connection Length (TCL) may need to be adjusted as well.
5.14.2 Using the Calibrate function

The **Calibrate** function is a tool which allows you to calculate the Correction Factor for still-pipe measurements and the Calibration Distance. It optimizes measurement performance from the top to the bottom of the tank by automatically minimizing the offset between actual product levels and level values measured by the gauge.

**To calibrate a Rosemount 5900S Radar Level Gauge**

1. Select the 5900 icon in the *Workspace* window, click the right mouse button and choose **Calibrate**, or choose **Calibrate** from the *Service/Devices* menu:

2. Click the **Calibration Data** button to open the *Calibration Data* window. Enter hand dipped level values and the corresponding levels measured by the gauge. Click the **Save Calibration Data in PC Database** button.

   The *Calibration* window displays a straight line fitted through measurement points representing the difference between hand dipped level values and values measured by the level gauge. For still-pipe antennas a sloping line is displayed, otherwise the line is horizontal.

3. Click the **Write new calibration data to RTG** button in order to save the current calibration data.

   A new Calibration Distance will be calculated and the level values measured by the 5900 are recalculated.

   See the *Rosemount 5900S Reference Manual* (Document No. 00809-0100-5900) for further information on using the Calibrate function for a Rosemount 5900S Radar Level Gauge.
5.15 Tank capacity

The tank geometry can be defined in a strapping table: the **Tank Capacity Table** (TCT). The TCT is used to convert a product level to the corresponding volume. Different TCT types can be specified: Raw; International, and Northern.

To open the **Tank Capacity Setup** window for a certain tank, select the tank icon in the workspace window, click the right mouse button and choose the Tank Capacity option:

See the *Rosemount TankMaster WinOpi Reference Manual* (Document No. 303028EN) for more information on the **Tank Capacity Setup** window and how to set up a Tank Capacity Table.
5.16 **Tank Entry**

The *Tank Entry* window is used for specifying a number of product parameters to be used for inventory calculations. TankMaster can use measured data, or data that is manually entered. To open the *Tank Entry* window:

1. In the WinSetup workspace select the tank to configure.

2. Click the right mouse button and choose the Tank Entry option:

3. To enter manual values select the check box and type the desired value in the input field. Manual values are marked with yellow as illustrated above.

See the *Rosemount WinOpi Reference Manual* (Document No. 303028EN) for further information on how to use the *Tank Entry* window.
5.17 Setting up a hybrid system

This is a description of how to install a Rosemount Tank Gauging system for on-line density measurements and mass calculations. Before starting the setup make sure the Tank Database of the 2460 System Hub is configured accordingly, see “Installing a Rosemount 2460 System Hub” on page 65.

For the mass calculations to work properly, a tank strapping table (also referred to as a Tank Capacity Table) must be entered.


A Rosemount Tank Gauging hybrid system typically includes two pressure sensors, P1 and P3, and a Rosemount 5900S Radar Level Gauge. In case there is always atmospheric pressure in the tank, the P3 sensor may be excluded. To configure the hybrid system:

1. Start the TankMaster WinSetup program.
2. In the Workspace window select the tank server icon (This Workstation in the example below):

   ![Network Connections](image)

   - Click the right mouse button and select Setup, or choose menu option Service>Servers>Setup to open the Server Preferences window.

3. Select the Units tab.
5. Choose the desired measurement units for **Density** and **Pressure**.
6. Click the **Apply** button to store the settings.
7. Select the **Inventory** tab.

8. For Local Gravity choose calculation method **Manual** or **Calculated**. The Local Gravity is used as input for calculating the Observed Density. **Manual**: enter a local gravity value in the “Value” field. **Calculated**: enter the latitude and elevation of the site where the tank is located.
9. Click the **OK** button to store the configuration and close the window.
10. In the **Workspace** window select the ATD device icon:

11. Click the right mouse button and select **Properties**, or from the **Service** menu choose **Devices>Properties** to open the 22XX ATD window.

12. Select the **Advanced Parameter Source Configuration** tab.

13. Verify that the parameters **Vapor Pressure** and **Liquid Pressure** are mapped to the correct pressure sensors (Source Device). See “**Advanced parameter source configuration**” on page 116 for further information on how to map system parameters to source devices.

14. Click the **OK** button to store the configuration and close the window.
15. Open the **Tank Configuration** window:
   a. In Winsetup select the desired tank icon in the workspace window.
   b. Click the right mouse button and choose **Properties**, or from the **Service** menu choose **Tanks>Properties** to open the **Tank Configuration** window.

16. Select the **Configuration** tab.

17. Choose source parameter and measurement unit for **Vapor Pressure** and **Liquid Pressure**.

18. Verify measurements by opening the **Tank View** window (**Service>Tanks>Open Tank View**).
19. Configure the Liquid Pressure and Vapor Pressure sensors. In the WinSetup workspace window select the tank icon:

20. Click the right mouse button and choose **Hybrid Tank Setup**, or from the **Service** menu choose **Tanks>Hybrid Tank Setup**, to open the **Hybrid Tank Setup** window.

21. Enter the **P1 Sensor Position**, i.e. the center position of the sensor membrane for the Liquid Pressure transmitter.

22. Enter the **P3 Sensor Position**, i.e. the position of the center of the Vapor Pressure sensor membrane.

23. Enter the **Hybrid Min Level**. This value specifies the lowest product level at which TankMaster calculates the **Observed Density**. Normally, the accuracy of pressure sensors is poor at low pressures, i.e. at product levels close to the sensor membrane. Therefore, you can enter a limit below which the density calculation is “frozen”. For example, if Hybrid Min Level is equal to 0.6 meter, TankMaster WinOpi will present the same density value for product levels below 0.6 meter.

**Note!**
Specify the actual minimum product level and not the distance between the pressure sensor and the product surface.

24. Click the **Apply** button to save the Hybrid Tank Setup configuration, or the **OK** button to save and close the window.
25. In the WinSetup workspace window select the tank icon:

```
[Image of tank selection in WinSetup]
```

26. Click the right mouse button and choose Tank Entry, or from the Service menu choose Tanks>Tank Entry to open the Tank Entry window:

```
[Image of Tank Entry window]
```

27. Ensure that the Reference Density is measured automatically, i.e. the check box is unmarked.

28. Click the Apply button to save the configuration, or click the OK button to save the configuration and close the window.
29. In the WinSetup workspace window select the tank icon:

![Tank Icon Selection](image)

30. Click the right mouse button and choose Properties, or from the Service menu choose Tanks>Properties to open the Tank Configuration window.

31. Select the Value Entry tab.

![Value Entry Tab](image)

Check that Value Source is set to Automatic

32. Ensure that Value Source is set to Automatic for the Liquid Pressure and Vapor Pressure measurement variables.

33. Click the OK button to save the configuration and close the window.
34. Check the result in the *Tank Inventory* window:
   
a. Start the *TankMaster WinOpi* program.
   
b. In the *WinOpi* workspace select the tank icon.
   
c. From the View menu, choose the Tank>Tank Inventory option.

If the inventory calculations seem to be incorrect, see chapter *Checklist for Inventory Parameter Setup* in the *TankMaster WinOpi Reference Manual (Document No. 303028EN)* for more information.
Section 6 Device Handling

To change device configuration ................................................................. page 181
To uninstall a device ................................................................................. page 183

6.1 To change device configuration

Once a device is installed and configured, you can modify the current settings at any time by opening the Properties dialog.

To open the Properties dialog do the following:

1. In the WinSetup Workspace window select the desired device.
2. Open the Devices folder and select the device icon.
3. Click the right mouse button and choose the Properties option, or from the Service menu choose the Devices/Properties option.
4. The device properties window (5900S RLG Properties window in this example, see the next page) appears with various tabs allowing you to change the current device settings.
A number of tabs are available for configuration of communication parameters, tank geometry, device specific parameters and advanced configuration options.

Some of the tabs refer to the different steps in the device installation wizard. Similar dialogs are available for other device types as well, for example the Rosemount 2410 Tank Hub.

See Section 5: Installing a Rosemount Tank Gauging System for detailed descriptions on how to configure various devices.
### To uninstall a device

A device can be uninstalled from the WinSetup workspace at any time. However, the associated tank must be uninstalled first. As an alternative you may keep the tank by disconnecting the device from the associated tank before the device is uninstalled.

**To uninstall a device**

1. Start by uninstalling the associated tank, see "To uninstall a tank" on page 158.

2. In the WinSetup workspace, select the device and click the right mouse button.

3. Choose the **Uninstall** option.

   Now the device is removed from the WinSetup workspace.

**To uninstall a device without uninstalling the tank**

If you prefer to keep the tank, you can disconnect it from the device and then uninstall the device:

1. In the WinSetup workspace, select the desired tank and click the right mouse button.

2. Choose the **Properties** option and select the **Configuration** tab.
3. Click the **Change** button.

4. In the right-hand side of the *Select Devices* window, select the device and click the left arrow button. The device will be removed from the *Selected Devices* pane to the *Available Devices* pane on the left-hand side.

5. Click the **OK** button.
Section 6: Device Handling

6. Open the **Tanks** folder:

![Image of TankMaster/WinSetup interface showing Tanks and Devices folders with LT-TK-1 and SYSHUB-201 folders]

   The LT-TK-1 level gauge is not associated with tank TK-1, but it is still available in the Devices folder.

7. Verify that the device (LT-TK-1 in this case) is no longer associated with the tank.

8. Open the **Devices** folder:

![Image of TankMaster/WinSetup interface showing Uninstall option]

   Uninstall

9. Select the device and click the right mouse button.

10. Choose the **Uninstall** option.

    Now the device is removed. However, the tank is still available in the WinSetup workspace.
Section 7: Service Functions

7.1 Section overview

The information in this section covers a number of service functions that can be used for maintenance and troubleshooting devices supported by Rosemount TankMaster.

7.2 Safety messages

Procedures and instructions in this section may require special precautions to ensure the safety of the personnel performing the operations. Information that raises potential safety issues is indicated by a warning symbol (▲). Refer to the following safety messages before performing an operation preceded by this symbol.

▲ WARNING

Failure to follow safe installation and servicing guidelines could result in death or serious injury:
Make sure only qualified personnel perform the installation.
Use the equipment only as specified in this manual. Failure to do so may impair the protection provided by the equipment.
Do not perform any service other than those contained in this manual unless you are qualified.

High voltage that may be present on leads could cause electrical shock:
Avoid contact with leads and terminals.
Make sure the main power to the device is off and the lines to any other external power source are disconnected or not powered while wiring the device.
7.3 System status

The System Status Overview shows status and properties for the overall system, Tank Server, Protocol Servers, and devices.

To open the System Status Overview do the following:

1. Select a workstation in the Workspace window.
2. Click the right mouse button and choose System Status Overview, or from the Service menu choose Servers>System Status Overview.
7.4 Customizing the Tools menu in WinSetup

To add custom options to the Tools menu do the following:

1. Choose the **Tools>Applications** menu option to open the Customize window:

2. Click the **Add** button to add a new menu option to the Tools menu.

3. In the **Menu Text** field type the text you would like to appear in the Tools menu.
4. Press the  button next to the **Command** field.

5. Browse to the program file that will be associated with the new Tools menu option as given in the Menu Text field.

6. Click the Open button and return to the **Customize** window.

7. In the Arguments field type any argument that you want to add to the command line. This line is usually left blank.

8. Click the **OK** button.

9. In the **Tools** menu, choose the new menu option and verify that the associated application starts as expected.
7.5 User defined temperature conversion

The Rosemount 2240S Multi-input Temperature Transmitter supports the use of non-standard spot temperature sensors. For these types of temperature elements you can specify the relation between temperature and electrical resistance with tables or mathematical formulas.

To enable and configure the different conversion methods:

1. In the WinSetup workspace, select the ATD device icon.
2. Click the right mouse button and choose the Properties option.

3. In the 22XX ATD window, select the 2240S MTT Temperature Sensor tab:

4. Disable Use Auto Sensor Configuration.
5. In the Conversion Method drop-down menu, choose the desired user defined conversion method.
6. Click the configuration button that corresponds to the selected user defined conversion method and configure the temperature sensor as described below.
7. Choose sensor type (Connection) and specify temperature range.
8. Click OK to store the configuration and close the 22XX ATD window.
7.5.1 User defined linearization table

When using a resistance temperature sensor, the electrical resistance values can be converted to temperature values by using a table of resistance and temperature values.

To create a conversion table:

1. In the 2240S MTT Temperature Sensor window, choose conversion method User Defined Linearization Table.
2. Click the Configure User Defined Linearization Table button:

   ![User Defined Linearization Table](image)

3. Specify the number of conversion points in the Length of Table input field.
4. Type resistance and temperatures values into the Resistance [Ohm] and Temperature [C] columns.
5. Click the OK button to store the linearization table in the temperature transmitter’s database registers.
7.5.2 User defined formula

For a resistance temperature sensor, the relation between temperature and resistance can be specified by a mathematical formula:

\[ R = R_0 \times (1 + A \times T + B \times T^2) \]

where \( R \) is the resistance at temperature \( T \), \( R_0 \) is the electrical resistance at zero degrees Celsius, and \( A \) and \( B \) are constants.

To create a conversion formula:

1. In the 2240S MTT Temperature Sensor window, choose conversion method User Defined Formula.
2. Click the Configure User Defined Formula button:

![User Defined Formula Window](image)

3. Enter the parameters \( R_0 \), \( A \) and \( B \) in the corresponding input fields.
4. Click the OK button to store the \( R_0 \), \( A \) and \( B \) parameters in the temperature transmitter’s database registers.
7.5.3 User defined individual formula

When using *User Defined Individual Formula*, a mathematical formula is used for each individual temperature element:

\[ R = R_0 \cdot (1 + A_1 \cdot T + B_1 \cdot T^2 + C_1 \cdot T^3) \]

- \( R \) is the resistance at temperature \( T \)
- \( R_0 \) is the resistance at zero degrees Celsius
- \( A, B, \) and \( C \) are individual constants for each element
- \( N \) is the number of temperature sensors

To create an individual conversion formula:

1. In the **2240S MTT Temperature Sensor** window, choose conversion method *User Defined Individual Formula*.
2. Click the **Configure User Defined Individual Formula** button:

3. Enter parameters \( R_0, A, B, \) and \( C \) for each individual temperature element.
4. Click the **OK** button to store the formula in the temperature transmitter’s database registers.
7.6 Viewing input and holding registers

In a Rosemount Tank Gauging system, measurement data is continuously stored in **Input registers** of devices such as the Rosemount 2410 Tank Hub, Rosemount 5900S Radar Level Gauge, and other devices. By viewing the input registers of a device, you can verify that the device is working properly.

**Holding registers** store various device parameters used to control measurement performance.

To view Input or Holding registers of a certain device do the following:

1. In the WinSetup Workspace, select the device icon:

   ![View Input Registers](image)

2. Click the right mouse button, or open the Service>Devices menu, and choose the **View Input Registers** or **View Holding Registers** option.
3. **Registers Type:**
   - Choose **Predefined** if you would like to see a commonly used selection of database registers.
   - For advanced service the **All** option allows you to view a specific range of registers. Specify a start value in the **Start Register** input field, and the total number of registers to be displayed in the **Number of Registers** field (1-500).

4. The **Registers Scope** drop-down list has three options:

<table>
<thead>
<tr>
<th>Scope</th>
<th>Description</th>
<th>Access level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic</td>
<td>Standard setting that includes the most commonly used registers</td>
<td>View Only</td>
</tr>
<tr>
<td>Service</td>
<td>Includes a wider range of registers for advanced service and troubleshooting</td>
<td>Supervisor</td>
</tr>
<tr>
<td>Developer</td>
<td>For advanced users only</td>
<td>Administrator</td>
</tr>
</tbody>
</table>

5. In the *Show Values in* pane, choose the appropriate register format Decimal or Hexadecimal.

6. Click the **Read** button to upload the contents of the device database registers.
7.7 To edit holding registers

Most Holding registers can be edited simply by typing a new value in the appropriate Value input field. Some holding registers (marked grey in the Value column) can be edited in a separate window. Then you can choose from a list of options or you can edit separate data bits.

To edit a holding register, do the following:

1. In the WinSetup Workspace, select the device icon:

2. Click the right mouse button, or open the Service>Devices menu, and choose the View Holding Registers option.

3. To change the contents of input fields with white background color in the Value column, put the cursor in the field and type a new value.

To change input fields with grey background color, double click the field to open a new window for editing. Depending on the type of Holding register, an Expanded Enumerated or an Expanded Bitfield window is opened(1). Select from the list of options (Expanded Enumerated) or change the appropriate data bit (Expanded Bitfield) as illustrated below.

(1) Contact Emerson Process Management/Rosemount Tank Gauging for more information about the different Holding register types.
4. Click the **Apply** button to store the register data, or click the **Close** button to store and close the window.
7.8 Viewing diagnostic registers

The View Diagnostic Registers window shows a predefined set of diagnostic Input and Holding registers. Each device has a standard set of diagnostic registers which can be changed in the Configure Diagnostic Registers window.

To view and configure the diagnostic registers perform the following steps:

1. Select the device icon (for example a Rosemount 2410 or 5900S) in the TankMaster WinSetup workspace.

2. Click the right mouse button and choose View Diagnostic Registers.

Register values in this window are of read only type. They are loaded from the device as the window is opened.

Table cells with grey background color in the Value column represent registers of either Bitfield or ENUM type. An expanded Bitfield/ENUM window can be opened for these register types. Double-click a cell to open the Expanded Bitfield/ENUM window.
Registers of Bitfield and ENUM type can be presented in hexadecimal format by selecting the Show in Hex check box.

It is possible to view diagnostic registers for devices of the same type without closing the window and opening it again for a new device. Press \[ \text{Next} \] or \[ \text{Prev} \] buttons to step to the next or previous device. Alternatively, another device can be selected from the drop down menu on the left-hand side of the View Diagnostic Registers window.

The Configure button lets you specify a default setting of diagnostic registers. See “Configure” on page 201 for more information.

The Log Setup button provides easy access to the Register Log Scheduling window, which allows you to setup a log schedule for automatic start and stop of register logging. See “Logging measurement data” on page 203 for more information.

The Print button lets you print the current register information.
7.8.1 Configure

The Configure button in the View Diagnostic Registers window opens the Configure Diagnostic Registers window which allows you to change the default selection of diagnostic registers. You can use this option to setup the View Diagnostic Registers window for the selected device type:

1. In the Registers Type pull down menu, choose Holding or Input registers. Input Registers are displayed in blue, Holding Registers in black.

2. The Group Prefix drop down menu lets you filter the list in the left pane.

Note!
The Group Prefix feature is not supported for all device types.

3. A standard selection appears automatically in the Selected Registers pane on the right-hand side of the Configure... window. To add a register to the list, select it in the left pane and press the button.

To remove a register from the right pane, select it and press the button.

4. The order in which registers are displayed in the View Diagnostic Registers window can be configured. Select a register in the right pane and press to move it upwards, or to move it downwards in the list.

5. Press OK to store the current configuration.
7.8.2 Restore to default setting

In case you wish to restore the View Diagnostic Registers window to the default setup, you need to remove the file that contains the current configuration data for the View Diagnostic Registers window.

To restore to the default setting do the following:

1. In Windows Explorer open the following folder:

   C:\Rosemount\TankMaster\Setup\Data,

   where C:\ is the drive letter associated with the hard disk on which TankMaster is installed.

2. Locate the configuration file for the device whose diagnostic register setup you wish to restore:

<table>
<thead>
<tr>
<th>Device</th>
<th>Configuration file</th>
</tr>
</thead>
<tbody>
<tr>
<td>2410 Tank Hub</td>
<td>R2410_diag.ini</td>
</tr>
<tr>
<td>5900S Radar Level Gauge</td>
<td>R5900_diag.ini</td>
</tr>
<tr>
<td>2240 Multi-Input Temperature Transmitter and Auxiliary Tank Devices (ATD)</td>
<td>R22XX_diag.ini</td>
</tr>
</tbody>
</table>

3. Remove the *.ini file, or rename it in case you wish to store the file for future use (for example R2410.old).

4. Start TankMaster WinSetup and open the View Diagnostic Registers window to verify that the View Diagnostic Registers window shows the default setting of diagnostic registers.
7.9 Logging measurement data

Devices such as the Rosemount 2410 and Rosemount 5900S support logging of diagnostic registers. This function is useful for verifying that the gauge works properly. The logging function can be accessed by using the TankMaster WinSetup program. To start logging do the following:

1. Start the TankMaster WinSetup program.
2. Select the device icon in the WinSetup workspace.
3. Click the right mouse button and choose Logging.
4. The Manual mode lets you start logging at any time. In Automatic mode you have to specify a Start and Stop time.
5. The resulting log file(s) will not exceed the size specified by the Max File Size parameter.
   - In Automatic Mode logging will proceed until the Stop Date and Time is reached.
   - In Manual Mode logging will proceed until the Stop button is pressed.
   - Logging will stop automatically when the number of log files is equal to the number given by the Max Log Files parameter.
6. The log file is stored as a plain text file and can be viewed in any word processing program. It is stored in the following folder:

C:\Rosemount\Tankmaster\Setup\Log, where C is the disk drive where the TankMaster software is installed.

The log file contains the same input registers as the View Diagnostic Registers window. You can change which input registers to be included in the log file by configuring the View Diagnostic Registers window, see “Viewing diagnostic registers” on page 199 for more information.
7.10 Saving and loading database registers

Input and Holding Registers of the Rosemount 5900S and the 2410 can be stored on disk. This can be useful for backup purposes and troubleshooting. Input and Holding registers can be saved for a single device or several devices simultaneously.

7.10.1 To save device registers for a single device

To save configuration database registers (Holding or Input Registers) to file for a single device do the following:

1. Start the TankMaster WinSetup program.
2. In the TankMaster WinSetup workspace window, click the right mouse button on the device icon.
3. Choose the Save Database to File option, or from the Service menu choose Devices>Save Database to File.

4. Select Holding/Input registers (the Holding Register options is shown in the example above for demonstration).
5. Choose the Predefined Registers or the User-Defined option.
   - The Predefined option stores the most frequently used registers.
   - The User-defined option stores a specified range of Holding registers and should only be used for advanced service.
6. For the Predefined option you may choose the desired Scope; "All Registers" or "Basic Registers". Basic is a limited number of registers mostly related to configuration parameters for the device.
7. Click the Browse button, select a folder and type a file name.
8. Click the Save button to start saving the configuration database to file.
To save device registers for multiple devices

To save a backup copy of the current configuration for multiple devices, do the following:

1. In the TankMaster WinSetup workspace, select the Devices folder.
2. Click the right mouse button and choose the Save Database of All to Files option, or from the Service menu choose Devices>Save Database of All to Files.

3. Select a device from the Available Devices pane and click the Add button in order to move it to the Selected Devices pane. Repeat for all devices you would like to include.
4. Select register type: Holding or Input registers.
5. Choose the Predefined Registers or the User-Defined option.
   - The Predefined option stores the most frequently used registers.
   - The User-defined option stores a specified range of Holding registers and should only be used for advanced service.
6. Click the Browse button, select a folder and type a file name.
7. Click the Start button to save the database backup.
7.10.3 To recover a device database

TankMaster WinSetup offers the option to replace the current holding register database with a backup database stored on disk. This can be useful, for example, when recovering configuration data.

To load a backup database to a device do the following:

1. Select the device icon in the WinSetup workspace.
2. Click the right mouse button and choose the **Upload Database** option, or from the **Service** menu choose **Devices>Upload Database**.

![Upload Database Window](image)

3. Type a file path and file name, or click the **Browse** button and choose a backup database file to be uploaded.
4. Click the **Upload** button to start uploading the recovery database.
7.11 Upgrading the device firmware

TankMaster WinSetup supports firmware upgrade for Rosemount Tank Gauging level gauges and temperature transmitters.

**Note!**
In case the current program version is significantly older than the new one, it is recommended that you load the default configuration database once the device is reprogrammed. Contact Emerson Process Management/Rosemount Tank Gauging service department if you need further advice.

To upload new software do the following:

1. Make sure the devices are properly prepared for reprogramming (normal operation and no warnings or errors).

2. In the WinSetup Workspace, select the Devices folder. (For a single device, select the device in the Devices folder).

3. Click the right mouse button and choose the Program All option, or from the Service menu choose Devices>Program All.
   (For a single device, choose the Program option, or from the Service menu, choose the Devices>Program option).

4. Select the device to be programmed from the Available Devices pane and click the Move button. Repeat for each device of the same type to be programmed. Note that if a single device was selected in the Workspace window, it will appear automatically in the Program These Devices pane.
   Use the Remove button if you would like to change the list of devices to be programmed.

5. Click the Browse button to locate the appropriate software file.
6. Click the **Start Programming** button to open the **Start Device Programming** window:

![Start Device Programming Window]

7. Click the **Start Programming** button to activate device programming.

See, for example, the *Rosemount 5900S Reference Manual* (Document No. 00809-0100-5900) or the *Rosemount 2410 Reference Manual* (Document No. 00809-0100-2410) for further information on programming devices in the Rosemount Tank Gauging system.
7.12 Tank Scan

The Tank Scan window allows you to view tank echoes and setup the most important parameters to enable a radar level gauge such as the Rosemount 5900S to separate a surface echo from disturbing echoes and noise.

To open the Tank Scan window:

1. In the WinSetup workspace, select the 5900S gauge icon.

2. Click the right mouse button and choose the Properties option.

3. Select the Advanced Configuration tab.
4. Press the **Tank Scan** button

5. The *Tank Scan* window contains the Graph Area, Legend/Options area, File Storage buttons, and various action buttons.
7.12.1 Graph area

When the *Tank Scan* window opens, WinSetup reads tank data from the gauge. The process is indicated by a progress bar in the lower right corner of the *Tank Scan* window.

Once the reading process is finished, a tank scan graph is displayed that shows a peak referring to the product surface. The *Tank Scan* graph may also contain other peaks. In addition to the surface echo, there might be echoes from agitators or other obstacles in the tank.

The Tank Scan function includes tools that allows you to configure the level gauge to distinguish between the surface peak and peaks from disturbing objects. See the following chapters for details.

The Tank Scan graph can be refreshed at any time with the Reread From Gauge button. The new echo curve will appear as a black line and the previous curve as a grey line. The graph may show up to two old echo curves. An old echo peak will be marked by a small cross symbol. This can be used to compare the existing tank signal with previous signals.
### 7.12.2 Legend/Options

The following items can be shown in the graph area (check the appropriate box for each item to be shown):

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tank Echo</strong></td>
<td>The black line shows the latest Tank Echo curve, and the grey lines show previous Tank Echo curves (maximum two).</td>
</tr>
<tr>
<td><strong>Prev. Tank Echo</strong></td>
<td>See Tank Echo.</td>
</tr>
<tr>
<td><strong>General Threshold</strong></td>
<td>The <strong>General Amplitude Threshold</strong> is shown in blue. Echoes with an amplitude below the <strong>General Amplitude Threshold</strong> will be filtered out by the level gauge.</td>
</tr>
<tr>
<td><strong>False Echo Areas</strong></td>
<td>The False Echo function is used to improve the performance of the gauge when the surface is close to a horizontal surface of a stationary object in the tank. The object causes an echo when it is above the surface. <strong>Added False Echo Areas</strong> are shown in grey:</td>
</tr>
</tbody>
</table>
**ATP (Amplitude Threshold Points)**

A weak disturbing echo can be filtered out by creating a curve of **Amplitude Threshold Points**.

**Holdoff Distance**

The **Holdoff Distance** defines how close to the Gauge Reference Point a level value is accepted. The **Holdoff Distance** is shown in red.

**Gauge Ref. Point (Gauge Reference Point)**

The **Gauge Reference Point** is shown as a dashed (olive colored) line:

**Zero Reference**

The **Zero Reference** (zero level; dipping datum point) close to the bottom of the tank, is defined by the Tank Reference Height (R). It is shown as a dashed (sand colored) line:
Tank Bottom

The Tank Bottom is shown in red:

---

Echo Peaks

Echo Peaks are shown in black for the Surface Echo and in green for unknown echoes:

---

Peak Labels

Peak Labels are shown for the Surface Echo and for unknown echoes:

---

Previous Peaks

Previous Peaks are shown for the Surface Echo and for unknown echoes:

---
7.12.3 File storage

To save Tank Scan data displayed in the Graph Area

1. In the *Tank Scan* window click the **Save** button.

2. Enter a name to identify the tank scan data. You may also type a comment in the Comment field (not required). This can for example be used to describe any special circumstances under which the Tank scan data was obtained.

3. Press the **OK** button.

**Note!**
The default data storage file is named *StrTankScanII.dat*. The file is stored in the following folder: \C:\Rosemount\TankMaster\Lib\Data\.
To export tank scan data to an external file

Tank scan data can be saved to file for viewing with the Tank Echo Viewer (Tools>Tank Echo Viewer):

1. In the Tank Scan window click the **Save** button to open the **Save Tank Scan Data** window:

2. Enter a name to identify the tank scan data. You may also type a comment to describe any special circumstances when the Tank scan data was obtained.

3. Press the **Advanced** button.

4. Select the **Export tank scan data to external file** check box.

5. Press the **Browse** button.
6. Browse to a destination folder and type a name in the File name input field. Press the **Open** button.

7. Press **Yes** to create the file.

8. Press **OK**.

9. Press **OK** to export tank scan data.
To load data from a saved file into the Graph Area

1. In the Tank Scan window press the Stored Echoes button.

2. Select the file to be loaded.

3. Press the Load button.

To delete a saved file

1. In the Tank Scan window press the Stored Echoes button.

2. Select the file you want to delete.

3. Press the Delete button.
7.12.4 Action buttons

The following buttons can be found in the Tank Scan window:

**Save**
See “File storage” on page 216.

**Stored Echoes**
See “File storage” on page 216.

**Reread From Gauge**
At any time, you can refresh tank echo and echo peaks with the Reread From Gauge button. The Tank Scan will display the new echo curve as a black line, and up to two previous echo curves in grey color. The previous echo peaks will appear with small crosses.

**Print**
Opens the print dialogue and prints the Tank Scan window.

**Apply**
When changing a parameter that affects echo peak detection (e.g. General Amplitude Threshold), you will have to press the Apply button to write these settings to the internal memory of gauge. It takes a few seconds for the gauge to update the echo peak data (up to 30 seconds due to the echo peak filtering function in the gauge).

Finally, press the Reread from Gauge button to update the echo peak information in the graph area.

**OK**
Applies changes and closes the window.

**Cancel**
Cancels all changes.

**Help**
Opens the online help for the current window.
7.12.5 Editing

All the elements having handles can be edited. Each handle may be moved by using the mouse pointer.

Clicking the right mouse button on a handle opens a dialog window. The Properties option allows you to review or change parameter values.

The following parameters can be edited via moving or right-clicking a handle:

- General Amplitude Threshold
- Amplitude Threshold Point
- False Echo Area
- Hold Off Distance
Section 7: Service Functions

To add a False Echo Area or an Amplitude Threshold Point

1. Click the right mouse button in the graph area where you would like to add a False Echo Area or an Amplitude Threshold Point:

![Graph with Right Click Menu]

2. Select a menu item in the popup menu. In the example above, the New False Echo Area option was chosen:

![False Echo Area Properties]

3. Enter the new data and click the OK button.

To delete a False Echo Area or Amplitude Threshold Point

1. Right-click the handle of the False Echo Area or Amplitude Threshold Point to be deleted:

![Delete False Echo Area]

2. Select the Delete False Echo Area (or Delete Amplitude Threshold Point) option.
7.13 Viewing tank data

WinSetup offers the option to view data from a single tank or a group of tanks. Various parameters such as Level, Level Rate, and Average Temperature can be displayed. The Setup Tank View window lets you specify the desired set of parameters. See “Tank view layout” on page 60 for more information.

7.13.1 Viewing data for all tanks

To view measurement data from all tanks, do the following:

1. In the WinSetup workspace, select the Tanks folder.

2. Click the right mouse button and choose Summary Tank View, or from the Service menu choose Tanks/Summary Tank View.

3. Choose the All Tanks tab for a complete list of all tanks, or choose a view that includes a bar graph for one tank at a time by selecting the appropriate tab.
7.13.2 Viewing data for a single tank

To view measurement data for a single tank, do the following:

1. In the WinSetup workspace, select the desired tank icon.

2. Click the right mouse button and choose the **Open Tank View** option, or from the **Service** menu choose **Tanks/Open Tank View**:

Measurement data for the selected tank is displayed in the **Tank View** window.
7.14 Viewing alarm status

WinSetup lets you view alarm status for all tanks, a certain tank group, or a single tank.

To view the current alarm status for all tanks do the following:

1. In the WinSetup workspace, select the TankMaster workstation (or the Tanks folder) where the tanks are installed:

2. From the View menu choose Alarms. The Alarm Status window presents a list of alarms for all the tanks connected to the selected TankMaster workstation:
To view the alarm status of a single tank:

1. Open the Tanks folder and select the desired tank:

   1. From the View menu choose Alarms. The Alarm Status window presents the current alarms for the selected tank:

   ![Alarm Status Window]

<table>
<thead>
<tr>
<th>Tanks</th>
<th>Parameters</th>
<th>Description</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>TK-1</td>
<td>Level</td>
<td>High</td>
<td>0x64</td>
</tr>
</tbody>
</table>
7.15  Protocol handling

7.15.1  Logging the channel communication

WinSetup allows you to log communication on the various communication protocol channels. You can log specific devices, as well as filter out certain function codes and error types.

To log the communication of a particular protocol channel do the following:

1. In the WinSetup workspace, select the protocol channel icon:

2. Click the right mouse button and choose the View Log option, or from the Service menu choose Channels/View Log.

3. Specify a log profile. You can filter out certain function codes and devices as well as error types as shown in Table 7-1 below.
Table 7-1. Realtime log settings

<table>
<thead>
<tr>
<th>Filter Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function Code</td>
<td>A Function Code defines a specific action or type of data. You can log all function codes or a specific code.</td>
</tr>
<tr>
<td>Device Address</td>
<td>You can log all devices or a device with a certain address by your own choice. <strong>Note:</strong> The device address is automatically copied from the current settings in the <em>File Log Settings</em> window, see &quot;Saving the communication log to file&quot; on page 230. You can change this address to any other address that you want to log.</td>
</tr>
<tr>
<td>Enable Filtering</td>
<td>Mark this check box to enable filtering by function codes and addresses.</td>
</tr>
<tr>
<td>Errors</td>
<td>Select the check box for the type of error you like to record: <em>Time-out Errors</em>, <em>Check Sum Errors</em>, or <em>Other Errors</em>. You can select one or more check boxes.</td>
</tr>
<tr>
<td>Number of messages</td>
<td>Specify the number of messages that will be added each time the <em>Communication Log</em> window is updated. If the log is updated too quickly, you may increase the Number of messages value to reduce the update speed.</td>
</tr>
</tbody>
</table>

4. Click the **OK** button to open the *Communication Log* window.

![GBG: ModbusMaster, Channel 1: Communication Log](image)

The *Channel Communication Log* window is continuously updated with new data.

To stop WinSetup from feeding new data click the right mouse button and choose **Freeze**.

By clicking the right mouse button in the *Channel Communication Log* window you will get access to a number of useful options:
The **Save As** option lets you save the current log to file.

Choose the **Log Setup** option if you want to change the filtering settings.
7.15.2 Saving the communication log to file

To save the communication log to file:

1. Select the protocol channel icon.

2. Click the right mouse button and choose Properties, or from the Service menu choose Channels/Properties.

3. Select the File Log tab.

4. Type a name of the log file in the File Name field and set the Maximum File Size to limit the amount of disk space required for storing log files. The Maximum File Size option can be used in combination with the Multiple Log Files option in order to store the log files on a number of floppy disks. The log file will be stored in the following folder:

<table>
<thead>
<tr>
<th>PC operating system</th>
<th>Log file folder</th>
</tr>
</thead>
<tbody>
<tr>
<td>MS Windows 7</td>
<td>C:\Rosemount\TankMaster\Log</td>
</tr>
<tr>
<td>MS Windows XP</td>
<td>C:\Program Files\Rosemount\TankMaster\Log</td>
</tr>
</tbody>
</table>

*Note!*

If the maximum number of files is reached, TankMaster will replace existing log files.
5. The **Multiple Log** files section allows you to optimize file size for storing on floppy disk. Choose the **One File** option if you prefer the log to be stored in a single file. By choosing the **Several Files** radio button, logging continues by creating new files whenever the size of the current log file reaches the **Maximum File Size** value. When using the **Several Files** option, also set the **Max Log Files** parameter to define the maximum number of log files to be created.

6. Set the **Log Schedule**.

   **Manual**: select Manual and click the Start button to start logging. The logging will stop when the Stop button is pressed, or the Maximum File Size is reached.

   **Automatic Stop**: set the Date and Time at which you want the logging to stop. Press the Start button to start the logging. The logging will stop when the set Date and Time is reached, the Stop button is pressed, or the Maximum File Size is reached.

7. Click the **Advanced** button if you would like to specify filtering options:

8. To restrict logging to a certain function code and/or a certain device address, select the **Enable Filtering by Function Codes and Addresses** check box.
9. Choose the **Selected Function Code** option if you would like to log a specific function.

   FC2  Read Inputs  
   FC3  Read Holding Registers  
   FC4  Read Input Registers  
   FC6  Write Single Register  
   FC8  Diagnostics  
   FC13 Program  
   FC14 Poll program complete  
   FC16 Write Multiple Registers  
   FC17 Report Slave ID  
   FC65 Change address

10. Choose one of the device address options; **Any Address** or **Selected Address**. Choose Selected Address if you want to log communication to a certain device.

11. Specify what type of errors to be logged by selecting the appropriate check boxes. You can choose one or more error types to be logged simultaneously.

12. Click the **OK** button.
7.15.3 Searching for connected devices

You can search for devices on the communication protocol channels:

1. In the WinSetup workspace, open the **Protocols** folder and the appropriate protocol sub folder.

2. Select the desired protocol channel. For more information on Protocol Channels, see “Communication protocol setup” on page 44.

3. Click the right mouse button and choose the **Find Devices** option, or from the **Service** menu choose **Channels/Find Devices**.

4. Type the desired values in the **First** and **Last** address input fields in order to restrict the search to a certain range of addresses (maximum range is 1-255).

5. Click the **Start** button. Now the TRL2 fieldbus is scanned for devices within the specified address range.

   The search result is a list of name, type, address, unit id and application software version of each device that was found.
7.15.4 Channel statistics

The Protocol Statistics function is a tool which can be used to check the quality of communication between the TankMaster workstation and the connected field devices.

To view statistical data for a protocol channel do the following:

1. In the WinSetup workspace, open the Protocols folder and the appropriate protocol sub folder.

2. Select the desired channel.

3. Click the right mouse button and choose the Statistics option, or from the Service menu choose Channels/Statistics.

The Channel Statistics window lets you view a summary of messages and various error types.
### 7.16 TankMaster Administrator

The TankMaster Administrator program provides the option to select which TankMaster programs that will start automatically when the PC is turned on. It also allows you to check which TankMaster processes that are currently running.

By using the backup option, copies of the current WinOpi, WinSetup and Tank Server configurations can be stored. In the event of a PC operating system crash, resulting in corrupt TankMaster files, these backup files can be used to restore the TankMaster settings and the registry of the Windows operating system.

To open the *TankMaster Administrator*, click the icon on the right-hand side of the MS Windows taskbar:

![Administrator icon]
7.16.1 Log on

To be able to make any changes in the TankMaster Administrator window you need to use the Log on function.

To log on to the TankMaster Administrator do the following:

1. Open the TankMaster Administrator window by clicking the Administrator icon on the right-hand side of the MS Windows Taskbar.
2. Press the **Log on** button.

3. Enter the password and press **OK**.

**Note!**
The default password is **admin**.
7.16.2 Changing the Administrator program password

To change the TankMaster Administrator password, do the following:

1. Open the TankMaster Administrator window.
2. Log on to the Administrator.
3. Click the Change Password button.
4. Enter the old and the new passwords. Confirm the new password.
5. Press OK.
7.16.3 Autostart

The Autostart function lets you specify programs to start automatically when the TankMaster computer is started.

To configure the Autostart option:

1. Open the *TankMaster Administrator* window.
2. Click Auto Start Config button to open the *Auto Start Configuration* window.

3. Select the check boxes for the programs you want to start automatically.
4. Click the OK button.
5. The Autostart function is activated next time the TankMaster PC is started.
7.16.4 Backup

The backup function can be used to save configuration data for devices and tanks as well as workspace settings for WinSetup and WinOpi.

To make backup copies of the current configuration do the following:

1. Open the *TankMaster Administrator* window and click the *Backup/Restore* button.

![Backup window]

The *Backup* window contains the following:
- Information on when the Last Backup and Last Auto Backup were performed
- Backup data files to create
- File path to destination folder for the backup files
- Auto Backup settings

2. Select which data files to create in the *Backup data files* pane.
   - The *TankServer* option lets you backup tank and device configurations (the Tank server must be running).
   - The *Batch Server* option lets you backup the batch database files (the Batch server must be running). Note that the Batch server automatically removes a batch from the database after a certain number of days, see the *TankMaster Batch Handling Reference Manual* for more information.
   - The *Historical Data* option lets you backup any previously created Historical Data, see the *WinOpi User’s Guide* for more information.
   - The *WinOpi* and *WinSetup* options allows you to save the workspace configuration such as groups, colors, network settings etc.
   - The *Registry keys for TankMaster* option lets you save the TankMaster settings of the MS Windows registry.
3. Choose a destination folder by pressing the **Browse** button.

![Browse For Folder window](image)


5. Click the OK button to close the *Browse for Folder* window and return to the *Backup* window.
Section 7: Service Functions

6. In the Auto Backup pane, select the Enable check box to enable automatic backup. Also set Start time and Interval (1-30 days). This will automatically backup the selected backup data files at the specified start time and interval.

7. Click the Save Configuration button to save the current Backup window settings.

8. Click the Backup Now button if you like to make a manual backup of the selected items in the Backup data files pane.

9. Click the Close button.
7.16.5 Restore

If the PC operating system has crashed resulting in corrupt TankMaster files, the TankMaster settings can be restored by using the backup files. To restore the TankMaster configuration and data files do the following:

1. Check that WinSetup and WinOpi are closed. You may click the **Processes** button in the TM Administrator program to check if any TankMaster programs are running. Note that the TankMaster Administrator program itself also appears in the Processes window, see “Processes” on page 250. (You may also open the Windows Task Manager to make sure that the **Tankserver.exe** program is closed).

2. Open the **TankMaster Administrator** window.

3. Click the **Backup/Restore** button. The **Backup** window appears.

4. In the **Backup** window click the **Restore** button to start the Restore Backup Wizard:
5. The *Restore Backup Wizard* lets you restore tank and device configuration, BatchServer data and Historical data. You may also restore WinOpi and WinSetup configurations such as groups, color, network settings etc.

6. Click the Next button and follow the instructions. You will be guided through a step-by-step instruction that lets you specify the folder where backup files are stored, and the data to be restored. You may also create a backup of the current configuration.
7. When the backup source folder is selected, you will be prompted to specify the data to be restored:

![Restore Backup Wizard]

**Note!**
Do not select the Registry key option if upgrading from TankMaster version 4.H0 or older to version 4.H1 or newer.
The Registry key option must not be used if TankMaster has been re-installed on another hard disk drive, or in another directory than the original installation. The file paths to the TankMaster configuration files and data files must be the same for the backup files and the restored files.
8. The following options have to be specified as well:

   - **Create a backup of the current configuration**: Check if the wizard should create a backup of all current configuration files before restoring the old backup. If anything goes wrong, you can always revert to this backup.

   - **Delete old configuration files**: Check if the wizard should delete all old configuration files before restoring the backup.

9. The first option, *Create a backup of the current configuration*, should **not** be used if the restore function is used to replace corrupt configuration files.

   The **Delete old configuration files** option clears all configuration files which are not replaced by the Restore function. If this option is used it may be a good idea to backup the current configuration files in case you need to recover the current TankMaster configuration at a later point of time.
10. Click Next and review the restore settings:

   ![Restore Backup Wizard window](image)

   - **Source folder:** M:\TM_BAK\TM Backup 6.66 2015-04-23 18:37
   - **Destination folder:** C:\Rosemount\TankMaster
   - **Data to restore:** Servers, WinSetup, registry
   - **Create backup:** Yes
   - **Delete old files:** Yes

   *Warning:* All TankMaster servers will be shut down when you press "Next"!

   Press the "Next" button to start restoring the backup.

11. Click Next to start the restore function:

   ![Restore Backup Wizard window](image)

   - **Restoring backup:**
     - Creating a backup of all current data: Succeeded.
     - Initializing restore operation:
       - Source: M:\TM_BAK\TM Backup 6.66 2015-04-23 18:37
       - Destination: C:\Rosemount\TankMaster
     - BatchServer data is compatible.
     - Shutting down TankMaster: Succeeded.
     - Restoring server configurations and data:

   ![Copy Log button](image)

12. The Copy Log button can be used to store the restore log in the ...
   Rosemount\Server\Log directory.

13. Click the Next button to continue.
14. Check that no errors occurred during the restore process and click the Finish button to close the restore wizard. In case an error occurred you may click the Back button to find the error in the restore log.

15. Finally, copy the contents of the ...Server\Data folder to the backup folder ...Server\DataBackup:
   
   a. Open the server data backup folder (in the current example: M:\TM_BAK\TM Backup xxx\Server\Data) and copy the contents.
   
   b. Open the C:\Rosemount\TankMaster\Server\DataBackup folder (C:\Rosemount\TankMaster is the folder where TankMaster is installed) and paste the copied files.

   The DataBackup folder mirrors the contents of the Data folder. This enables TankMaster to restore data in case an error occurred while saving new configuration data.

16. Restart WinSetup and WinOpi to check that all settings are restored.
7.16.6 File version information

The **File Details** option allows you to view a list of all the files included in the TankMaster software package. The list presents file versions and brief descriptions.

![File Version Info](image)

The list can be stored by using the **Save to File** button. The file is stored in text format which can be opened by any word processing program:

![File Version Info.txt - Notepad](image)

**Note!**
When entering the filename in the Save to File dialogue, also enter file type **.txt**, e.g. enter File_Version.txt.
7.16.7 Processes

To view the running TankMaster programs, click the Processes button in the TankMaster Administrator window:

The Shutdown TM button lets you close all TankMaster programs except the TankMaster Administrator. In case a TankMaster client requests data, the TankServer starts up again.

By using the Shutdown TM and Staydown button the TankServer stays down regardless of any requests.

If the Also shutdown administrator check box is selected, the TM Administrator program is shut down as well.

Click the Update button to update the contents of the Processes window.
This section provides a brief guide of the menus in the TankMaster WinSetup configuration software. Clicking the right mouse button will result in different menu options depending on which folder or device that is selected in the TankMaster workspace.

The Service menu options are available by clicking the right mouse button on a specific folder or device as illustrated below, as well as in the menu bar at the top of the TankMaster workspace.

Figure 8-1. Service menu options are available by clicking the right mouse button
8.1 File

| New Connection | Connect to another tank server. |

If a workstation is selected, more options are available in the File menu:

| Install New > | Tank | Install new tanks by starting the tank installation wizard. |
| Install New > | Device | Install new devices by starting the device installation wizard. |
| Log On | Log on as Administrator, Supervisor or Operator. |
| Log Off | Log off from TankMaster to View Only mode. |
| Exit | Exit the WinSetup program. |

8.2 View

| Toolbar | Hide or reveal the Toolbar. |
| Status bar | Hide or reveal the Status bar. |
| Find Object | Search for a certain tank or device. |
| Workspace | Open or close the Workspace window. |
| Refresh Views | Update the current view. |
| Alarms | Show a list of current alarms for all tanks in the network, or tanks connected to a certain workstation. |
### 8.3 Service

The service options are found in the Service menu or by clicking the right mouse button on a specific folder, device, or tank.

#### Servers

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rename</td>
<td>Change the server name.</td>
</tr>
<tr>
<td>Disconnect</td>
<td>Disconnect from the current server.</td>
</tr>
<tr>
<td>Configure Digital Alarms</td>
<td>Configure the system’s digital alarms. Used for IOTs.</td>
</tr>
<tr>
<td>System Status Overview</td>
<td>Opens an overview of installed devices, protocol servers, and more.</td>
</tr>
<tr>
<td>Setup</td>
<td>Choose measurement units, ambient air source, and other system parameters.</td>
</tr>
</tbody>
</table>

#### Tanks

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install New</td>
<td>Install a new tank.</td>
</tr>
<tr>
<td>Summary Tank View</td>
<td>View various tank measurement variables such as level, level rate, average temperature etc. for all installed tanks.</td>
</tr>
<tr>
<td>Approved Tanks (option)</td>
<td>Show a list of tanks approved for custody transfer.</td>
</tr>
</tbody>
</table>

#### Devices

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand All</td>
<td>Show all items in the Device folder.</td>
</tr>
<tr>
<td>Collapse All</td>
<td>Close the device folder.</td>
</tr>
<tr>
<td>Install New</td>
<td>Install new devices by starting the device installation wizard.</td>
</tr>
<tr>
<td>Program All</td>
<td>Download an application program to a group of devices.</td>
</tr>
<tr>
<td>Save Databases of All to Files</td>
<td>Save the database registers for several devices.</td>
</tr>
<tr>
<td>Overview IOT Terminals</td>
<td>View an overview of installed IOT terminals.</td>
</tr>
<tr>
<td>Register Log Overview</td>
<td>Show a list of current log status for the connected devices.</td>
</tr>
</tbody>
</table>
When selecting a tank in the Tanks folder, new options are available under the **Service > Tanks** menu:

<table>
<thead>
<tr>
<th>Tanks &gt;</th>
<th>Uninstall</th>
<th>Remove the selected tank.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Rename</td>
<td>Change the tank name.</td>
</tr>
<tr>
<td>Open Tank View</td>
<td>View various tank related variables such as level, level rate, average temperature etc. for a single tank.</td>
<td></td>
</tr>
<tr>
<td>Calibrate</td>
<td>Use the built-in calibration function to adjust the still-pipe correction factor and Calibration Distance.</td>
<td></td>
</tr>
<tr>
<td>Tank Entry</td>
<td>Configure product data for inventory calculations.</td>
<td></td>
</tr>
<tr>
<td>Hybrid Tank Setup</td>
<td>Define pressure sensor positions for hybrid tank gauging.</td>
<td></td>
</tr>
<tr>
<td>Tank capacity</td>
<td>Specify a Tank Capacity Table (strapping table).</td>
<td></td>
</tr>
<tr>
<td>Tank Volume Calculation</td>
<td>Define settings for the tank volume calculation.</td>
<td></td>
</tr>
<tr>
<td>Properties</td>
<td>View and change tank configuration parameters.</td>
<td></td>
</tr>
</tbody>
</table>
When selecting a device in the device folder, new options are available under the **Service > Devices** menu:

<table>
<thead>
<tr>
<th><strong>2160 Field Communication Unit</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Devices &gt;</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
### 2460 SystemHub

<table>
<thead>
<tr>
<th>Devices &gt;</th>
<th>Expand all</th>
<th>Show all devices connected to the Rosemount 2460 System Hub.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Collapse All</td>
<td>Close the device folder.</td>
</tr>
<tr>
<td></td>
<td>Uninstall</td>
<td>Remove the selected device.</td>
</tr>
<tr>
<td></td>
<td>Save database to file</td>
<td>Save the current holding register setup to file. This function can be useful if you would like to save a backup of the current database. It can be downloaded to a device by choosing the Upload Database option.</td>
</tr>
<tr>
<td></td>
<td>Upload Database</td>
<td>Upload a database to the selected device.</td>
</tr>
<tr>
<td></td>
<td>View Input Registers</td>
<td>View input register values. You can choose between a predefined set of registers or you can specify a certain range of registers.</td>
</tr>
<tr>
<td></td>
<td>View Holding Registers</td>
<td>View holding (database) register values. You can choose between a predefined set of registers or you can specify a certain range of registers.</td>
</tr>
<tr>
<td></td>
<td>View Diagnostic Registers</td>
<td>View the diagnostic registers for the selected device.</td>
</tr>
<tr>
<td></td>
<td>Restart</td>
<td>Restart the selected device. The boot software performs an initialization procedure and memory tests.</td>
</tr>
<tr>
<td></td>
<td>Logging</td>
<td>Log the diagnostic registers.</td>
</tr>
<tr>
<td></td>
<td>Write Protect</td>
<td>Protect the holding register database from unintentional changes.</td>
</tr>
<tr>
<td></td>
<td>Properties</td>
<td>View and change the current device settings (not in View Only mode).</td>
</tr>
</tbody>
</table>
## 2410 Tank Hub

See the Rosemount 2410 Tank Hub Reference Manual (Document no. 00809-0100-2410) for more information.

<table>
<thead>
<tr>
<th>Devices</th>
<th>Expand all</th>
<th>Show all devices connected to the selected Rosemount 2410 Tank Hub.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Collapse All</td>
<td>Close the device folder.</td>
</tr>
<tr>
<td></td>
<td>Uninstall</td>
<td>Remove the selected device.</td>
</tr>
<tr>
<td></td>
<td>Save Database to File</td>
<td>Save the current holding register setup to file. This function can be useful if you would like to save the current database as a backup. It can be downloaded to a device by choosing the Upload Database option.</td>
</tr>
<tr>
<td></td>
<td>Upload Database</td>
<td>Upload a database to the selected device.</td>
</tr>
<tr>
<td></td>
<td>View Input Registers</td>
<td>View input register values. You can choose between a predefined set of registers or you can specify a certain range of registers.</td>
</tr>
<tr>
<td></td>
<td>View Holding Registers</td>
<td>View holding (database) registers. You can choose between a predefined set of registers or you can specify a certain range of registers.</td>
</tr>
<tr>
<td></td>
<td>View Diagnostic Registers</td>
<td>View diagnostic registers for the selected device.</td>
</tr>
<tr>
<td></td>
<td>Restart</td>
<td>Restart the device. The boot software performs an initialization procedure and memory tests.</td>
</tr>
<tr>
<td></td>
<td>Logging</td>
<td>Log the diagnostic registers.</td>
</tr>
<tr>
<td></td>
<td>Program</td>
<td>Download an application program to the device.</td>
</tr>
<tr>
<td></td>
<td>Device Live List</td>
<td>Show a list of devices connected to the Tankbus.</td>
</tr>
<tr>
<td></td>
<td>Manual Control of Relay</td>
<td>Manually change relay status.</td>
</tr>
<tr>
<td></td>
<td>Simulation</td>
<td>Simulate field devices to verify communication with a host system.</td>
</tr>
<tr>
<td></td>
<td>Write Protect</td>
<td>Protect the holding register database from unintentional changes.</td>
</tr>
<tr>
<td></td>
<td>Properties</td>
<td>View and change the current device settings (not in View Only mode).</td>
</tr>
</tbody>
</table>
### 5900 Radar Level Gauge

See the Rosemount 5900S Reference Manual (Document no. 00809-0100-5900) or the Rosemount 5900C Reference Manual (Document no. 00809-0100-5901) for more information.

<table>
<thead>
<tr>
<th>Devices</th>
<th>Uninstall</th>
<th>Remove the selected device.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Database to File</td>
<td>Save the current holding register setup to file. This function can be useful for saving the current database as a backup. It can be uploaded to the device by choosing the Upload Database option.</td>
<td></td>
</tr>
<tr>
<td>Upload Database</td>
<td>Upload a database to the selected device.</td>
<td></td>
</tr>
<tr>
<td>View Input Registers</td>
<td>View input registers. You can choose between a predefined set of registers or you can specify a certain range of registers.</td>
<td></td>
</tr>
<tr>
<td>View Holding Registers</td>
<td>View holding (database) registers. You can choose between a predefined set of registers or you can specify a certain range of registers.</td>
<td></td>
</tr>
<tr>
<td>View Diagnostic Register</td>
<td>View diagnostic registers for the selected device.</td>
<td></td>
</tr>
<tr>
<td>Restart.</td>
<td>Restart the device. The boot software performs an initialization procedure and memory tests.</td>
<td></td>
</tr>
<tr>
<td>Logging</td>
<td>Log the diagnostic registers.</td>
<td></td>
</tr>
<tr>
<td>Program</td>
<td>Download an application program to the device.</td>
<td></td>
</tr>
<tr>
<td>Calibrate</td>
<td>Use the built-in calibration function to adjust the still-pipe Correction Factor and the Calibration Distance.</td>
<td></td>
</tr>
<tr>
<td>LPG Setup</td>
<td>Configure the device for LPG measurements.</td>
<td></td>
</tr>
<tr>
<td>LPG Verify Reference Pins</td>
<td>Verify that the distance between actual and nominal position of the reference pin is within the approved limit.</td>
<td></td>
</tr>
<tr>
<td>Custody Transfer Config (Option)</td>
<td>Configure the level gauge for custody transfer.</td>
<td></td>
</tr>
<tr>
<td>Write Protect</td>
<td>Protect the holding register database from unintentional changes.</td>
<td></td>
</tr>
<tr>
<td>Properties</td>
<td>View and change the current device settings (not in View Only mode).</td>
<td></td>
</tr>
</tbody>
</table>
**Auxiliary Tank Devices (ATDs) (22405, 2230 etc.)**
For more information about the various ATD devices, see the reference manual for the specific device.

<table>
<thead>
<tr>
<th>Devices</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Uninstall</td>
<td>Remove the selected device.</td>
</tr>
<tr>
<td></td>
<td>Save Database to File</td>
<td>Save the current holding register setup to file. This function can be useful for saving the current database as a backup. It can be uploaded to a device by choosing the Upload Database option.</td>
</tr>
<tr>
<td></td>
<td>Upload Database</td>
<td>Upload a database to the selected device.</td>
</tr>
<tr>
<td></td>
<td>View Input Registers</td>
<td>View input register values. You can choose between a predefined set of registers or you can specify a certain range of registers.</td>
</tr>
<tr>
<td></td>
<td>View Holding Registers</td>
<td>View holding (database) register values. You can choose between a predefined set of registers or you can specify a certain range of registers.</td>
</tr>
<tr>
<td></td>
<td>View Diagnostic Register</td>
<td>View diagnostic registers for the selected device.</td>
</tr>
<tr>
<td></td>
<td>Restart</td>
<td>Restart the device. The boot software performs an initialization procedure and memory tests.</td>
</tr>
<tr>
<td></td>
<td>Logging</td>
<td>Log the diagnostic registers.</td>
</tr>
<tr>
<td></td>
<td>Custody Transfer Config</td>
<td>Configure the device for custody transfer.</td>
</tr>
<tr>
<td></td>
<td>Properties</td>
<td>View and change the current device settings (not in View Only mode).</td>
</tr>
</tbody>
</table>

### Protocols

<table>
<thead>
<tr>
<th>Protocols</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocols</td>
<td>Configure</td>
<td>Connect to the various protocol servers.</td>
</tr>
</tbody>
</table>
When selecting a specific protocol, new options will be available:

<table>
<thead>
<tr>
<th>Protocols &gt;</th>
<th>Disable</th>
<th>Disable the selected protocol.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Properties</td>
<td>Open the protocol Properties window and choose a communication channel.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Channels &gt;</th>
<th>Find Devices</th>
<th>Search for devices within a certain address range.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>View Log</td>
<td>View the Realtime Log window. You can choose to view only certain function codes, device addresses and error types.</td>
</tr>
<tr>
<td></td>
<td>Statistics</td>
<td>Open the Channel Statistics window to display various statistical data such as Messages received, Messages sent, Timeout errors.</td>
</tr>
<tr>
<td></td>
<td>State</td>
<td>Display information about the selected protocol channels.</td>
</tr>
<tr>
<td></td>
<td>Properties</td>
<td>View and change the communication, file log and tank mapping (for slave protocols) settings (not in View Only mode).</td>
</tr>
</tbody>
</table>

| Preferences | Preferences | Specify Tag prefixes, E-mail, Tank View layout, and Tanks Visibility. |
### 8.4 Tools

<table>
<thead>
<tr>
<th>Applications</th>
<th>Customize the Tools menu.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Administrative Tools &gt;</strong></td>
<td></td>
</tr>
<tr>
<td>User Manager</td>
<td>Manage the user accounts.</td>
</tr>
<tr>
<td>User Information</td>
<td>Display information about the current user.</td>
</tr>
<tr>
<td>Set Password</td>
<td>Change the password for the current user.</td>
</tr>
<tr>
<td>Set Inactivity Timeout</td>
<td>Define the user inactivity timeout.</td>
</tr>
<tr>
<td>Set Required Access Levels</td>
<td>Set the required access levels for various TankMaster operations.</td>
</tr>
<tr>
<td>Tank Echo Viewer</td>
<td>Open the tank scan viewer for the selected level gauge.</td>
</tr>
<tr>
<td>Custom menu</td>
<td>Open a User defined menu item.</td>
</tr>
</tbody>
</table>

### 8.5 Help

<table>
<thead>
<tr>
<th>Online Help</th>
<th>Open the online help.</th>
</tr>
</thead>
<tbody>
<tr>
<td>About WinSetup</td>
<td>Display information about the WinSetup program.</td>
</tr>
</tbody>
</table>
Symbols

Numerics

Index

Symbols

Numerics
## Index

<table>
<thead>
<tr>
<th>Page</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>264</td>
<td>Index</td>
</tr>
</tbody>
</table>

### Communication Protocol Parameters
- Communication Protocol Setup ........................................ 40, 44
- Communication tab .................................................. 110

### Configure
- field devices ......................................................... 41
- Master Protocol ..................................................... 45
- Rosemount 2160 ....................................................... 40
- Rosemount 2410 ....................................................... 41
- Slave Protocol ....................................................... 48
- tanks ................................................................. 41
- Configure button ..................................................... 200
- Configure Diagnostic Registers .................................... 201
- Configure protocol server ........................................... 53
- Conversion method ................................................... 112
- Conversion Table ..................................................... 192
- Copy Log button ..................................................... 247
- Correction Factor .................................................... 168, 169
- Customize window .................................................... 189
- Customizing .......................................................... 189

### D
- DCS system ............................................................ 15
- Default password ..................................................... 31
- Device Address ....................................................... 228
- Device installation wizard ......................................... 43
- Device Tag Setup ..................................................... 72
- Device Tags window .................................................. 99
- Device Type .......................................................... 70, 89, 132, 143
- Diagnostic Registers ................................................ 199, 201
  - configure .......................................................... 200, 201
  - restore ............................................................. 202
- Dielectric constants ................................................ 140
- Digital Alarms ....................................................... 57
- Dipping Datum Point ................................................ 87, 127
- Display configuration ............................................... 74
- Display setup ........................................................ 73
- Display Toggle Time ................................................ 74, 120
- DSR ................................................................. 49

### E
- Echo Peaks ............................................................ 215
- E-mail Configuration ................................................ 59
- Empty Tank Handling ................................................ 80, 94
- Enable Channel ....................................................... 47
- Enable Filtering ....................................................... 228
- Environment .......................................................... 133
- Environment parameters ............................................. 140
- Environment window ................................................ 130

### F
- Field ports ............................................................. 65
- File Info Option ..................................................... 249
- File Log ............................................................... 230
  - Filtering options .................................................. 231
  - Maximum File Size ............................................... 230, 231
  - Several Files ..................................................... 231
- File Log Settings .................................................... 231
  - Automatic Stop .................................................... 231
  - Manual .............................................................. 231
- File Log tab .......................................................... 46, 230
- Filter Factor .......................................................... 122
- Filter Settings ........................................................ 94
- Find Devices .......................................................... 233
- Free Water Level ..................................................... 116, 151
- Function Code ........................................................ 228, 232
- FWL ................................................................. 151

### G
- Gauge Reference Point ............................................... 86, 127, 214

### H
- Handshaking ........................................................... 46, 49
- Hardware key ........................................................ 16
- HART ................................................................. 121
- Hexadecimal format ................................................ 200
- High Current Limit ................................................ 122
- Hold Off Distance ................................................... 83, 85, 126, 138
- Holding registers .................................................... 195, 197
- Holdoff Distance ..................................................... 214
- Host ports ............................................................. 65
- Hybrid Density Calculation ....................................... 77
- Hybrid Min Level ..................................................... 176
- Hybrid System ....................................................... 172
  - P3 sensor ............................................................ 172
  - Hybrid system ..................................................... 172
  - Mass calculations ................................................ 172
- Hybrid Tank Setup .................................................. 176

### I
- Icons ................................................................. 29
- Illegal characters ..................................................... 19
- Inactivity Timeout ................................................... 38
- Individual Formula .................................................. 194
- Individual Tank Configuration .................................... 74, 120
- Input Registers ....................................................... 74, 195
- Insert Distance ....................................................... 113

### Install
- ATD Devices .......................................................... 109
- field devices ......................................................... 41
- New device ........................................................... 25
- New tank ............................................................... 25
- Rosemount 2160 ....................................................... 40
- Rosemount 2230 ....................................................... 109
- Rosemount 2240S ..................................................... 109
- Rosemount 2410 ....................................................... 41, 66
- Rosemount 5300 ....................................................... 135
- Rosemount 5400 ....................................................... 123
- Rosemount 5900S ..................................................... 80
- Tank ................................................................. 146
- Tank Gauging System .............................................. 40
- tanks ................................................................. 41
- Inventory ............................................................. 56

### July 2015

### File Log Settings
- Automatic Stop .................................................... 231
- Manual .............................................................. 231
- File Log tab .......................................................... 46, 230
- Filter Factor .......................................................... 122
- Filter Settings ........................................................ 94
- Find Devices .......................................................... 233
- Free Water Level ..................................................... 116, 151
- Function Code ........................................................ 228, 232
- FWL ................................................................. 151

### Gauge Reference Point
- 86, 127, 214

### Handshaking
- 46, 49

### Hardware key
- 16
Inventory Calculations ........................................ 146
Inventory calculations .................................... 54

L
Level Modbus Address ........................................ 71
Level Offset ..................................................... 115
Level Rate ...................................................... 151
Level Tag ....................................................... 72, 89, 132, 143, 167
Liquid Pressure ................................................ 151, 174
Local Display setup ....................................... 73
Local Gravity .................................................. 56
Log file ......................................................... 52, 204
Log File Configuration .................................. 52
Log On .......................................................... 32
Log on .......................................................... 236
Administrator ................................................. 236
Log scheduling .............................................. 203
Logging ......................................................... 203
Logical view .................................................. 27
Low Current Limit .......................................... 122
Lower Dead Zone ............................................ 115
Lower Product Dielectric Range ....................... 141

M
Manual Configuration ........................................ 112
Manual mode .................................................. 203
Mapped Tanks ................................................ 51
Mapping ........................................................ 146
Mass calculations ......................................... 172
Master Protocol ............................................. 40, 45
Master protocol ............................................. 44
Master protocol channel
  log file configuration .................................. 52
Master Protocol Server ................................ 15
Master protocol server ................................ 15
Maximum File Size ...................................... 231
Measurement Units .................................... 146
Measurement units .................................... 54
Measuring units .......................................... 54
Menu bar ....................................................... 23
Microsoft Windows 7 .................................... 13
Microsoft Windows Server 2008 ..................... 13
Minimum Level Distance (C) ......................... 87, 127
Miscellaneous ............................................... 57
Modbus ........................................................ 68
Modbus Address ........................................... 69
Rosemount 5900S ......................................... 82
Modbus address .......................................... 69
Modbus Master Protocol ................................ 45
Modbus Master protocol ................................ 44
Modbus Slave protocol ................................ 44
Modem ........................................................ 46, 49
Multiple Log Files ....................................... 230

N
Name Tag Prefixes ........................................... 58
Number of messages .................................. 228

O
Observed Density ........................................... 56, 151, 173, 176
On-line density .............................................. 172
OPC ............................................................. 15
Open Tank View ............................................ 224
Operator ......................................................... 31

P
P1 Sensor Position .......................................... 176
P3 sensor ....................................................... 172
P3 Sensor Position .......................................... 176
Parameter Source Configuration .................... 116
Parity ........................................................... 46, 49
Password
  default ....................................................... 31
  OPER ......................................................... 31
  SUPER ....................................................... 31
Physical view ............................................... 27
Pipe Diameter ............................................. 85
Pipe Inner Diameter .................................... 126
Port ........................................................... 46, 49
Predefined .................................................... 196
Preferences
  e-mail ....................................................... 59
  Tag Prefixes ............................................. 58
  Tank View Layout .................................. 60
  Tank Visibility ......................................... 62
Pressure sensors .......................................... 172
Previous Peaks ........................................... 215
Primary Bus ............................................... 77, 160
Probe Length ................................................ 138
Probe Type .................................................. 138
Probe type .................................................. 135
Processes button ......................................... 250
Product Dielectric Range .............................. 93, 130, 141
Program All .................................................. 208
Program option ............................................. 208
Protection Level ........................................... 36
Protection levels .......................................... 31
Protocol Channel ............................................ 52
  activate ..................................................... 47, 49
  enable check box ................................... 47, 49
Protocol channel ......................................... 68
Protocol Channel Configuration
  Changing .................................................... 52
  Protocol channel statistics ......................... 234
  Protocol Properties window ....................... 45
  Protocol Server ......................................... 53
  Protocol server configuration ................... 53
  Protocol statistics .................................. 234
  Protocols folder ....................................... 45
  Protocols/Properties .................................. 45
## Index

**System Configuration Manual**
00809-0300-5100, Rev BA

<table>
<thead>
<tr>
<th>R</th>
<th>Rosemount 5400</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rapid Level Change</td>
<td>Advanced configuration</td>
</tr>
<tr>
<td>Recover database</td>
<td>advanced configuration</td>
</tr>
<tr>
<td>Redundant server</td>
<td>Antenna Extension</td>
</tr>
<tr>
<td>Reference Density</td>
<td>Antenna Type</td>
</tr>
<tr>
<td>Reference Distance (G)</td>
<td>Basic Configuration</td>
</tr>
<tr>
<td>Reference Temperature</td>
<td>Communication parameters</td>
</tr>
<tr>
<td>Register log file</td>
<td>configuration</td>
</tr>
<tr>
<td>Register Log Scheduling</td>
<td>Environment</td>
</tr>
<tr>
<td>Register Log scheduling</td>
<td>Hold Off Distance</td>
</tr>
<tr>
<td>Relay functions</td>
<td>Installation</td>
</tr>
<tr>
<td>Relays</td>
<td>installation</td>
</tr>
<tr>
<td>Reply timeout</td>
<td>Level Tag</td>
</tr>
<tr>
<td>Rread From Gauge button</td>
<td>Modbus address</td>
</tr>
<tr>
<td>Restore</td>
<td>Pipe Inner Diameter</td>
</tr>
<tr>
<td>Retries</td>
<td>Reference Distance (G)</td>
</tr>
<tr>
<td>RLG Reference Distance (G)</td>
<td>Still Pipe</td>
</tr>
<tr>
<td>Rosemount 2230</td>
<td>Tank Distance Parameters</td>
</tr>
<tr>
<td>Display Toggle Time</td>
<td>tank environmental conditions</td>
</tr>
<tr>
<td>Installation</td>
<td>Tank geometry</td>
</tr>
<tr>
<td>Rosemount 2240S</td>
<td>Tank Reference Height (R)</td>
</tr>
<tr>
<td></td>
<td>Tank Shape</td>
</tr>
<tr>
<td>Auxiliary Sensor Configuration</td>
<td>User Defined antenna</td>
</tr>
<tr>
<td>Average Temperature Calculation</td>
<td>RS232</td>
</tr>
<tr>
<td>Communication Setup</td>
<td>RS485</td>
</tr>
<tr>
<td>Insert Distance</td>
<td></td>
</tr>
<tr>
<td>Installation</td>
<td></td>
</tr>
<tr>
<td>Level Offset</td>
<td></td>
</tr>
<tr>
<td>Lower Dead Zone</td>
<td></td>
</tr>
<tr>
<td>Sensor Type</td>
<td></td>
</tr>
<tr>
<td>Temperature Sensor Configuration</td>
<td></td>
</tr>
<tr>
<td>Upper Dead Zone</td>
<td></td>
</tr>
<tr>
<td>Water Level Sensor</td>
<td></td>
</tr>
<tr>
<td>Rosemount 2410</td>
<td></td>
</tr>
<tr>
<td>Advanced Configuration</td>
<td></td>
</tr>
<tr>
<td>communication setup</td>
<td></td>
</tr>
<tr>
<td>Device Tag setup</td>
<td></td>
</tr>
<tr>
<td>Device Type</td>
<td></td>
</tr>
<tr>
<td>Installation</td>
<td></td>
</tr>
<tr>
<td>Local Display setup</td>
<td></td>
</tr>
<tr>
<td>Tank Database setup</td>
<td></td>
</tr>
<tr>
<td>Rosemount 2460</td>
<td></td>
</tr>
<tr>
<td>Installation</td>
<td></td>
</tr>
<tr>
<td>Rosemount 5300</td>
<td></td>
</tr>
<tr>
<td>Advanced configuration</td>
<td></td>
</tr>
<tr>
<td>Basic Configuration</td>
<td></td>
</tr>
<tr>
<td>configuration</td>
<td></td>
</tr>
<tr>
<td>Installation</td>
<td></td>
</tr>
<tr>
<td>installation</td>
<td></td>
</tr>
<tr>
<td>Level Tag</td>
<td></td>
</tr>
<tr>
<td>Measurement Mode</td>
<td></td>
</tr>
<tr>
<td>Modbus Address</td>
<td></td>
</tr>
<tr>
<td>Probe Type</td>
<td></td>
</tr>
<tr>
<td>Rapid Level Change</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>S</th>
<th>Safety Alarm</th>
<th>.94</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save configuration database</td>
<td>Save Database</td>
<td>205</td>
</tr>
<tr>
<td>Save Database</td>
<td>Scope</td>
<td>205</td>
</tr>
<tr>
<td>Save Database to File</td>
<td>Save Device Registers</td>
<td>205, 206</td>
</tr>
<tr>
<td>Save to File</td>
<td>249</td>
<td></td>
</tr>
<tr>
<td>Scope</td>
<td>205</td>
<td></td>
</tr>
<tr>
<td>Secondary Bus</td>
<td>.77</td>
<td></td>
</tr>
<tr>
<td>Select Devices</td>
<td>156</td>
<td></td>
</tr>
<tr>
<td>Sensor Connection</td>
<td>112</td>
<td></td>
</tr>
<tr>
<td>Sensor Type</td>
<td>113</td>
<td></td>
</tr>
<tr>
<td>Server 2008</td>
<td>.13</td>
<td></td>
</tr>
<tr>
<td>Server and Client</td>
<td>.18</td>
<td></td>
</tr>
<tr>
<td>Server Preferences</td>
<td>.54</td>
<td></td>
</tr>
<tr>
<td>Ambient Air Temperature</td>
<td>.55</td>
<td></td>
</tr>
<tr>
<td>Inventory</td>
<td>.56</td>
<td></td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>.57</td>
<td></td>
</tr>
<tr>
<td>Units</td>
<td>.54</td>
<td></td>
</tr>
<tr>
<td>Servers Setup</td>
<td>.56</td>
<td></td>
</tr>
<tr>
<td>Set Inactivity Timeout</td>
<td>.38</td>
<td></td>
</tr>
<tr>
<td>Index</td>
<td>Page numbers</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>--------------</td>
<td></td>
</tr>
<tr>
<td>Set password</td>
<td>37</td>
<td></td>
</tr>
<tr>
<td>Set Required Access Levels</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>Setup Tank View</td>
<td>60, 223</td>
<td></td>
</tr>
<tr>
<td>Several Files Option</td>
<td>231</td>
<td></td>
</tr>
<tr>
<td>Slave Protocol</td>
<td>40, 48</td>
<td></td>
</tr>
<tr>
<td>Slave protocol</td>
<td>44</td>
<td></td>
</tr>
<tr>
<td>Slave protocol channel</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced Configuration</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>tank mapping configuration</td>
<td>51</td>
<td></td>
</tr>
<tr>
<td>TRL2 Modbus Communication setup</td>
<td>48</td>
<td></td>
</tr>
<tr>
<td>Slave Protocol Server</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>Smart Wireless Gateway</td>
<td>11</td>
<td></td>
</tr>
<tr>
<td>Smart Wireless THUM Adapter</td>
<td>11</td>
<td></td>
</tr>
<tr>
<td>Software modules</td>
<td>14, 16</td>
<td></td>
</tr>
<tr>
<td>Source Device Type</td>
<td>117</td>
<td></td>
</tr>
<tr>
<td>Start Programming</td>
<td>209</td>
<td></td>
</tr>
<tr>
<td>Statistics</td>
<td>234</td>
<td></td>
</tr>
<tr>
<td>Status bar</td>
<td>26</td>
<td></td>
</tr>
<tr>
<td>Still Pipe</td>
<td>126</td>
<td></td>
</tr>
<tr>
<td>Still-pipe correction factor</td>
<td>168</td>
<td></td>
</tr>
<tr>
<td>Stop bits</td>
<td>46, 49</td>
<td></td>
</tr>
<tr>
<td>Stored Echoes</td>
<td>219</td>
<td></td>
</tr>
<tr>
<td>Strapping table</td>
<td>170</td>
<td></td>
</tr>
<tr>
<td>Sub Level Descriptions</td>
<td>34</td>
<td></td>
</tr>
<tr>
<td>Summary</td>
<td>76</td>
<td></td>
</tr>
<tr>
<td>Summary Tank View</td>
<td>223</td>
<td></td>
</tr>
<tr>
<td>Summary window</td>
<td>76</td>
<td></td>
</tr>
<tr>
<td>Supervisor</td>
<td>31</td>
<td></td>
</tr>
<tr>
<td>Surface Echo Tracking</td>
<td>94</td>
<td></td>
</tr>
<tr>
<td>System Hub</td>
<td>65</td>
<td></td>
</tr>
<tr>
<td>Tank Database</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>System Requirements</td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>System Status Overview</td>
<td>188</td>
<td></td>
</tr>
<tr>
<td><strong>T</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tag Prefixes</td>
<td>58</td>
<td></td>
</tr>
<tr>
<td>Tag</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced Configuration</td>
<td>153</td>
<td></td>
</tr>
<tr>
<td>Assign Devices</td>
<td>149</td>
<td></td>
</tr>
<tr>
<td>Change Configuration</td>
<td>157</td>
<td></td>
</tr>
<tr>
<td>Configuration</td>
<td>151</td>
<td></td>
</tr>
<tr>
<td>Installation</td>
<td>146</td>
<td></td>
</tr>
<tr>
<td>Inventory Calculations</td>
<td>146</td>
<td></td>
</tr>
<tr>
<td>Tag</td>
<td>148</td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>146</td>
<td></td>
</tr>
<tr>
<td>Uninstall</td>
<td>158</td>
<td></td>
</tr>
<tr>
<td>Value Entry</td>
<td>154</td>
<td></td>
</tr>
<tr>
<td>Variables</td>
<td>146</td>
<td></td>
</tr>
<tr>
<td>Tank Bottom Type</td>
<td>92</td>
<td></td>
</tr>
<tr>
<td>Tank Capacity Table</td>
<td>57, 170</td>
<td></td>
</tr>
<tr>
<td>Tank Configuration</td>
<td>151, 156</td>
<td></td>
</tr>
<tr>
<td>Tank Connection Length</td>
<td>85, 126</td>
<td></td>
</tr>
<tr>
<td>Tank Connection Length (TCL)</td>
<td>83</td>
<td></td>
</tr>
<tr>
<td>Tank Database</td>
<td>40, 70, 166</td>
<td></td>
</tr>
<tr>
<td>2-in-1</td>
<td>97</td>
<td></td>
</tr>
<tr>
<td>Tank Position</td>
<td>70</td>
<td></td>
</tr>
<tr>
<td>Tank Echo Viewer</td>
<td>217</td>
<td></td>
</tr>
<tr>
<td>Tank Entry</td>
<td>171, 177</td>
<td></td>
</tr>
<tr>
<td>Tank Environment</td>
<td>93</td>
<td></td>
</tr>
<tr>
<td>Tank environmental conditions</td>
<td>123</td>
<td></td>
</tr>
<tr>
<td>Tank Geometry</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calibration Distance</td>
<td>87</td>
<td></td>
</tr>
<tr>
<td>Minimum Level Distance (C)</td>
<td>87</td>
<td></td>
</tr>
<tr>
<td>Reference Distance (G)</td>
<td>86</td>
<td></td>
</tr>
<tr>
<td>Tank Reference Height (R)</td>
<td>86</td>
<td></td>
</tr>
<tr>
<td>Tank geometry</td>
<td>123, 135</td>
<td></td>
</tr>
<tr>
<td>Tank Hub</td>
<td>41</td>
<td></td>
</tr>
<tr>
<td>Tank installation</td>
<td>146</td>
<td></td>
</tr>
<tr>
<td>tank type</td>
<td>148</td>
<td></td>
</tr>
<tr>
<td>Tank Mapping</td>
<td>51</td>
<td></td>
</tr>
<tr>
<td>Tank mapping</td>
<td>44</td>
<td></td>
</tr>
<tr>
<td>Tank mapping configuration</td>
<td>51</td>
<td></td>
</tr>
<tr>
<td>Tank Position</td>
<td>70, 164</td>
<td></td>
</tr>
<tr>
<td>Tank Ref Point</td>
<td>86</td>
<td></td>
</tr>
<tr>
<td>Tank Reference Height (R)</td>
<td>86, 127, 139</td>
<td></td>
</tr>
<tr>
<td>Tank Reference Point</td>
<td>86, 127</td>
<td></td>
</tr>
<tr>
<td>Tank Scan</td>
<td>80, 94, 210</td>
<td></td>
</tr>
<tr>
<td>Action Buttons</td>
<td>220</td>
<td></td>
</tr>
<tr>
<td>Editing</td>
<td>221</td>
<td></td>
</tr>
<tr>
<td>File Storage</td>
<td>216</td>
<td></td>
</tr>
<tr>
<td>Tank Scan graph</td>
<td>212</td>
<td></td>
</tr>
<tr>
<td>Tank Server</td>
<td>14</td>
<td></td>
</tr>
<tr>
<td>Tank Shape</td>
<td>129, 133</td>
<td></td>
</tr>
<tr>
<td>Tank Tag</td>
<td>148</td>
<td></td>
</tr>
<tr>
<td>Tank Type</td>
<td>92, 146, 156</td>
<td></td>
</tr>
<tr>
<td>Tank types</td>
<td>148</td>
<td></td>
</tr>
<tr>
<td>Tank Variables</td>
<td>146</td>
<td></td>
</tr>
<tr>
<td>Tank View</td>
<td>223</td>
<td></td>
</tr>
<tr>
<td>Tank View Layout</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>Tank View window</td>
<td>224</td>
<td></td>
</tr>
<tr>
<td>TankMaster</td>
<td>9, 13</td>
<td></td>
</tr>
<tr>
<td>TankMaster ATD Tag</td>
<td>72, 167</td>
<td></td>
</tr>
<tr>
<td>TankMaster installation</td>
<td>17</td>
<td></td>
</tr>
<tr>
<td>TankMaster Level Tag</td>
<td>72, 167</td>
<td></td>
</tr>
<tr>
<td>Tanks Visibility</td>
<td>62</td>
<td></td>
</tr>
<tr>
<td>TCL</td>
<td>83</td>
<td></td>
</tr>
<tr>
<td>TCT</td>
<td>57, 170</td>
<td></td>
</tr>
<tr>
<td>Temperature Sensor</td>
<td>111</td>
<td></td>
</tr>
<tr>
<td>Temperature sensor</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto Sensor Configuration</td>
<td>112</td>
<td></td>
</tr>
<tr>
<td>Conversion method</td>
<td>112</td>
<td></td>
</tr>
<tr>
<td>User Defined Formula</td>
<td>112</td>
<td></td>
</tr>
<tr>
<td>User Defined Individual Formula</td>
<td>112</td>
<td></td>
</tr>
<tr>
<td>User Defined Table</td>
<td>112</td>
<td></td>
</tr>
<tr>
<td>Temperature Sensor Configuration</td>
<td>111</td>
<td></td>
</tr>
<tr>
<td>Sensor Type</td>
<td>113</td>
<td></td>
</tr>
<tr>
<td>Temperature Sensor Connection</td>
<td>112</td>
<td></td>
</tr>
<tr>
<td>Timeout</td>
<td>38</td>
<td></td>
</tr>
<tr>
<td>Toolbar</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Tools Menu</td>
<td>189</td>
<td></td>
</tr>
<tr>
<td><strong>U</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Uninstall</td>
<td></td>
<td></td>
</tr>
<tr>
<td>device</td>
<td>25, 183, 185</td>
<td></td>
</tr>
<tr>
<td>tank</td>
<td>25</td>
<td></td>
</tr>
</tbody>
</table>
Index
July 2015

Virtual relays .............................................77

W
Water Level Sensor .................................114
  Level Offset ..................................115
  Lower Dead Zone .............................115
  Upper Dead Zone .........................115
Weak Echo Signals ..............................93, 130
Weight in Air .....................................56
WIA ....................................................56
Windows 7 .........................................13
WinOpi ...............................................9, 14
WinSetup .........................................9, 15
Wireless .............................................11
Wizard .............................................43
Wizards .............................................19
Workspace .......................................21, 22, 25, 28
  Logical view ..................................27
  Physical view .................................27
Write new calibration data to RTG ..........169

Z
Zero Level .........................................87, 127
Zero level ......................................86, 87
Zero Reference ..................................214
Zero Reference Point ......................139

Unit ID ...........................................69
Units .................................................54
Upload Database ...............................207
Upper Dead Zone ...............................115
Upper Product Dielectric Constant ....141
Upper Reference Point ..................139
User defined conversion ..................191
User Defined Formula .........................112, 193
User Defined Individual Formula ......112, 194
User Defined Linearization Table ......192
User Defined Table ............................112
User management
  Administrator ..................................31
  Operator .......................................31
  Supervisor ..................................31

V
Value Entry ......................................154, 156, 178
Value Range .....................................121, 155
Value Source ....................................178
Vapor Dielectric Constant ...............141
Vapor dielectric constant ..............140
Vapor Pressure ................................151, 174
Vapor Temperature .........................116, 118, 151
View Diagnostic Registers ...........199, 201
  restore to default ..........................202
View Log ..........................................227
View Only .........................................31